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Preface —

SPSS is a sophisticated piece of software used by social scientists and related pro-
fessionals for statistical analysis. This workbook is based on version 12.0, which is
compatible with the Windows environment.

There are several new features in SPSS 12.0 relating to improved charting, new data
management, statistical enhancements and, for those who work with it, a new add-on
module for working with sample survey data. Some of these new features are outlined
below.

Improved Charting Features

* Better default chart appearance

* Support for long text strings and automatic text wrapping
*» Control of default scale ranges using chart templates

» 3-D effects for pie and bar charts

* Improved choice of colour patterns.

New Data Management Features

» Longer variable names — now a maximum of 64 bytes, compared with eight in
previous versions

* Visual bander — assists you in banding scale data into categorical ranges (e.g. age —_
in 10-year ranges)

* Duplicate record finder — helps you identify, flag, report and filter duplicate records
with the new Duplicate Cases feature

» Output management system — allows you to turn output into input with the new OMS
command by automatically writing selected categories of output to different output —_
files in different formats — HTML, XML, text and SPSS-format for data files

» Command syntax to delete variables — the new Delete Variables command makes it
easy to delete variables you do not need anymore, such as temporary variables used
in transformations.

Statistical Enhancements

* New options of handling weighted data in the Crosstabs procedures
» New stepwise function in Multinomial Logistic Regression. -

This edition of SPSS: Analysis without Anguish continues the trend of previous
editions in providing a practical text intended as an introduction to SPSS and a guide —
for users who wish to conduct analytical procedures.

We’ve also tried to improve the text from the feedback we have obtained from our
readers. In this edition, we have included reporting at the end of each relevant chapter
to illustrate how significant results from each of the particular tests should be reported.

Many readers also requested that we bring back our chapters on Cluster Analysis, Multi- -
dimensional Scaling and Discriminant Analysis. Thanks to the contribution of Dr Mark
Fenton from James Cook University in Townsville, this edition includes additional
chapters on Mutidimensional Scaling.

Again, we’ve tried to keep the text clear and simple -— no one text will satisfy all our
readers. However, in subsequent editions we hope to expand on some of the other - -
techniques offered in SPSS.

(U@ PREFACE
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Chapters 1 to 3 are generic chapters that introduce the software, detail how to prepare
data files and outline data screening methods. Chapters 4 to 20 outline specific pro-
cedures within the package. In each of these chapters, a working example is presented.

One major advantage of the workbook is that the text is accompanied by data files, which
are available from the website that accompanies this title (www.johnwiley.com.au/
highered/spssV12), so that the user can progressively work through each procedure with
the text. At the end of each chapter, a practice example is given to help users to con-
solidate the skills they have learned. Solutions to these practice examples are also pro-
vided to clarify the analytical procedure and to facilitate interpretation of the SPSS
output.

As highlighted above, chapter 21 considers the application of Multidimensional
Scaling and, as with other editions, chapter 22 concludes in dealing specifically with
output, outlining ways in which presentation can be improved.

Although the workbook outlines each statistical procedure, this is not a statistical text
and a degree of statistical knowledge is assumed. At the beginning of each chapter,
assumption testing for each procedure is discussed, and the procedure is approached
simply and systematically.

The concept of the workbook arose from our collective experience of teaching and
applying research methods. It evolved from a recognised need to make research meth-
odology more accessible and understandable to students who are undertaking research
methods courses and to professionals who are taking part in research in an applied
context.

We still receive very positive feedback from you, the users of the book, who tell us that
we have helped alleviate some of the ‘anguish’ associated with the analysis of research
data. We trust that this edition continues to help with this.

Having worked through the book, you will be well on your way to effective research
from coding, entering and exploring data, and undertaking appropriate analysis to cre-
ating meaningful data output. We wish you well in your research endeavours.

A very big thank you must also go to Dr Mark Fenton, associate professor, James
Cook University, Townsville Queensland, for his chapter contributions and feedback;
to Peta Dzidic for her assistance in preparation; and to you, our readers, for your con-
tinued support.

Dr Sheridan Coakes, Director, Coakes Consulting,
PO Box 1027, Kalamunda WA 6926

Dr Lyndall Steed, Senior Lecturer, School of Psychology,
Curtin University of Technology, Perth WA 6001

September 2004
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At-a-glance text examples

Working examples

Work 2
Work 3
Work 4
Work 5

Work 6
Work 7
Work 8
Work 9
Work 10
Work 11
Work 12
Work 13
Work 14
Work 15
Work 16
Work 17
Work 18
Work 19a
Work 19b
Work 19¢
Work 19d
Work 19e
Work 19f
Work 19g
Work 20a
Work 20b
Work 21

Individual’s shopping behaviour
Community resident attitudes towards physical exercise
Gender differences in tennis performance

Relationship between intelligence (IQ) and tertiary entrance examin-
ation scores (TEE) among potential university students

Comparisons of car engine efficiency

Comparisons of utility cost by city

Efficacy of weight-reduction programs

Toy store sales by store type and location

Practice effects on anagram completion times

Manager productivity across store type and location
Influence of age on reaction time

Efficacy of new treatment program for depression
Gender differences in sales representatives

Internal consistency of a help-seeking instrument
Attitudes towards organ donation

Eftect of shelf space and price on the sale of pet food
Influence of attitudes, feelings and exposure on organ donation behaviour
Attitudes towards US military bases in Australia
Reader publication preferences and geographic location
Comparison of productivity across factories
Comparison of factory productivity by time period
Evaluation of different sales training programs
Reaction times across drug conditions

Relationship between sales performance and employee income
Criteria used in selection of rams for breeding

Native trees growing in gardens

Tourist perceptions of distance between Australian cities

Practice examples

Practice 2
Practice 3
Practice 4
Practice 5
Practice 6
Practice 7
Practice 8
Practice 9

Attitudes towards new school opening

Adolescent attitudes towards their future

Difterences in white goods sales across junior and senior sales staft
Relationship between smoking and lung damage

Hypnosis and memory recall

Comparison of nutrient value of varying food supplements in rats
Comparison of weight gain in rats across varying food supplements

Influence of density of traffic and type of intersection on number of
road accidents
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KaRaNLIK



Practice 10
Practice 11
Practice 12
Practice 13
Practice 14

Practice 15
Practice 16
Practice 17

Practice 18

Practice 19a
Practice 19b
Practice 19¢
Practice 19d
Practice 19e
Practice 19f
Practice 19g
Practice 20a
Practice 20b

Practice 21

Differences in house sales according to suburb and time of year
Influence of colour and background on visual aesthetics

Effect of caffeine on motor task performance

Influence of auditorium size and sound-proofing on quality of acoustics
Influence of peer tutoring on level of computer anxiety

Reliability of independent personality scales — hope, optimism, locus
of control and self-esteem

Factor structure of independent personality scales — hope, optimism,
locus of control and self-esteem

Relationship between the volume of wood and forest characteristics
(number of trees, average age of trees, average volume of trees)

Gender differences across personality measures

Customer preference for specialty coffee bags

Gender differences in drink preference

Relationship between personality types and religious affiliation
Effect of temperature on pilot performance

Number of injuries across different sports

Companionability of varying dog breeds

Effect of load on truck fuel consumption

Reasons for getting married

Factors influencing purchase of a used car

Tourist perceptions of similarity among distance between nine cities

Note: there are no working or practice examples for chapters 1 and 22.
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Introduction to SPSS

This chapter provides an introduction to using SPSS version 12.0 for Windows. It
addresses aspects of the SPSS environment, describes the menu options and toolbars,
and provides instructions on how to begin and end an SPSS session.

Getting started

If this is one of your first experiences with the SPSS package, do not be put off. Before
long, you will be able to manoeuvre around the package with ease and carry out all
kinds of analytical procedures. Now, it’s time to familiarise ourselves with the SPSS
program and its attributes.

When SPSS is initially installed, the SPSS program group is created in the Programs
menu. To start an SPSS session, double-click on the SPSS icon.

:‘g

goac

i

LE

Eiect PC and Sleep

Help and Support

Run...

Windows XP Professional
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The SPSS environment

& SPSS for Windows provides a powerful statistical analysis and data management
system in a graphical environment, using descriptive menus and simple dialogue boxes
to do most of the work for you. Most tasks can be accomplished simply by pointing
and clicking the mouse.

In addition to the simple point-and-click interface for statistical analysis, SPSS has
eight different types of windows:

» Data Editor

* Viewer

* Draft Viewer

* Pivot Table Editor
* Chart Editor

* Text Output Editor
* Syntax Editor

* Script Editor

Data Editor

The Data Editor is a versatile spreadsheet-like system for defining, entering, editing
and displaying data. This window opens when you start an SPSS session and displays
the contents of a data file. In this window you can create new data files or modify
existing data files. As outlined, the data editor is like a spreadsheet where cases are
represented in rows and variables are represented in columns.

Hﬂ\éara View K arianie vien [
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Viewer and Draft Viewer

The Viewer makes it easy to browse your results, selectively show and hide output,
change the display, order results and move presentation-quality tables and charts between
SPSS and other applications. This window opens automatically the first time you run a
procedure that generates some output. The window displays all statistical results, tables
and charts and allows you to edit the output and save it in an output file for later use.
This window also allows you to access the Pivot Table Editor, Text Qutput Editor and
Chart Editor and to move between SPSS and other applications, e.g. Word.

The window 1is divided into two panes. The left pane, referred to as the outline pane,
contains an outline view of the output contents and can be used to navigate through
your output and control the output display — very handy if you have a lot of output.
The right pane of the window is the contents pane, which contains statistical tables,
charts and text output. If you select an item in the outline pane, the corresponding item
in the contents pane is highlighted. Moving an item in the outline pane moves the cor-
responding item in the contents pane. The width of the outline pane can also be
changed by clicking on the right-hand border and dragging it to the desired width.

= Frequencies

Statisics

You can also display output as simple text (instead of in interactive pivot tables) in the
Draft Viewer.

Pivot Table Editor

Output displayed in pivot tables can be modified in a number of ways. Using this
editor, it is possible to edit text, rearrange rows, columns and layers, add colour, create
multidimensional tables and selectively hide and display results. You move into the
Pivot Table Editor from the Viewer by selecting the table you want to edit and clicking
the right mouse button to open the SPSS Pivot Table Object.

CHAPTER 1 e Introduction to SPSS
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Frequencies

- R

This will reveal the Pivot Table, formatting toolbar and pivot trays and allow editing of
tables to begin.
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Chart Editor
High-resolution, full-colour pie charts, bar charts, histograms, scatterplots, 3-D graphics
and more are included as standard features in SPSS. These can be edited in the Chart

Editor. Changes in colour, font, axes, rotations and chart types can also be made using
the Chart Editor.

v,

b4

% Bl 8 nseom

You move into the Chart Editor from the Viewer by selecting the chart and clicking the
right mouse button to open the SPSS Chart Object. This will reveal the Chart Editor
and allow editing of charts to begin.

Fle €& vew Chat top
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Text Output Editor

Text in the Viewer that is not displayed in pivot tables or charts can also be modified
using the Text Output Editor. Possible modifications include changes to font character-
istics such as colour, type, style and size.

Syntax Editor

Although most tasks can be accomplished by simply pointing and clicking, SPSS also
provides a powerful command language, which allows you to save and automate many
common tasks. The command language also provides some functionality not found in
the menus and dialogue boxes.

As you undertake particular procedures in SPSS, you can paste your dialogue box
choices into a syntax window. This window contains the command syntax that reflects
the choices you have made in selecting menu options. These commands can then be
edited to include special features not available through the pull-down menus and dia-
logue boxes, and they can be saved in a file for further use.

sex | race

rodoad ]
e e e b
~

i

28
27
28] K
28 i
33

. 2
‘Caaxa ey £ e e 7

At the top of the syntax window there is a menu titled Run. This menu allows you to
process the commands you have pasted. You choose whether to run the current com-
mand, all the commands currently in the syntax window, a selection of commands or
just to the end of the command syntax.

n SPSS: Analysis without Anguish
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If you have decided to paste your syntax in this manner, you will need to use the Run
menu to obtain your output and move into the Viewer window.

Script Editor

Scripting and OLE automation allow you to customise and automate many tasks in
SPSS. With the Script Editor, you are able to create and modify basic scripts within the
program,

At the top of each window you will have noticed a menu and an icon bar. Let’s learn
more about these particular features, which provide quick and easy access to the
special features available in each of the SPSS windows.

The toolbar, located just below the menu bar, provides quick, easy access to many fre-
quently used features. The toolbar contains tools that are available when a particular
type of window is active. Each window has its own toolbar. When you put the mouse
cursor on a tool in an active window, a brief description of that tool is displayed.

Tools in the Data Editor include:

i

SRS B || =k & Q&R 29

* File Open allows particular data files to be opened for analysis.
+ File Save saves the file in the active window.
 File Print prints the file in the active window.

* Dialogue Recall displays a list of recently opened dialogue boxes, any of which can
be selected by clicking on their name.

* Go to Case allows the typing in of the number of the case you want to go to and it
will be found in the data file.

* Variables provides data definition information for all variables in the working data
file.

CHAPTER 1 o Introduction to SPSS
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* Find allows data to be found easily within the data editor.
* Insert Cases inserts a case above the case containing the active cell.

* Insert Variable inserts a variable to the left of the variable containing the active
cell.

» Split File splits the data file into separate groups for analysis based on the values of
one or more grouping variables.

* Weight Cases gives cases different weights for statistical analysis.

* Select Cases provides several methods for selecting a subgroup of cases based on
criteria that include variables and complex expressions.

* Value Labels allows toggling between actual values and value labels in the Data
Editor.

* Use Sets allows the selection of sets of variables to be displayed in the dialogue
boxes.

Some of the tools in the Viewer include:

* Print Preview allows what will be printed to be viewed.

* Export Output saves pivot tables and text output in HTML, text, Word/RTF, and
Excel format, and it saves charts in a variety of common formats used by other
applications.

* Go to Data moves directly into the data file and makes the Data Editor window
active.

* Insert Heading, Title, Text allows headings, titles and text to be added into your
output.

* Show/Hide allows output to be shown or hidden.

The Chart Editor has a range of tools that can be used to make your charts more inter-
pretable and attractive, including:

Ta 3 MR s By T
,,,,,,,,,,,,, f2. 1 mB ¥ P =,

* Show Properties Window shows the properties of the chart.

* Insert a Text Box allows the insertion of a text box.

* Show/Hide Legend allows the legend on a chart to be shown or hidden.
* Show Data Labels allows the data labels to be shown on the chart.

In the Syntax Editor Window the tools are similar to those in the Data Editor, with a
few additions:

18| @] o Ol=lk| ) »| @z |

¢ Run Current runs commands that are selected or, if there is no selection, the com-
mand in which the cursor appears.

* Syntax Help assists you with the syntax for the analysis you are undertaking.

n SPSS: Analysis without Anguish
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Menus

SPSS is menu driven and has a variety of pull-down menus available for the user. The
main menu bar in the Data Editor contains ten menus:

« File

< Edit

e View

¢ Data

¢ Transform
* Analyze
¢ Graphs

¢ Utilities
¢ Window
« Help.

The Analyze and Graphs menus are available in all windows, making it much easier
to generate new output without having to switch between windows.

File

The File menu allows you to create new files, open existing files, read in files from
other software programs, save files and print.

i

Hew
Oper
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save Colag 1.00 17 1 1 2 51 12 37 12 a7’ 22
Save as... 100 2 1 2 i k) 20 20 18 200 757
e nead ooty ot 5 5 o > % e T AR i
et SIS . X 2 . o % " " & o
1,00 2 1 4 bl 2 12 98 98 97 42:
100 2 0 7 59, 10 3 3 ' 0
i G e : R e e
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Edit

The Edit menu allows you to modify or copy text from the output or syntax windows,
and to search for and replace text or data. It also offers a number of personal prefer-
ence options.

Oata Transform Analyze Graphs Utities

| 4
| region happy | lfe | sibs | chids | "age | educ [ paeduc | maeduc | speduc | prestg80 | 43
12

Copy
“ 100 1 7 1 2 B I &7 2z
; o : En 2 1 2 1 32 2% S 2 i
. S 00 1 § 2 1 3 2 1% 17 56
i Find. . R 100 g 2 H 0 2 0 20 20 a7 18
L Optoss... SR 2 1 A 0 a; .3 % e 2
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View

The View menu allows you to make the status bar and toolbar active, and to change
particular characteristics of the window (for example, by removing grid lines, dis-
playing value labels and changing font style and size).

s
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Data

The Data menu allows you to define variables and create variable templates. In
addition, more global changes to SPSS data files are available, such as merging files,
inserting, sorting and transposing variables and cases, and selecting and weighting
cases.

rer: otTal Survey -

Data Transform  Analyza Graphs

Define variabia Froparties.,,, i (T i o i
Copy Data Proparties... »j l_' ‘I‘ r: % @
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Transform

The Transform menu allows you to change certain variables in the data file using
commands such as Recode and Rank Cases, as well as to create new variables using
the Compute command.

n SPSS: Analysis without Anguish
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Analyze

The Analyze menu allows you to select the analysis you require. A variety of statistical
procedures are available, ranging from summarising data through to more complex
designs.
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Graphs

The Graphs menu allows you to create bar, line, area and pie charts, as well as histo-
grams and scatterplots.
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Utilities

The Utilities menu allows you to display file and variable information. In addition, it
allows you to define and use different variable sets.
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Window

The Window menu allows you to arrange, select and control the attributes of the
various windows. Using this menu, you can move efficiently between data, syntax,
output and chart windows.

Edit
=HS
4]

i se

Help

The Help menu allows you to access information on how to use the many features of
SPSS. The SPSS tutorial can be accessed through the Help menu.

Data Tramsform Analyze Graphs Ulbfities Window | M
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Dialogue boxes for statistical procedures

When you choose a statistical procedure, a dialogue box appears on the screen. Each
main dialogue box has four basic components: the source variable list, the target
variable(s) list, command pushbuttons and the option to choose sub-dialogue boxes.

Yarablels):

< Race of Responde| = |
# Region of the Unit
#® General Happiness

) Reset i
@ lIs Life Exciting or D i
@ Number of Brothers Cancel }
i’@ Number of Children Help l

4 Age of Respondernt;

B0 R Y SRV 3P Wb A

[V Display frequency tables

Statistics... Chars... Fomnet...

N—
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Source variable list

The source variable list is a list of all the variables in the data file.

To select a single variable

Highlight the variable and click on the ] button next to the selected variable list box.
|

Varablels):

@ Race of Responde :
@ Region of the Unite
@ General Happiness

’

, Reset
@ Is Ufe Exciting or D
@ humber of Brothers Eff_e_l_’

& MNumber of Children Help l

® Age of Pespondent- »
i
AN TN e o Ve w oL

¥ Display frequency tables

Statistics... ’ Charts... Format... l

% To select multiple variables that are grouped together in the variable list

Click on the first variable you wish to select, then hold the Shift key and click on the
last variable in the group. Then click on the ] button.

Variableis):

Reset i
® ’ Cancel ’
& Number of Children Help i

@ Age of Respondeni

R LW SR VR o

V¥ Display frequency tables

Statistics... Charts... Format... t
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&

y > To select multiple variables that are not grouped together

Click on the first variable, then hold the Ctrl key and click on the next variable, and so
on. Then click on the ] button.

Yanablels)

4 Race of Responde| =
@ Region of the Unit
4 General Happiness

[
jal% st

Reset

z K - Canceli
@ Mumber of Children Help l

@ Age of Responden

N L limlz ot Vs £ 0

I Display frequency tables

Statistics... ! Chats... Format ... i

Selected variable(s) list

The selected variable(s) list is a list or lists of variables you have chosen for certain
analyses. For certain statistical procedures, both dependent and independent variable
lists are created.

If you wish to remove variables from this list, highlight the variable and click on the @]
button, which you will notice is now reversed. This process is called deselection of
variables.

Command pushbuttons

The five standard command pushbuttons in most dialogue boxes are:
* OK Runs the procedure.

* Paste Pastes the syntax associated with a procedure into the Syntax Editor
window. This command syntax can then be modified if necessary or new
syntax can be added.

* Reset Deselects the variables in the selected variable list(s) and resets all speci-
fications in the dialogue and sub-dialogue boxes.

Cancel Cancels any changes in the dialogue box settings since the last time it
was opened, then closes the dialogue box.

Help Allows access to a Help window relevant to the current procedure.
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& Respondent's Sex A OK l
@ Race of Responde

@ General Happiness ..f.a_s_i.e._.’
@ Is Ufe Exciting or D : Reset i
@ Number of Brothars 4]

4> Number of Children _SB’E’I_]
4 Age of Respondent Help
4 Highest Year of Sch

PN NPV Y

V¥ Display frequency tables

Statistics‘..i Charts.,.! Format...

Accessing sub-dialogue boxes

When selecting a statistical procedure, you can make additional specifications that are

available in the sub-dialogue boxes. These are accessed by selecting the buttons at the

bottom or on the side of the main dialogue box. These buttons may include: Statis-

tics..., Charts..., Format..., Options..., Save..., Plots..., Cells..., etc.

As outlined in the screen dump below, the three command pushbuttons within sub-

dialogue boxes are:

* Continue Saves any changes to the settings and returns to the main dialogue box.

» Cancel Ignores any changes, restores the previous settings and returns to the
main dialogue box.

* Help Allows access to a Help window relevant to the current procedure.

T T Y I VW R — - Central Tendency

7 Quartiles ; ™ Mean Cancel
™ Cut points fDl’:l”& *  equal groups [ Median Help
[~ Percentilefs): I I~ Mode

: ™ Sum

™ walues are group midpoints

- Dispersion +~ Distribution -~
I~ Std. devistion [~ Minimum T Skewness
[~ Varance ™ Maimum ‘ ™ Kutosis !
I™ Range ™ SE mean !

!
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Check boxes, radio buttons and drop-down lists

Within sub-dialogue boxes, choices can be made using check boxes, radio buttons and
drop-down lists.

Check boxes

Check boxes () allow you to select certain options within sub-dialogue boxes. When
you click on the box, v is displayed in the check box [ To deselect this option, click
the box again. Multiple check boxes can be selected if required.

- POrContile Valuas s . ~Central Tendency
r Quartiles x r; WMean Cancel g
[~ Cutpoints eril)f‘f equal goups v Median Ly

; Heip !

N ?ercentile{s}:! . v Mode

Pl ™ Sum

™ Walues are group midpaints

DiSDefSiOn , astnbmmn ,,,,,,,,,,,,,,,,,,,,,,,,,
¥ Std. deviation ¥ Minimum (¥ Skevness

| v ‘arance Vv Maximum ’ ¥ Kutosis

' ¥ Range M SEmean = |

Radio buttons

Radio buttons (O) allow you to make single selections within sub-dialogue boxes.
When you click on the radio button, a solid black circle appears in the centre of the
button @).

Varables:

:

@ Race of Responder__
#® Region of the Unite:
B General Happiness

@ Is Life Exciting or Dt S

< Number of Brothers Cancel
4 Number of Chilgren
@ Ane of Resnandent
~Comelation Coefficients

¥ Pearson |7 Kendalstaub [~ Speamen

Reset

Help

Pese |
s |
_tes |

~Test of Significance
¥ Twoiailed " Onedailed

Options...
¥ Flag signfficant comelations ~——E—-—-———J

n SPSS: Analysis without Anguish

KaRaNLIK



Drop-down lists

Drop-down menus or lists allow you to make single selections from a list of alternatives.

r Regressi

# Respondent's Sex |4 Dependent:
# Race of Responde l

< Region of the Lintte - Block 1of 1

@ General Happinees

B ls Life Bxcting or D)
@ Humber of Brothers
4 Humber of Children
@ Age of Respondent
@ Highest Year of 5S¢l
@ Highest Year Schar Method:  |Emer -
@ Highest Year Scho:

D> Hi ot [l ! R Y

@ Highest Year Scho: Selestion Va| 3159

® R's Qeeupational P Femove
Backward

4 Occupational Catey
B R's Federal Income Case Labels:

W Take Active Patin
@ To Obey lobey]

@ To Be Well Liked o WILS Weight:
#® To Think far Oneseé{ Z l

Staﬁs‘h’cs,.‘i Plots... l Save... } COptions...

Reset

=y

Independent(s): Cancel {

Help

i

Saving files and ending a session

To save files in SPSS, the Save As... command is selected from the File menu. If you
are working in the Data Editor window, then the file extension .sav will be displayed in
the Save as type: box and you will be prompted to type in a filename in the Filename:
box. If you are in the Viewer window, then the extension .spo will be displayed. And if
you are in the Syntax Editor window, then the extension .sps will appear.

Save” Daf& Xs

Savein:l@spss :_J i c¥ B~
=™l @AML survival
ru @}anorectic
[)Scripts @Anxiety
) Tutorial AnXiEt"f’ 2
,, @_’]Breast cancer survival
Blcarpet
- o
< 2
Keeping 43 of 43 variables. Variables... !
File name: 11991 1).S. General Social Survey l Save '
Save as type: ]SF‘SS sav) :J Paste [
" Cancel i

r:
[
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To end a session, select the File menu and the Exit option. If you exit a session
without first saving your files, then SPSS will prompt you to save the contents of each
window.

Fle' Edit view Dats Transform Analyze Graphs dtfites Wndow Hep

e bl o] s

Cpan
Open Database »
[ ResdTedbatd v degion | heppy | i | sibs | chids | age | educ [ paeduc | maeduc | speduc

seve Crl+s 1.00 e o o 2 61 2 97 12 97

Save 5. 100 H 1 2 1 32 20 P 18 20

Mark Fle Reac Only 10 1 g 2 1 3% 28 i 4 17

Display Data Fila Information » 100 9 2 2 0 26 20 20 20 57

Cache Data... 100 2 1 4% 0 5 2 95 93 97

E : : 100 2 0 7 A 9 14 5 7 0

Swstch Server... 160 1 5 7 kl 45 1q R 93 97 g

Print Preview 100 2 0 7 4 59 16 g [ 97 ]

Print... e 100 2 2 ? 3 57 1 8 H 7 0

R 160 2 | i H &4 " 3 12 20 33

ezently Lised Data 4 . 1 5 75 g 7 k] a7 B

cecently Used Fies , 100 2 1 [ 0 2 g 12: 93 a7 36
o . 1.00 1 0 H H §7 12 8 13 23
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Preparation of data files

This chapter describes the process involved from data source to data file: that is, the
conversion of raw source material to a useable data file. It focuses on defining vari-
ables, assigning appropriate numeric codes to alphanumeric data and dealing with
missing data. These preparatory steps are desirable before data entry can begin. Other
procedures such as applying variable definition attributes to other variables, entering
data, inserting and deleting cases and variables, saving data and opening existing data
files will also be addressed.

Working example

You have developed a questionnaire that asks a number of questions relating to an
individual’s shopping behaviour. The variables you have measured include: gender,
age, desire for 24-hour shopping, choice of shopping area and amount spent on
groceries per week. For each case you have assigned a participant identification
number.

Defining variables

The process of defining variables has seven optional steps. The primary step is naming
your variable and the other steps cover labels (variable and value), missing values,
variable type, column format and measurement level.

f%‘b Naming o variable

Variable names must comply with certain rules:

» Must begin with a letter. The remaining characters can be a letter, any digit, a full
stop or the symbols @, #, _or $.

» Cannot end with a full stop or underscore.
* Blanks and special characters cannot be used (for example, !, ?, ‘, and *).
* Must be unique; duplication is not allowed.

» The length of the name cannot exceed 64 bytes (typically 64 characters in single-
byte languages e.g. English, German, French, Spanish etc.).

» Reserved keywords cannot be used as variable names e.g. ALL, AND, BY, EQ, GE,
GT, LE, LT, NE, NOT, OR, TO, WITH.

« Names are not case sensitive, i.e. can be written in upper or lower case.

¢ Long variable names need to wrap to multiple lines in the output, so SPSS attempts
to break lines at underscores, periods, and a change from lower to upper case.
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In the case of the variable age, the variable name can be age because this name com-
plies with all of the rules listed. The variable choice of shopping area can be labelled
area, and the other variables on the questionnaire could be id, gender, allday and cost.

Variable labels

The variable label is the full description of the variable name and is an optional means
of improving the interpretability of the output. For example, the first variable you will
name in the data file is id and the label for this variable is ‘participant identification
number’. Suggested variable labels for the other variables appear in the following table.

Variable name Label

gender optional

age optional

allday desire for 24-hour shopping facilities
area choice of shopping area

cost amount spent on groceries per week

You will notice that the gender, age and choice of shopping area variables do not
require variable labels because the variable names are self-explanatory.

Value labels

It is possible to use alphanumeric codes for the variables; however, you may also wish
to use a numeric code. For example, for gender you could assign a code of 1 for female
and 2 for male. This type of variable is categorical because it has discrete categories.
The variables allday and area are also categorical. When variables are measured using
interval or ratio scales, then coding is not relevant unless categorisation is required.

Value codes and labels for the above variables are illustrated in the following table.

Variable name Label
id not applicable
gender 1 = female
2 = male
age not applicable
allday 1 = would use 24-hour shopping

2 = would not use 24-hour shopping

area 1 = shop in suburb where living
2 = travel fo next suburb
3 = travel further to shop

cost not applicable

Missing values

It is rare to obtain complete data sets for all cases. When dealing with missing data you
may leave the cell blank or assign missing value codes. If you choose the latter, then a
number of rules apply:

» Missing value codes must be of the same data type as the data they represent. For
example, for missing numeric data, missing value codes must also be numeric.

* Missing value codes cannot occur as data in the data set.

* By convention, the choice of digit is usually 9.
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Variable type

By default, SPSS assumes that all new variables are numeric with two decimal places.

However, it is possible to select other variable types (such as date, currency, string) and
vary the number of decimal places.

Column format

It is possible to adjust the width of the Data Editor columns or change the alignment of
data in the column (left, centre or right).

Measurement level

You can specify the level of measurement as scale (interval or ratio), ordinal or nominal.

To define a variable

1 Working in the Untitled — SPSS Data Editor window, double-click a variable
name at the top of the column in the Data View or click the Variable View tab.

2 In the first blank cell of the Name column, type the first variable name (i.e. id)
and press Enter.

Fip Edit vien Data Transform Analyze Graphs Utlites Window Halp

BR8] B v k] Bl el
o tlame I Type de!h[ Decimals | Label Values ! Missing Columns | Align I Measure 21

1jid {lHumeric 2 ! hene Nong 3 {Right Scale

{1+ I\ Data View jVariable view /T 00 0 - o I

{SPSS Processor s ready

'} Coskes Version 113

L8\ crapter 2 -terasoft..c.- | 8] Chapter 2-Micrasofts .,

3 In the first blank cell of the Label column, type the label for the variable, i.e.
Identification Number. You will notice that the width of the column automati-
cally increases to accommodate the long label.

For the variable id, there are no value labels or missing values, and the other properties
are appropriate so you can move on to the second variable.

If you return to the Data View, by clicking the Data View tab you will notice that the
variable name id has appeared in the first column as a heading.
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%f%? To repeat this process for the second variable, gender

1 Working in the Variable View, in the second blank cell of the Name column,
type the second variable name, i.e. gender, and press Enter.

Again, SPSS automatically supplies other properties such as type, width, values, etc.
Since gender requires no further explanation a label will not be typed in. However,
values are assigned.

2 Click on the second cell of the Values column and then on the button on the
right to open the Value Labels box. In the Value: box, type the first value code
for the variable (i.e. /) then tab. In the Value Label: box, type the label for this
value, i.e. female.

3 Click on Add. You will notice that the value and its label have moved into the
box below.
4 Repeat this process for the second value.

Vatua Labats”

Value Labels OK
Value: l
Cancel
Value Label: |
Help
5 Click on OK. You will notice that there is now information in the cell.
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To create o missing value

1 Click on the second cell of the Missing column and then on the button on the
right to open the Missing Values dialogue box.

Select the Discrete missing values radio button.

In the first box, type the missing value code, i.e. 9.

" No missing values

% Discrete missing values ]

9
I ‘ l Help
" Range plus one optional discrete missing value

Lo | High |

Dhiserete vabue ’

4 Click on OK. You will notice that the missing value has been recorded.

Fle Edt View Datas Transform Anafvze Graphs Utiites ‘Window Help
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The previous process is then repeated for each variable you wish to define in your data
file. As highlighted earlier in this chapter, other options such as Type, Column Width
and Measurement Level are also available if you are dealing with different types of
variable that require special conditions. For the variable gender, you may wish to
select the nominal scale of measurement.

Applying variable definition attributes to other variables
Once you have nominated variable definition attributes for a variable you can copy one
or more attributes and apply them to one or more variables. Basic copy and paste
operations are used to apply variable definition attributes. For example, you may have
several variables with a Likert scale response format. That is, you may have several
variables that use the same response scale where 1 = strongly disagree, 2 = disagree,
3 = neutral, 4 = agree and 5 = strongly agree. Having defined these value labels for one
variable you can then copy them to other variables.

To apply variable definition afiributes to other variables

b
1 In the Variable View, select the attribute cell(s) you want to apply to other variables.
2 From the Edit menu click on Copy.

3

Select the attribute cell(s) to which you want to apply the attribute(s). You can
select multiple target variables.
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4 From the Edit menu click on Paste.

If you copy attributes to blank rows, then new variables are created with default attri-
butes for all but the selected attributes.

Entering data

?’% To enter the following two cases

id gender age allday area cost
1 male 27 1 1 4
2 female 34 2 3 7

1 In the Data View click on the first cell in the Untitled — SPSS Data Editor
window. You will notice that a heavy border appears around the cell, indicating
that the cell is now active.

2 Type in the first value for id, i.e. /. This value is displayed in the cell editor at
the top of the Data Editor window and also in the cell itself.

& dits e 7
Fie Edt view Data Transform Analyze Graphs Utites Window Help
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A

3 Press Enter or move to another cell by using the arrow keys or mouse. Data
values are not recorded until you press Enter or select another cell. Remember
that it is more efficient to code gender numerically.

4 To move around your data file quickly, you can hold down the Control key with
an arrow key to take you to the limit of the file in that direction.

Having entered data for the first two cases, your Data View window will look like this:

File Edit Yiew Dats Transform - Analyze Graphs. Utlites Wmdow Help
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lnserfmg and deleting cases and variables

Often you may need to insert or delete extra cases (rows) and variables (columns) in
the existing data file. You can achieve this by using the menus as described below or by
using the appropriate tools from the toolbar.

To insert @ new case between existing cases

1 Select any cell in the case (row) below the position where you want to insert the
new case.
2 Select the Data menu and click on Insert Case or click on the Insert Case tool.

A new case (row) will be inserted.
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Moving

-

1

To insert a new variable between existing variables
Select any cell in the variable (column) to the right of the position where you
want to insert a new variable.

Select the Data menu and click on Insert Variable or click on the Insert
Variable tool. A new variable (column) will be inserted.

To delete a case {row)

Click on the case number on the left side of the row if you wish to delete the
entire case or select any cell in the row that you wish to delete.

Select the Edit menu and click on Clear. Alternatively, you can use the Delete
button on the keyboard.

To delete a variable {column)

1 Click on the variable name at the top of the column if you wish to delete the
entire variable, or select any cell within the column that you wish to remove.

2 Select the Edit menu and click on Clear. Again, you can use the Delete button
if you wish.

variables

You may wish to change the sequence of variables in the Data Editor window. If you
want to position the variable between two existing variables, then insert a new variable
in the position where you want to move the variable.

G
1

4

>

1
2
3

To move a variable

For the variable you want to move, click the variable name at the top of the
column in the Data View or the row number in the Variable View. The entire
variable is highlighted.

Select the Edit menu and click on Cut.

Click the variable name in the Data View or the row number in the Variable
View where you want to move the variable to. The entire variable is highlighted.

Select the Edit menu and click on Paste.

Saving data files

To save a data file for the first time

First ensure that you are in the Data Editor window.
Click on the File Save tool.

You will be asked to give the file a name.

or

Select the File menu and click on Save As... to open the Save Data As dialogue
box.

In the box for File Name: type in the file name of your choice. SPSS will
append the extension .sav automatically. If you are saving data to a floppy disk,
then remember to change to the appropriate drive.

Click on Save.
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f)b To save an existing data file

1 First ensure that you are in the Data Editor window.
2 Click on the File Save tool.
or

1 Select the File menu and click on Save Data. Your changes will be saved to the
existing file.

Openmg an existing data file

Once a data file has been saved in SPSS it can be accessed in subsequent sessions.
Furthermore, files that have been created in other software packages can be imported
into SPSS.

b
1 Select the File menu.

2 Click on Open and Data... to open the Open File dialogue box.
3 Select the file from the file list.

4 Click on Open.

"’%%} To read o text data file

Select the File menu.

Click on Read Text Data to open the Open File dialogue box.
Select the file from the file list.

Click on Open.

N W =

Follow the steps in the Text Wizard to define how to read the data file.

Practice example

You have surveyed individuals within your local community to determine their attitude
towards the opening of a new school. You have collected data on the variables in the
following table.
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would you
length of number of use the

id gender residence children school?
1 Female 2 2 Yes
2 Male 3 1 No
3 Male 6 2 Yes
4 Male 5 4 No
5 Female 8 3 Yes
6 Female 9 2 Yes
7 Female 11 2 Yes
8 Male 3 0 Yes
9 Male 5 2 Yes

10 Female 12 3 Yes

11 Male 10 1 No

12 Female 8 1 Yes

13 Female 9 4 Yes

14 Male 9 2 Yes

15 Male 3 0 No

16 Female 1 3 Yes

17 Male 0.5 1 Yes

18 Female 4 2 Yes

19 Male 3 1 [4

20 Female 2 1 Yes

Given the above data, your task is to create a data file in SPSS. Remember, you must
define each variable, allocating appropriate variable and value labels. Other definitions
are optional. Data must then be entered and saved in a data file.
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Data screening and
transformation

Data screening and transformation techniques are useful in making sure that data have
been correctly entered and that the distributions of variables that are to be used in
analysis are normal. If variable distributions deviate dramatically, then this may affect
the validity of the results that are produced. If distributions do vary from normal, then
non-normal distributions may be transformed before further analysis. Furthermore, if
distributions deviate dramatically, nonparametric techniques may also be used because
they are less powerful than their parametric counterparts.

Data may also need to be transformed using Recode and Compute commands. In
addition, if data files have missing values, mean substitution may be an alternative.

It is often useful to be able to conduct analyses on subsets of the data and to make
conditional transformations of variables. These can be achieved using the Select If and
Compute If commands.

These procedures will be demonstrated in the context of the following research
example.

Working example

Community residents were surveyed to determine their attitudes towards physical
exercise. Participants were also asked their age, number of hours per week spent in
physical activity and whether they participated in team sports.

Each individual (of the 99 students who participated) was given an identity number.
Attitude towards exercise was measured using a seven-item scale comprising state-
ments to which participants agreed or disagreed, using a five-point Likert response
format such that: | = Strongly agree, 2 =Agree, 3 =Neither agree nor disagree,
4 = Disagree and 5 = Strongly disagree.

The data file can be found in Work3.sav on the website that accompanies this title and
is shown in the following figure. Several items of this scale were negatively worded
and thus required recoding.
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You wish to determine whether the distributions of the continuous variables (that is,
age, hours spent doing exercise and attitude to exercise) are normal. This procedure is
not necessary for team participation because this is a categorical variable.

- Errors in data entry

Errors in data entry are common and therefore data files must be carefully screened.
For example, while responses to the attitude items are being entered, out-of-range
values can be detected easily using the Frequencies or Descriptives commands and
replaced in the data file with the correct value.

» To obtain frequencies

- 1 Select the Analyze menu.

2 Click on Descriptive Statistics and then Frequencies... to open the Frequen-
cies dialogue box.

3 Select art] to att7 and click on the P] button to move these variables into the
Variable(s): box.
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¥ Display frequency tables

Statigtics.., i Chans... Format... f
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4 Click on OK.

FREQUENCIES
VARIABLES=att1 att2 att3 att4 att5 att6 att7
/ORDER= ANALYSIS .

You will observe that all cases for att/ are within the expected range of 1-5. You must
ensure the other items are also within the expected range.

att1
Cumulative
Frequency Percent valid Percent Percent

valid  strongly agree 22 22.2 222 222

agree 31 313 31.3 5345

neither agree nor . -

disagree 38 384 38.4 919

disagree 3 30 3.0 949

strongly disagree g £ 1 100.0
Total 29 100.0 100.0

Assessing normality

The assumption of normality is a prerequisite for many inferential statistical tech-
niques. There are a number of different ways to explore this assumption graphically:

* Histogram

* Stem-and-leaf plot

* Boxplot

* Normal probability plot

* Detrended normal plot.

Furthermore, a number of statistics are available to test normality:

* Kolmogorov-Smirnov statistic, with a Lilliefors significance level and the Shapiro-
Wilks statistic

e Skewness
* Kurtosis.

There are several procedures available to obtain these graphs and statistics but the
Explore procedure is the most convenient when both graphs and statistics are required.
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To obtain these graphs and statistics

Select the Analyze menu.

2 Click on Descriptive Statistics and then Explore... to open the Explore dialogue
box.

3 Select the variable you require (i.e. age) and click on the ] button to move this
variable into the Dependent List: box.

" Explore
Dt ) oK f
P sttl
P Paste l
Wt Resst
Pans Factor Ust: -~
Rt Coneel |
P Help 1
@ hoursex
@ teem paticipation ] Label Cases by

o Display e

f? Both ¢ Statistics { Plots Statistics..,z Plots... ‘ Optians... !

4  Click on the Plots... command pushbutton to obtain the Explore: Plots sub-
dialogue box.

5  Click on the Histogram check box and the Normality plots with tests check
box, and ensure that the Factor levels together radio button is selected in the
Boxplots display.

Descriptive
V' Stem-andfeaf o I l
¥ Histogram nee

Help

# Factor levels togather
¢~ Dependents togather
" Mone

V' Nomnality plots with tests
- Spread vs. Level with Levene Tegt ey
&

Click on Continue.
In the Display box, ensure that Both is activated.

8  Click on the Options... command pushbutton to open the Explore: Options
sub-dialogue box.

9  In the Missing Values box, click on the Exclude cases pairwise radio button. If
this option is not selected then, by default any variable with missing data will be
excluded from the analysis. That is, plots and statistics will be generated only
for cases with complete data.
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10 Click on Continue and then OK.

EXPLORE
VARIABLES=age
/PLOT BOXPLOT STEMLEAF HISTOGRAM NPPLOT
/COMPARE GROUP
/STATISTICS DESCRIPTIVES
/CINTERVAL 95
/MISSING PAIRWISE

/NOTOTAL.
Histograms
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Above is a histogram of age. The values on the vertical axis indicate the frequency of
cases. The values on the horizontal axis are midpoints of value ranges. For example,
the midpoint of the first bar is 20 and the midpoint of the second bar is 25, indicating
that each bar covers a range of 5. The shape of the distribution is considered normal.

Stem-and-leaf plots and boxplots

Closely related to the histogram is the stem-and-leaf plot and the boxplot. These plots
provide more information about the actual values in the distribution than does the
histogram.

The stem-and-leaf plot is very similar to the histogram but is displayed on its side. The
length of each row corresponds to the number of cases that fall into a particular interval.
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A stem-and-leaf plot represents each case with a numeric value that corresponds to the
actual observed value. For example, the stem of the graph corresponds to the first digit
of a score (2), while the leaf is the trailing digit (23347889).
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D
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The boxplot, illustrated below, also summarises information about the distribution of
scores. Unlike the histogram and the stem-and-leaf plot, which plot actual values, it
plots summary statistics such as the median, 25th and 75th percentiles, and extreme
scores in the distribution. The lower boundary of the box is the 25th percentile and the
upper boundary is the 75th percentile. The median is presented by a horizontal line
through the centre of the box. The smallest and largest observed values within the
distribution are represented by the horizontal lines at either end of the box, commonly
referred to as whiskers.

30 -

70

60 -

40+

30

20

age

If the distribution has any extreme scores — that is, three or more box lengths from the
upper or lower edge of the box — then these will be represented by an asterisk (*).
Cases with values between one-and-a-half and three box lengths from the upper or
lower edge of the box are called outliers, and these are designated by a circle.

To determine whether a distribution is normal you look at the median that should be
positioned in the centre of the box. [f the median is closer to the top of the box, then
the distribution is negatively skewed, and if it is closer to the bottom of the box, then it
is positively skewed. The spread or variability of the scores can be determined from
the length of the box.
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Normal probability plots and detrended normal plots

In a normal probability plot, each observed value is paired with its expected value
from the normal distribution. If the sample is from a normal distribution, then the cases
fall more or less in a straight line.

Normal Q-Q Plot of age

Expected Normal
o
1

i U 1 i ¥ i ] i
10 20 30 40 50 50 70 80

Observed Value

It is also possible to plot the actual deviations of the points from a straight line. If the
sample is from a normal distribution, then there is no pattern to the clustering of
points; the points should assemble around a horizontal line through zero. This type of
plot is referred to as a detrended normal plot and is illustrated in the following figure.

Detrended Normal Q-Q Plot of age
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Kolmogorov-Smirnov and Shapiro-Wilks statistics

The Kolmogorov-Smirnov statistic with a Lilliefors significance level for testing
normality is produced with the normal probability and detrended probability plots. If
the significance level is greater than .05, then normality is assumed. The Shapiro-
Wilks statistic is also calculated if the sample size is less than one hundred.

Tests of Normality

Kolmogorae-Smirmoy” Shapirg-ilks
Statistic af Sig. Statistic df Sig.
age 027 g 200* 2oz 29 828

* This is 3 lower bound of the true significance.
a. Lilliefors Significance Correction

Skewness and kurtosis

Skewness and kurtosis refer to the shape of the distribution, and are used with interval
and ratio level data. Values for skewness and kurtosis are zero if the observed distri-
bution is exactly normal. Positive values for skewness indicate a positive skew, while
positive values for kurtosis indicate a distribution that is peaked (leptokurtic). Negative
values for skewness indicate a negative skew, while negative values for kurtosis indi-
cate a distribution that is flatter (platykurtic). Other descriptive statistics, such as
measures of central tendency and variability, can also be used to determine the nor-
mality of the distribution.

Descriptives
Statistic Std. Error
age Kean 45 3% 1212
2% Confidence Lower Bound 42.9%
Interval for Mean Upper Bound
47.76
2% Trimmed Kean 4528
edian 4200
Yariante 145,415
Std. Deviaticn 12.058
Kinimum 18
aximum 75
Range 27
Interquariie Range 18
Skewness A28 243
Kutgsis -.318 431

You should be familiar with most of the above statistics. However, you may not have
encountered the 5 per cent Trim statistic, which is the mean of the distribution with the
top 5 per cent and the bottom 5 per cent of scores removed. The purpose of this trim-
ming is to obtain a measure of central tendency that is unaffected by extreme values.
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Assessmg normality by group

It is sometimes necessary to assess the normality of a variable across two or more
levels of another variable. For example, you may wish to assess the normality of age
for team participants and non-team participants separately. This can be achieved using
the preceding procedure with one addition. In the Explore dialogue box you will
notice that there is a Factor List: box. By transferring your group variable (that is,
team participation) into this box, the chosen statistics and plots will be generated for
each group independently.

Variable transformation

Variables rarely conform to a classic normal distribution. More often, distributions are
skewed and display varying degrees of kurtosis. When skewness and kurtosis are
extreme, transformation is an option.

The decision to transform variables depends on the severity of the departure from nor-
mality. Having decided that transformation is desirable, the researcher must select the
most appropriate transformation methods. The options available can be found in any
good chapter on data screening.

To illustrate the process of transformation, the hours of exercise variable will be exam-
ined using the above steps. Plots and normality statistics were obtained.

Descriptives

Statistic 3td. Errer
hoursex  Hean 17.57 1.816
2% Confidence Lower Bound 1204
Intersal for Mean Uppsr Bound
21.27
5% Trimmed Kean 1£.49
KMedian 11.00
ariance 326.357
Std. Daviation 18.055
Hinimum 1
laximum 87
Range 85
Interquartile Range 21
Skewness 1770 243
Kurtosis 2475 481
Tests of Normality
Kolmogarow-Smimoy” Shapirg-yvilks
Statistic df Sig. Statistic df Sig.
hoursex 178 99 000 B12 99 000

a. Lilliefors Significance Correction
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Detrended Normal Q-Q Plot of hoursex
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All the above charts and statistics suggest that the variable hoursex is not normally
distributed but is significantly positively skewed. The boxplot indicates that there are
five outliers, as illustrated by the circles. Therefore, a natural logarithmic transformation
is appropriate.

To transform the variable, you will need to use a data transformation command called
Compute.

iﬁ’# To compute values for a variable based on numeric transformations of
other variables

Select the Transform menu.

2 Click on Compute to open a Compute Variable dialogue box.
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3 In the Target Variable: box, where the cursor is flashing, type an appropriate
variable name (i.e. Inhours).

4 From the Functions: box, select the appropriate transformation (i.e. LN(numexpr))
and press the [a] button.

5 From the variable list box, select the variable (i.e. hoursex) and press the ]
button to insert the variable in the function.

1 Compute Variable

Target Jasable: Mumeric Expression:
firhours = |LMhoursex:

Type & Label... l

_'_I < ___}_j‘_j Functions:
o eelz=] 2]8I8|TE
I N .L}_j 2]
23l
|

~ i Detele

OK i Paste 1 Reseti Cance{] Help ]

6 Click on OK.

COMPUTE Inhours = LN(hoursex) .
EXECUTE .

If you now return to your data file, you will see that a new variable has been created in
the data file called Inhours. To make things quicker, use the SPSS Manager at the
bottom of your screen to quickly move between your data and syntax editor windows
and the SPPS Viewer, which displays your output.

IL'__», 2o
att3 ] a4 | att | ams | au? | howsex ] tearmnpant | age | inhours | agecat | A
1 7 z 3 1 3 4 4 4 2 3% 181 100
2 z 2 3 i 1 4 4 2 1 2 44 240 100
3 3 2 1 4 4 4 1 1 30 2 2 340 160
4] E) P 2 3 4 i i i B i FOI Za0
5 3 5 4 H 5 3 2 2 47 314 200
5 5 3 B 5 g H 4 72 1 72 K 200
7 7 3 5 2 i i i i 27 2 57 336 200
8 5 1 3 1 5 ! 3 1 27 27 240 100
9 § 1 4 i 3 4 1 3% 2 52 336 2.00
16 1 3 5 3 3 5 5 7 2 a2 195 100
11 1 1 3 4 5 7 A 57 165 200
12 12 2 1 4 H 5 3 2 8 110 200
13 13 3 kB 4 5 2 2 kG 1 100
1 14 2 3 5 H 4 10 a0 230 2400
5 15 3 H 4 4 5 4 2 27 138 190
15 18 3 i Ty 4 7 2 i 195 2800
17 17 1 5 5 51 1 40 383 160
18 18 1 5 5 5 45 2 45 Kkl 200
15 19 3 3 3 3 4 6 2 86 179 200
b g e > 5 e R R s
21 21 2 4 3 5 4 2 2 49 3.00 206
22 22 1 3 3. H 5 k] 2 47 340 200
23 23 2 2 20 4 5 1 2 24 0o 100
= AR IRTR = g i : St e
25 2% g 5 3 5 T 20 2 37 300 200°
26 26 5 3 H 5 3 3 2 38 110 200
27 3 4 3 1 B 1 2 a1 00 100
28 28" 3 i I g i 2 3 5 5% 270
P N | 5 3 by 5 S v 583 e 2w
30 30 2 § 3 5 5 75 139 PN
:D\Data View ;,(‘/anab!e%/newq/ . N * %2 SPE5 Synter & e o
{5P58 Frotessor is ready SPSS Data Editer

] Contees Yersion 1440... | ) Crepter 3-Marosoft, Chapter. ~ Mirosoft,..
n L) ., | ]

CHAPTER 3 ¢ Data screening and transformation

KaRaNLIK



Now that you have transformed the variable hoursex into Inhours, you can obtain nor-
mality graphs and statistics for this new transformed variable using the procedures out-
lined at the beginning of the chapter. This output appears below.

Descriptives
Statistic Std. Error
Inhours  klean 2.3183 11598
95% Confidence Lower Bound 2.0881
Interval for ldean Upper
pper Bound 25404
5% Trimmed ldgan 2.3376
ldedian 2.3979
variance 1331
Std. Deviation 1.15383
Hinimum 00
Haximum 4.47
Range 4.47
Interquartile Range 1.83
Skewness -312 243
Kurtosis - 708 481
Tests of Normality
Kolmc;g;orcrv'-Smirnovs Shapire-Wilks
Statistic of Sig. Statistic df 8i
Inhours 098 99 027 965 99 010
a. Lilliefors Significance Correction
Histogram
10~ e —
8 —-1 o
.
e 5 ] B ]
Q
=3
o frmcmae
[
w
4 - o— b
2_. — —
Iean = 2.3183
Std. Dev. =1 15383
0 N=99
0.00 1.00 2.00 300 4.00
inhours
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It is apparent from the preceding statistics and graphs that the natural logarithmic
transformation was appropriate because the distribution of hoursex is now relatively
normal. The Lilliefors statistic would suggest that there is still a slight problem, but all
the other diagnostic data are satisfactory. It is important to note that when reporting
and interpreting results involving transformed variables, you must acknowledge that a
transformation has been undertaken on the data.

Data transformation

b

Recode

You can modify data values by recoding. There are three instances where recoding
variables is appropriate:

* Collapsing continuous variables into categorical variables (for example, median
split).

* Recoding negatively worded scale items.

* Replacing missing values and bringing outlying cases into the distribution.

i@b To collapse o continuous variable

In relation to the research example, you wish to obtain a median split on the variable
age.

1 Select the Transform menu.

2 Click on Recode and Into Different Variables to open the Recode into Dif-

ferent Variables dialogue box. By selecting Into Different Variables, you will
retain the original data.

3 In the Variable List box, select the variable you wish to recode (i.e. age) and
click on the ] button to move the variable into the Input Variable -> Qutput
Variable: box.
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4  In the Name: box of the Qutput Variable box, type the new variable name
(i.e. agecat).

Click on the Change command pushbutton.

Click on the Old and New Values... command pushbutton to open the Recode
into Different Variables: Old and New Values sub-dialogue box.

7  Click on the second Range: radio button and type the median in the box
(i.e. 44).

In the New Value box, type the new value (i.e. I).

Click on the Add command pushbutton.
10  Click on the third Range: radio button and type the median plus one (i.e. 45).
11 In the New Value box, type the new value (i.e. 2).
12 Click on the Add command pushbutton.

-Old Value r New Value
™ Value: i (‘ Value: 1 r Sys(emmtssmg
™ Systemsnissing (‘ Copy old valuets)

£ System- or user-missing Old --> New:
; Lowest thru &4 > 1
48 thru Highest -x 2

: {~ Output vaniables are stings
l through highest T Comrsn mmmenc

Al other values Conﬁnue‘ Cancel 1 Help 1

13 Click on Continue and then OK.

RECODE

age

(Lowest thru 44=1) (45 thru Highest=2) INTO agecat .
EXECUTE .

If you now go back into your data file you will notice that the variable agecat now has
two possible values: 1 = 0—44 years and 2 = 45+ years. This variable can now be used
in analysis where categories are required.

Three of the items on the attitude scale required recoding because they were negatively

worded. Remember that the response format for the items was 1 = strongly agree,
2 = agree, 3 = neutral, 4 = disagree and 5 = strongly disagree.

To recode negatively worded scale items

1 Select the Transform menu.

2 C(lick on Recode and Into Same Variables to open the Recode into Same
Variables dialogue box. By selecting Into Same Variables, you will overwrite
the original data.

3 In the Variable List box, select the variable(s) you wish to recode (i.e. att2, att4
and art6) and click on the P button to move the variables into the Variables:
box.
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4  Click on the Old and New Values... command pushbutton to open the Recode
into Same Variables: Old and New Values sub-dialogue box.

In the Old Value box, type the old value (i.e. ).

In the New Value box, type the new value (i.e. 5).
Click on the Add command pushbutton.

In the Old Value box, type the second old value (i.e. 2).

L =T~ A - Y,

In the New Value box, type the new second value (i.e. 4).
10 Click on the Add command pushbutton.

11 Repeat steps 8, 9 and 10 for the remaining two values.

’;?’R
~Old Value 1~ New Value

& Value: l *(3 Value:; ™ System-missing

{~ System-missing

¢~ System- or Userfnissing
¢ Range:
} Weiigh l

" Range:

" Range:

J thicn

¢ All other values

Continue ( Cancel ( Help

12 Click on Continue and then OK.

RECODE
att2 attd att6  (1=5) (2=5) (4=2) (5=1).
EXECUTE .

Att2, Art4 and A6 have now been recoded to allow computation of a composite
variable.

I
?‘» To replace missing values

Missing observations can be problematic. To avoid this problem you can replace
missing values with estimates computed with one of several methods. A commonly
used method is mean substitution.

1 Select the Transform menu.

2 Click on Recode and Into Same Variables to open the Recode into Same
Variables dialogue box.

3 In the Variable List box, select the variable(s) you wish to recode (i.e. a#tl) and
click on the ] button to move the variable into the Variables: box.

4 Click on the Old and New Values... command pushbutton to open the Recode
into Same Variables: Old and New Values sub-dialogue box.

5 In the Old Value box, select the System- or user-missing radio button.

6 In the New Value box, type the mean of the variable (i.e. 2.37, as obtained by
calculating the average score on the at/ item).

7 Click on the Add command pushbutton.
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~Qld Value ~ Mew Value %
" Value: 1 : Value:i " System-missing j
™ System-missing old - N ;
> New:
(@ System- or usermissing TASaG -5 3.37
Hatve
™ All other values Continue g Cancel l Help

8 Click on Continue and then OK.

RECODE
attt  (MISSING=2.37) .
EXECUTE .

Any missing data for the variable aft/ will be replaced with the mean of 2.37.
Recoding missing values using mean substitution allows you to include all cases in
your analysis. Alternatively, you may prefer to deal with missing cases in each
analysis. Most procedures allow you to exclude missing cases either pairwise or list-
wise. Exclusion of missing cases pairwise involves the deletion of cases with missing
values only on the relevant variables. Listwise deletion involves the elimination of
cases with a missing value for any variable on the data list. More advanced procedures,
such as factor analysis, give you the opportunity to replace missing data with the mean
for particular variables during the procedure itself.

Compute

Transformation of variables is just one instance where the Compute command may be
used. The compute command is most commonly used to obtain composite scores for
items on a scale. This can be achieved for the whole data set or only a subset if certain
conditions apply. In the research example, a total attitude score would be appropriate.
This can be obtained by adding the responses to the seven items comprising the scale
for each individual case.

To compute a new variable

1 Select the Transform menu.

Click on Compute to open the Compute Variable dialogue box. If previous
settings remain, these can be cleared with the Reset command pushbutton.

3 In the Target Variable: box, type an appropriate variable name (i.e. Totalatt).

Select the first scale item from the variable list box (i.e. attl) and click on the [*]
button to move the variable into the Numeric Expression: box.

5 Click on the + button.

Select the second scale item from the variable list box (i.e. a#t2) and repeat steps
4 and 5.
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ompute Variable

Target ‘Varable: Humenc Expression:
;To: 4

Type & Label... i

= jattt-att? - el - ats - atth - anb - g7

9 éh ] _:j EaES! ﬂﬂi Functions:

B att2 o} eels=] 2] 5] 6] FBSrumenr

B e ! L~ AbYiest valu
\:;i't 5 _J ;'_" ,lj.?.}ﬁ_ Apg}]fnun’ ?
s / ; ART Ainumexgpr)
Bats A W 0 R § Y i iR
@ ant e ot K95 COF BERWOULLYa p)
o )

B roursax

@ team patticipation {

B ace i

7 Click on OK.

COMPUTE Totalatt = attt + att2 + att3 + att4 + atts + atté + att7 .
EXECUTE .

Again if you move back into your data file (remember to use the SPSS Manager) you
will notice that items have been added to obtain a new composite variable in your data
file — Totalatt.
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SPSS Processor is ready

Other transformations are possible using the calculator pad and functions options in

the Compute Variable dialogue box.

If you wish to compute a new variable based on certain conditions, then a slightly dif-
ferent procedure is required. For example, you may wish to compute a total attitude

score for only those people who exercise for four hours per week or less.
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To compute new variables based on certain conditions

Select the Transform menu.
Click on Compute to open the Compute Variable dialogue box.

In the Target Variable: box, type an appropriate variable name (i.e. Totalatr).

Select the first scale item from the variable list box (i.e. att/) and click on the
] button to move the variable into the Numeric Expression: box.

Click on the + button.

Select the second scale item from the variable list box (i.e. att2) and repeat steps
4 and 5 until all items are entered.

7  Click on the If... command pushbutton to open the Compute Variable: If
Cases sub-dialogue box.

8 Select the Include if case satisfies condition: radio button.

9 Select the variable on which the condition is based (i.e. hoursex) and click on
the ] button to move the variable into the box.

10 Select the <= operator button, which moves the symbol into the box above, then
select the digit 4.

I T " Include all cases
& st i @ Include # case satisfies condtion:

B2  fhoursex <= 2
Batt?

[

B4

B ans

®an’

#> hoursex

Piesm paticipation - - AN
Bage - HCDFHOF o
B inhours . e | |COF BERNOULLIG ) ~
@ agecst .
B Totalsit [hd] Continue

Cancel , Help 3

11 Click on Continue and then OK.

IF (hoursex <= 4) Totalatt = att1 + att2 + att3 + att4 + att5 + att6 + att7 .
EXECUTE .

In this example, a new variable has been computed — Toralatt — based on certain
conditions, i.e. for those individuals who spent four hours or less (hoursex <= 4) in
physical activity.

Data selection

In the Select Cases option in the Data menu, there are a number of procedures that
can be chosen:

* Selection of specified cases using the If option
* Selection of a random sample of cases using the Sample option

* Selection of cases based on time or case range using the Range option.
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Selection of cases using the If option is most commonly used. For example, you may
wish to examine the descriptive statistics of only males or females, or you may wish to
analyse only half your data set.

@ To select the first 50 cases in the data file for subsequent analysis

1 Select the Data menu.

2 Click on Select Cases... or click on the Select Cases tool to open the Select
Cases dialogue box.

3 In the Select box, click on the If condition is satisfied radio button.

Click on the If.. command pushbutton to open the Select Cases: If sub-
dialogue box.

5 Select the variable you require (i.e. id) and click on the [ button to move the
variable into the box.

6 Click on the operator of your choice (i.e. <=), which will then be pasted into the
box above.

7 Type in the value you require (i.e. 50).

@i i S fd =50
® a1 | » ]
@ a2 E
P a2 !
Bt I O Y B D T
o 8its e - - e
4 BSinumenpr; "~
@ atts § ANYRest value value... } [
Pat7 ; | VARSI numexpr

iia 5117 )
G J - |ARTANUmexpr]
@housec | [CoFoRMzvale) .
4 team participation 1} |CDF BERMOULLEG.p) ¥
@ sge
\/f> Inhours fy} Continue z Cancel ! Help i

8 Click on Continue and then OK.

USE ALL.

COMPUTE filter_$=(id <= 50).

VARIABLE LABEL filter $ 'id <= 50 (FILTER).

VALUE LABELS filter_$ 0 'Not Selected' 1 ‘Selected:.
FORMAT filter_$ (f1.0).

FILTER BY filter_$.

EXECUTE .

You are now ready to do analysis on the 50 cases selected. If you go back into your
data file (using the SPSS Manager) you will see that cases 51 to 99 have been crossed
through.
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Practice example

The following scale measured how adolescents feel about their future. Data from 100
year 11 students were collected. The scale comprised six items:

I feel optimistic about my future.

I believe that every cloud has a silver lining.

I doubt that I can achieve what I want to in life.
I have got what it takes to create a bright future.

If anything bad can happen, it will.

QA N R W N

I deserve to have good things come my way.

The response format for these items was:

1 = strongly agree

2 = agree
3 = neutral
4 = disagree

5 = strongly disagree.

Given the data in Prac3.sav, your tasks are to:

Check for incorrect data entry.

Recode negatively worded items.

Recode missing values using mean substitution.
Compute a total hope score.

Screen for normality for the composite variable.

(=LY I SRS I O R

Attempt an appropriate transformation on the composite variable and compare
the output of this transformation with the distribution of the original variable.

7 Select a random sample of 50 cases from the data set and obtain the mean hope
score for this subset.
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Solutions

Syntax

DESCRIPTIVES

VARIABLES=hope1 hope2 hope3 hoped hope5 hopeb
/STATISTICS=MEAN STDDEV MIN MAX .

RECODE

hope3 hope5 (1=5) (2=4) (4=2) (5=1) .

EXECUTE .

DESCRIPTIVES

VARIABLES=hope1 hope2 hope3 hope4 hope5 hopeb
/STATISTICS=MEAN STDDEV MIN MAX .

RECODE

hope2 (MISSING=4.31) .

EXECUTE .

RECODE

hoped (MISSING=1.55) .

EXECUTE .

RECODE

hope5 (MISSING=4.34) .

EXECUTE .

RECODE

hope6 (MISSING=3.63) .

EXECUTE .

COMPUTE hopetot = hope1 + hope2 + hope3 + hope4d + hope5 + hopeb .
EXECUTE .

EXAMINE

VARIABLES=hopetot

/PLOT BOXPLOT STEMLEAF HISTOGRAM NPPLOT
/COMPARE GROUP

/STATISTICS DESCRIPTIVES

/CINTERVAL 95

/MISSING PAIRWISE

/NOTOTAL.

COMPUTE refhope = 26 - hopetot .

EXECUTE .

COMPUTE sqrethop = SQRT(rethope) .

VARIABLE LABELS sqrefhop 'Square root of reflected hope' .
EXECUTE .

EXAMINE

VARIABLES=sqrefhop

/PLOT BOXPLOT STEMLEAF HISTOGRAM NPPLOT
/COMPARE GROUP

/STATISTICS DESCRIPTIVES

/CINTERVAL 95

/MISSING PAIRWISE

/NOTOTAL.

USE ALL.

COMPUTE filter_$=(id <= 50).

VARIABLE LABEL filter_$ 'id <= 50 (FILTER)'.
VALUE LABELS filter_$ 0 'Not Selected' 1 'Selected'.
FORMAT filter_$ (f1.0).

FILTER BY filter_$.

EXECUTE .

DESCRIPTIVES

VARIABLES=hopetot

/STATISTICS=MEAN STDDEV MIN MAX .
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Output

The minimum and maximum show that no out-of-range entries have been made. To
obtain the means needed for mean substitution of missing values, descriptives must be
found for recoded variables. Having recoded the negatively worded items and the
missing values, a total hope score can be computed.

Screening for normality

Descriptive Statistics

I Kinimum | Maxinnum l1ean Std. Deviation
hope 100 1 s 1.75
hopeZ2 ad 1 o £.31
hopel 100 1 z 1.25
hopes g8 1 & 1.28
hopes 94 1 £ 155
haepes a9 1 g 383
Yalid M ilistwise; s
Descriptives
Statistic Std. Error

haopetot  Liean 203338 22942

45% Confidence Lower Bound 19.8785

Interval for Klean Upper Bound 5 7300

2% Trimimed [1ean 20.3708

ldedian 208800

Yariance 2263

Std. Deviation 2.29420

Iinimum 14.00

taximum 2200

Range 11.00

Interquartilie Range .00

Skewness - 424 241

Kurtosis 152 478

Tests of Normality
Kolmagarey-Smimey” Shapirz-vilks
Statistic af Sig. Statistic of 3ig.

hopetot 182 100 000 Relty) 100 004

3. Lilliefars Significance Correcticn
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Normal Q-Q Plot of hopetot
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There is no problem with these data but we will do a transformation for practice. We
will do a reflection and then a square root.
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Descriptives

Statistic Std. Error
Square root of ldean 2.3271 05033
reflected hope 959 Confidence Lower Bound 2.2273
Interval for klean Upper Bound 5 4970
£% Trimmed Mean 2.3431
ledian 2.3229
variance 253
Std. Deviation 20328
Iinimum 1.00
Ktaximum 3.48
Range 2.46
Interguartile Range BE
Skewness -.328 241
Kurtosis 589 478

Tests of Normality

- B 3
Kalmagorav-Smimay

Shapira-\vilks

Statistic df Sig,

Statistic df

Square root of
reflected hope

144 100 000

989 100

a. Lilliefars Significance Correction

Square root of reflected hope

Histogram
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Normal Q-Q Plot of Square root of reflected hope
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The mean total hope score of a random sample of 50 cases is as follows:

Descriptives
Descriptive Statistics
M Kinimum | Kaximum llean 3td. Deviation
hopetot 20 16.00 25.00 20.3366 2.08760
walid M (listwise} 50
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Descriptive statistics

Descriptive statistics are used to explore the data collected, as shown in chapter 3; and
to summarise and describe those data.

Descriptive statistics may be particularly useful if one just wants to make general
observations about the data collected, for example number of males and females, the
age range and average (mean) age, the average length of residence in a community etc.
Other statistics such as standard deviation and variance give more information about
the distribution of each variable.

Frequency distributions

A frequency distribution is a display of the frequency of occurrence of each score
value. The frequency distribution can be represented in tabular form or, with more
visual clarity, in graphical form. For continuous variables, measured on ratio or
interval scales, histograms or frequency polygons are appropriate. For categorical vari-
ables, measured on nominal or ordinal scales, bar charts are suitable.

Measures of central tendency and variability

The three main measures of central tendency are mode, median and mean. The
measures of variability include range, interquartile range, standard deviation and vari-
ance. All of these measures of variability are more appropriate for interval or ratio
data. You can also examine the normality of the distribution through the Frequencies
procedure.

Workmg example

One hundred tennis players participated in a serving competition. Gender and number
of aces were recorded for each player. The data file can be found in Work4.sav on the
website that accompanies this title and is shown in the following figure.

SPSS D
Fle Edit view Data Transform Analvze Gr

=Z|K|&
17 gendar ’

“gender | aces | it ] gt | | ¢ e s i ] i [ Ll Vi I vt | =
1 00) 5.00: : :
200 200,
100 100
200 g0
100 300
2060 607
1.60 500
200 5007
T e
T
1001 5001

P R s A e A L S LS S

RN SN
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% To obtain a frequency table, measures of central tendency and variability

Select the Analyze menu. -

Click on Descriptive Statistics and then on Frequencies... to open the
Frequencies dialogue box.

Select the variable(s) you require (i.e. aces) and click on the ] button to move
the variable into the Variable(s): box.

Click on the Statistics... command pushbutton to open the Frequencies:
Statistics sub-dialogue box.

In the Percentile Values box, select the Quartiles check box.

In the Central Tendency box, sclect the Mean, Median and Mode check
boxes.

In the Dispersion box, select the Std. deviation, Variance, Range, Minimum

and Maximum check boxes.

ﬁ%requenaes. Statistics

&

- ?emeﬂtlle Vatues ,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,
¥ Guartiles

an Pemenme{s}:]

' Cutpointsfor:"ﬂ &qual groups

-~ Dispersion
. ™ Std. deviation ™ Minimum !
¥ Varance M Madmum
- ¥ Range [T SE mean

~Central Tendency

- ¥ Mean Cancel

[ Medien
T Sum

™ Yalues are group midpaints

 Distribtion -

i

Help
vV Mode

[T Skewness

™ Kutosis

i

10

Click on Continue.

Click on the Charts... command pushbutton to open the Frequencies: Charts

sub-dialogue box.

Click on the Histogram(s) radio button. You will notice that you can also obtain
a normal curve overlay, so click on the With normal curve check box.

Chart Type ey

" None

" Barcharts
" Pie charts
¢ Histograms:

vV With nomal curve

Continue

Cancel

Help

e P e, e
- hant Valuss

@ Frequencies O Poe
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11 Click on Continue and then OK.

FREQUENCIES
VARIABLES=aces
INTILES= 4
/STATISTICS=STDDEV VARIANCE RANGE MINIMUM MAXIMUM MEAN MEDIAN MODE
/HISTOGRAMA @ NORMAL
JORDER= ANALYSIS .

Statistics
aces
M Yalid 104
Missing {
Kean 21100
Idedian 2.0000
ldade 200
Std. Deviation 1.83620
Yariance 3.372
Range a.00
Hinimum - 1.00
Iaxdimum 10.09
Percentiles 25 4.0000
50 5.0000
75 40000
aces
Cumulative
Frequency | Percent Walid Percent Percent
valid  1.00 3 3.0 3.0 3.0
2.00 A 8.0 2.0 a0
3200 7 7.0 7.0 18.0
400 1€ 15.0 120 310
£.00 33 2ED 320 AB.0
5.00 12 15.0 12.0 81.0
7.00 8 8.0 8.0 88.0
2.00 5 5.0 5.0 8z.0
Q.00 4 490 4, a9.0
10.00 1 1.0 1.0 100.0
Total 100 100.0 100.0

In the frequency table, the frequency column summarises the total number of aces
served. For example, only one person served ten aces. The percent column displays
this frequency in percentage form for all cases, including those cases that may be
missing. The valid percent column is the proportion of scores only for those cases that
are valid. Because you have no missing data in this example, the percent and valid per-
cent columns are identical. The cumulative percent column is the summation of the
percentage for that score with the percentage for all lesser scores.

By obtaining the 25th and 75th percentiles for the distribution, the interquartile range
can be calculated by subtracting one from the other. Therefore, in this example, the
interquartile range is equal to 6 — 4 = 2.
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To obtain the appropriate cutput for a categorical variable

Select the Analyze menu.

Click on Descriptive Statistics and then on Frequencies... to open the Fre-
quencies dialogue box.

Select the variable(s) you require (i.e. gender) and click on the ] button to
move the variable into the Variable(s): box.

Click on the Statistics... command pushbutton to open the Frequencies:
Statistics sub-dialogue box.

In the Central Tendency box, click on the Mode check box.
Click on Continue.

Click on the Charts... command pushbutton to open the Frequencies: Charts
sub-dialogue box.

Select the Bar chart(s) radio button.
Click on Continue and then OK.

FREQUENCIES
VARIABLES=gender
/STATISTICS=MODE
/BARCHART FREQ
/ORDER= ANALYSIS .

gender
Cumulative
Frequency | Percent | valid Percent Percent
*/alid 1.00 20 00 0.0 200
2.00 20 £0.0 £0.0 1000
Total 100 100.0 100.0
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Descriptives command

It is also possible to obtain certain measures of central tendency and variability
through the Descriptives command. This command also allows you to save standard-
ised values as variables. These standardised or Z-scores are useful for further analysis
(for example, interaction terms in multiple regression) or in comparing samples from
different populations. Furthermore, inspection of Z-scores will allow identification of
outlying cases, which is useful in data screening. Z-scores greater than +3 and less
than -3 are considered to be outliers.

To obtain descriptive statistics and Z-scores

Select the Analyze menu.

Click on Descriptive Statistics and then Descriptives... to open the Descriptives
dialogue box.

3 Select the variable(s) you require (i.e. aces) and click on the ] button to move
the variable into the Variable(s): box.

4 Select the Save standardized values as variables check box.

5 Click on the Options command pushbutton.
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[ Descriptives:

Options
¥ Mean ™ Sum Continue |
- Dispersion '
Cancel l
V¥ Std. deviation ¥ Minimum
Hel
[T Varance ¥ Madimum P
I” Range ™ S.E.mean
- Distrbution
™ Kurtosis [7 Skewness
- Display Order
{* Variable list
™ Alphabetic
™ Ascending means
™ Descending means
6 Note that the Mean, Std. deviation, Minimum and Maximum check boxes are

automatically selected. If you wish to obtain additional descriptive statistics,
select the appropriate check boxes.

7 Click on Continue and then OK.

DESCRIPTIVES
VARIABLES=aces/SAVE
/STATISTICS=MEAN STDDEV MIN MAX.

Descriptive Statistics

I Einimum | Baximum llean Std. Deviation
aces 104 108 10.00 21100 183520
valid M ilistwise’ 100

If you switch back to the Data Editor window, you will notice that the Z-scores have
been saved as another variable: Zaces.

Practice example

e Sales in $1000s by 20 junior and senior salespeople working in a white goods shop
' were recorded at the end of a week. Given the data in Prac4.sav, your task is to obtain
a frequency table and the appropriate chart and descriptive statistics for each variable
in the data file.
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Solutions

Syntax

FREQUENCIES
VARIABLES=rank
/STATISTICS=MODE
/BARCHART FREQ
/ORDER= ANALYSIS .
FREQUENCIES
VARIABLES=sales
/NTILES= 4
MODE/STATISTICS=STDDEV VARIANCE RANGE MINIMUM MAXIMUM MEAN MEDIAN

Output

rank
Cumulative
Frequency Percent +/3lid Percent Percent

alid junier 10 0.0 2.6 526

senior <] 250 47.4 100.0

Total 19 s 0 100.0
Idissing  2.00 1 £
Total 20 100.0

The appropriate chart for a categorical variable (rank) is a bar chart and the mode is
the appropriate measure of central tendency.

rank
10 ~
8 -
=
Q G-
=
@
3
o
@
1
[T
§
2
0 T T
unior Senion
rank
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You will notice that because one case was missing, the percentage and valid per-
centage columns are not identical.

For continuous data (sales), a histogram is appropriate, and either the mean or median
is the chosen measure of central tendency. The interquartile range is 75 — 51 = 24.

Statistics
sales in 51050
M Walid
lissing
ldean
KMedian
Hade
Std. Deviation
Jariance
Range
Minimum
Maximum
Percentiles 2%
£0
78

3. Lultipie medes exist The smaliestvalug is shown.

sales in $1000

Cumulative
Frequency Percent valid Percent Percent

alid 30040 240 23 23
43.09 1 £0 23 10.2
42,00 1 Z0 £3 128
47 .00 1 4 £z 211
£1.00 1 2.0 23 253
25.00 1 zQ 23 318
80.00 1 =0 £33 36.8
34,00 1 2.0 3 42.1
48.00 1 20 23 474
58.00 1 20 23 28
70.00 1 2.0 2.3 578
72.00 1 0 23 622
74.00 1 20 23 58.2
FE00 2 100 102 739
74.00 1 z.0 23 ga2
77.00 1 z.Q 23 3.2
B80.00 P 10.0 10.% 100.0
Total 1% 920 1000

Hissing 9800 1 0

Total 20 100.0
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Histogram

Frequency

iy \
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Mean = 63 6316

/ St Dev. = 14.49218

0 N=19

3000 40.00 50,00 40.00 70.00 £0.00

sales in $1000

You may also notice that the data for the variable sales appear to be positively skewed.
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Correlation

Correlation looks at the relationship between two variables in a linear fashion.

A Pearson-product-moment correlation coefficient describes the relationship between
two continous variables and is available through the Analyze and Correlate menus.

A correlation between two dichotomous or categorical variables is called a phi
coefficient and is available through the Crosstabs option from the Analyze and
Descriptive Statistics menus.

A correlation between a continuous and a categorical variable is called a point-biserial
correlation. This option is not available in the SPSS for Windows package. However,
you can use a Pearson product-moment correlation to correlate a dichotomous and a
continuous variable but the proportion of each category of the dichotomous variable
must be approximately equal, and variables must be coded as 0 and 1.

When the assumptions underlying correlation cannot be met adequately, a nonpara-
metric alternative is Spearman’s rank-order correlation.

In this chapter you will address bivariate and partial correlations using Pearson’s
product-moment correlation.

Simple bivariate correlation, also referred to as zero-order correlation, refers to the cor-
relation between two continuous variables and is the most common measure of linear
relationship. This coefficient has a range of possible values from —1 to +1. The value
indicates the strength of the relationship, while the sign (+ or —) indicates the direction.

Partial correlation provides a single measure of linear association between two vari-
ables while adjusting for the effects of one or more additional variables.

Assumption testing

Correlational analysis has a number of underlying assumptions:

1 Related pairs — data must be collected from related pairs: that is, if you obtain
a score on an X variable, there must also be a score on the Y variable from the
same participant.

Scale of measurement — data should be interval or ratio in nature.
Normality — the scores for each variable should be normally distributed.

Linearity — the relationship between the two variables must be linear.

M o W

Homoscedasticity — the variability in scores for one variable is roughly the
same at all values of the other variable. That is, it is concerned with how the
scores cluster uniformly about the regression line.

Assumptions 1 and 2 are a matter of research design. Assumption 3 can be tested using
the procedures outlined in chapters 3 and 4. Assumptions 4 and 5 can be tested by
examining scatterplots of the variables.
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Working example

Twenty students wishing to enter university were given an intelligence test (IQ) and
their tertiary entrance examination scores (TEE) were recorded. You suspect that a
positive relationship exists between these two variables and wish to test this directional
hypothesis (one-tailed).

At the end of the academic year, the course averages for the same 20 students were
obtained. You also wish to determine whether the relationship between TEE scores and
course average is significant when IQ is controlled in the analysis.

The data file can be found in Work5.sav on the website that accompanies this title and
is shown in the following figure.

{E"Workd - SPSS Dat

Fle

9 To obtain a scatterplot

b

1 Select the Graphs menu.

2 Click on Scatter... to open the Scatterplot dialogue box.
3 Ensure that the Simple Scatterplot option is selected.

- 3 Matnx Cancel 1
.:&. Overey |k 30 Help 1

& Smple i J

4 Click on the Define command pushbutton to open the Simple Scatterplot sub-
dialogue box.

‘5 Select the first variable (i.e. ree) and click on the ] button to move the variable
into the Y Axis: box.

E SPSS: Analysis without Anguish
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6 Select the second variable (i.e. ig) and click on the [*] button to move the vari-
able into the X Axis: box.
7 Simple Scatterplot
“#)ur\iav
Label Cases by:
- Template
I~ Use chart specfications from: |
Titles... Options... }
7 Click on OK.
GRAPH
/SCATTERPLOT(BIVAR)=iq WITH tee
/MISSING=LISTWISE .
42000~
o
° o
o
390,00 o o
o
o o
o
0 4 o
360.00 o
o
[ ]
2 °© o o
330.00 o
o
o
300.00 o
o
27000+ ©
i i ¥ i i H 1
112 114 116 13 120 122 124
iq

As you can see from the scatterplot, there is a linear relationship between 1Q and TEE
scores. Given that the scores cluster uniformly around the regression line, the assump-
tion of homoscedasticity has not been violated.

KaRaNLIK

CHAPTER 5 o Correlation



Similarly, the scatterplot was obtained for TEE scores and course average, indicating
that assumptions of linearity and homoscedasticity were not violated. The output of
this plot is not displayed.

7% To obtain a bivariate Pearson product-moment correlation

1 Select the Analyze menu.

2 Click on Correlate and then Bivariate... to open the Bivariate Correlations
dialogue box.

3 Select the variables you require (i.e. ig and tee) and click on the [ button to
move the variables into the Variables: box.

Ensure that the Pearson correlation option has been selected.

5 In the Test of Significance box, select the One-tailed radio button.

- Comelation CoBgIEms «mmmmmm s
¥ Pearson | Kendabstaub [ Speamen

Test of éégnﬁcanoey*y~':* e o
¢ Twodailed & Onetaied

!

. Cptions...
¥ Rag signficant comelations o

6 Click on OK.

CORRELATIONS
/NVARIABLES=iq tee
/PRINT=ONETAIL NOSIG
/MISSING=PAIRWISE .

Correlations

i 12¢
in Pearsen Correlation 1 7E7
Big. i 1-tailed; 004a
¥ 25 25
tee Pearson Caorrelation FET 1
Sig. {1-tailed; Rl
I 25 22

* Carrelation is significant at the .01 level

To interpret the correlation coefficient, you examine the coefficient and its associated
significance value (p). The output confirms the results of the scatterplot in that a sig-
nificant positive relationship exists between IQ and TEE (r = .767, p < .05). Thus,
higher intelligence scores are associated with higher TEE scores.

m SPSS: Analysis without Anguish
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To conduct a partial correlation

Select the Analyze menu.

Click on Correlate and then on Partial... to open the Partial Correlations

dialogue box.

3 Select the variables you wish to correlate (i.e. tee and uniav) and click on the B
button to move the variables into the Variables: box.

4 Select the variable to be controlled (i.e. ig) and click on the ®] button to move
the variable into the Controlling for: box.

5 In the Test of Significance box, select the One-tailed radio button.

‘arables: m
B uniav Paste *

Feset

Ci i
Controlling for: ,.a.‘Ee_J
®ig Help ;

Test of Significance
" Twodailed & Cnetalled
- Options... l
¥ Display actual signficance level

6 Click on OK.

PARTIAL CORR
/VARIABLES=tee uniav BY iq
/SIGNIFICANCE=ONETAIL
/MISSING=LISTWISE .

Correlations

Control Variables

19 tee Correlation

df

Significance {1-tailedd:

uniay  Carrefation

o

if

Significance (1-tailed:

Py
£

[T TR N
]

[3N]

The output indicates that the relationship between TEE scores and course averages
after the first year of university is also significant, having controlled for intelligence
scores. Again, the higher the TEE score, the higher the course average for the first year

of university (r = .354, p < .05).
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Practice example

Medical researchers believe that there is a relationship between smoking and lung
damage. Data were collected from smokers who have had their lung function assessed
and their average daily cigarette consumption recorded. Lung function was assessed in
such a way that higher scores represent greater health. A negative relationship between
the variables was expected.

The researchers also believe that the relationship between these variables may be influ-
enced by the number of years for which the person has been a smoker. Given the data
in Prac5.sav, your tasks are to:

1 Check your data for violations of assumptions.

2 Conduct the appropriate analysis to determine whether cigarette consumption is
related to lung capacity.

3 Determine whether the above relationship remains significant, having controlled
for the length of the smoking habit.

Solutions

Syntax

DESCRIPTIVES
VARIABLES=lungfunc cigsday years
/STATISTICS=MEAN STDDEV KURTOSIS SKEWNESS .

GRAPH

/SCATTERPLOT(BIVAR)=cigsday WITH lungfunc
/MISSING=LISTWISE .

GRAPH

/SCATTERPLOT(BIVAR)=years WITH lungfunc
/MISSING=LISTWISE .

CORRELATIONS
/NARIABLES=lungfunc cigsday
/PRINT=ONETAIL NOSIG
/MISSING=PAIRWISE .

PARTIAL CORR
NARIABLES= lungfunc cigsday BY years
/SIGNIFICANCE=ONETAIL
/MISSING=LISTWISE .

Output

Assumption testing

Normality
It is evident from the output that all variables are relatively normally distributed.

Descriptive Statistics

8] Idean Stil Skewness Kurtosis
Statistic Statistic Statistic Statistic Std. Error Statistic Std. Error
lung function 22 44300 2.50201 228 454 - 202 802
gverags Cigarettes 3 43y 2% 30 8 11.24502 335 -8%1 202
7&ars of smoking 2z 10.81210 1002 454 -287 832
Zald M distwise: 25
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Linearity and homoscedasticity

The scatterplot of cigarettes per day and lung function suggests a somewhat curvilinear

relationship.

10.00 4

8.00

lung function
=
[=3
o
1

by

=3

a
H

2.00~

0.00—

00 [e o] [e]e]

H i
20.00 30.00

i
40.006

average cigarettes a day

1
50.00

However, because this tendency is not marked, the assumptions of linearity and homo-
scedasticity are not violated. The second scatterplot has a similar shape and indicates
no violation of these assumptions.

Correlations

ung function

ung function

Pearson Carrslation
s

ig, [ 1-tailed:

= m

4

earson Correlation

g, [i-tailsd:

o Correistionis significant atthe 201 1evel (1-tailed:.

There is a significant negative correlation between average number of cigarettes
smoked per day and lung function, indicating that lung function decreases as cigarette
consumption increases (r = -.825, p < .001). Given that a directional hypothesis was
stated, a one-tailed probability test was appropriate.

Correlauons

lurig fiir

ung function

Corretatian

¢

o

Significance i-tailzd:

3verage cigarettes 3 da.

Correlation
s

5

o
ignifizance «1-talled;
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The partial correlation coefficient, whereby years of smoking was controlled, is still
significant (r = -.378, p < .05). Thus, it is demonstrated that the relationship between
the number of cigarettes smoked per day and lung function is still significant, even
controlling for years of smoking.
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T-tests

A t-test is used to determine whether there is a significant difference between two sets
of scores. Three main types of t-test may be applied:

* One-sample
» Independent groups

» Repeated measures.

Assumption testing

Each statistical test has certain assumptions that must be met before analysis. These
assumptions need to be evaluated because the accuracy of test interpretation depends
on whether assumptions are violated. Some of these assumptions are generic to all
types of t-test, but others are more specific.

The generic assumptions underlying all types of t-test are:

1 Scale of measurement — the data should be at the interval or ratio level of
measurement.
2 Random sampling — the scores should be randomly sampled from the popu-

lation of interest.
3 Normality — the scores should be normally distributed in the population.

Clearly, assumptions 1 and 2 are a matter of research design and not statistical analysis.
Assumption 3 can be tested in a number of different ways, as outlined in chapter 3.

Working example

A major oil company developed a petrol additive that was supposed to increase engine
efficiency. Twenty-two cars were test driven both with and without the additive, and
the number of kilometres per litre was recorded. Whether the car was automatic or
manual was also recorded and coded as | = manual and 2 = automatic.

During an earlier trial 22 cars were test driven using the additive. The mean number of
kilometres per litre was 10.5.

You are interested in addressing the following questions:

1 Are the cars in the present trial running more efficiently than those in the earlier
trial? The single sample t-test will help answer this question.

2 Does engine efficiency improve when the additive is used? This is a repeated
measures t-test design.

3 Does engine efficiency with and without the additive differ between manual and
automatic cars? This is an independent groups t-test.

CHAPTER 6 » T-tests
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The data can be found in Worké6.sav on the website that accompanies this title and is
shown in the following figure.

8 Warks - SPSS Data Editor

cartyps | withaut I withadd |
] 5 )

SN

o

GvDh e o DR R

i
i
t
2
2
1
11 Z E 12
Z
1
i
1
1
2
1
Z

The one-sample t-test

% : The one-sample t-test is used when you have data from a single sample of participants
and you wish to know whether the mean of the population from which the sample is
drawn is the same as the hypothesised mean.

To conduct a one-sample t-test

Select the Analyze menu.

Click on Compare Means and then One-Sample T Test... to open the One-
Sample T Test dialogue box.

3 Select the variable you require (i.e. withadd) and click on the ] button to move
the variable into the Test Variable(s): box.

4 In the Test Value: box type the mean score (i.e. 10.5).

B catyps Test Vanable/s):
@ without # withadd past i
e

Reset

Cancel

Test Value: 125 Options...

WHHAG

5 Click on OK.

T-TEST
[TESTVAL = 10.5
/MISSING = ANALYSIS
NARIABLES = withadd
/CRITERIA = C1(.95) .

H SPSS: Analysis without Anguish
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It is possible to determine whether a difference exists between the sample mean and
the hypothesised mean by consulting the t-value, degree of freedom (df) and two-tail
significance. If the value for two-tail significance is less than .05 (p < .05), then the
difference between the means is significant.

The output indicates that there is a significant difference in engine efficiency between
the present trial and the earlier trial. That is, the cars in the present trial appear to have
greater engine efficiency than that of those in the earlier trial —t (21) = 5.74, p < .05.

One-Sample Statistics

Std. Error
N Mean Std. Deviation Mean
withadd 22 13.86 2.748 .586

One-Sample Test

Test Value = 10.5

95% Confidence Interval of
the Difference

Mean
t df Sig. (2-tailed) Difference Lower ~ Upper
withadd 5.741 21 .000 3.364 2.15 4.58

T-tests with more than one sample

In the last section, a one-sample t-test is used to determine whether a single sample of
scores was likely to have been drawn from a hypothesised population. This section
extends the understanding of sampling distributions to ask whether two sets of scores
are random samples from the same or different populations. If they are random
samples from the same population, then any differences across conditions or groups
can be attributed to random sampling variability. However, if the two sets of scores are
random samples from different populations, then you can attribute any difference
between means across conditions to the independent variable or the treatment effect.

Repeated measures t-test

The repeated measures t-test, also referred to as the dependent-samples or paired t-test,
is used when you have data from only one group of participants. In other words, an
individual obtains two scores under different levels of the independent variable. Data
that are collected from the same group of participants are also referred to as within-
subjects, because the same subject performs in both conditions. Studies which employ
a pretest—posttest design are commonly analysed using repeated measures t-tests. In
this form of design, the same participant obtains a score on the pretest and, after some
intervention or manipulation, a score on the posttest. You wish to determine whether
the difference between means for the two sets of scores is the same or different.

Before you attempt to answer this question, you must ensure that the assumptions of
repeated measures t-test are met. Remember, from the section on assumption testing,
that a number of assumptions are generic to all types of t-test. The repeated measures
t-test has one additional assumption:

1 Normality of population difference scores — the difference between the
scores for each participant should be normally distributed. Providing the sample
size is not too small (30+), violations of this assumption are of little concern.

Testing this assumption involves the same procedures used for the single-sample t-test.
Because you have two dependent variables, you need to test the normality of each vari-
able separately, which allows you to assume that the difference scores are normally
distributed. Having evaluated the assumption of normality for both pretest and posttest
measures, you are ready to conduct a repeated measures t-test.

CHAPTER 6 ¢ T-tests
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7% To conduct a repeated measures t-test

Select the Analyze menu.

2 Click on Compare Means and then Paired-Samples T Test... to open the
Paired-Sample T Test dialogue box.

3 Select the variables you require (i.e. without and withadd) and press the P
button to move the variables into the Paired Variables: box.

Paired Yariablas: ) oK
wihout -withadd ... o W-J

~Cumrert Selections
arable 1:
Varable 2;

4 Click on OK.

T-TEST
PAIRS= without WITH withadd (PAIRED)
/CRITERIA=C1(.95)
IMISSING=ANALYSIS.

Paired Samples Statistics

Std. Error
Mean N Std. Deviation Mean
Pair 1 without 8.50 22 3.335 711
withadd 13.86 22 2,748 .586
Paired Samples Correlations
N Correlation Sig.
Pair 1 without & withadd 22 .559 .007
Paired Samples Test
Paired Differences
95% Confidence Interval
sid Std. Error of the Difference Sig
Mean Deviation Mean Lower Upper t df (2-tailed)
Pair 1 without -5.364 2.904 619 -6.651 -4.076 -8.663 21 .000
— withadd

By looking at the t-value, df and two-tail significance you can determine whether the
groups come from the same or different populations. The correct way to determine sig-
nificance is to consult the critical t-tables that are available at the back of most statistical
textbooks, using the degrees of freedom. However, significance can also be determined
by looking at the probability level (p) specified under the heading ‘two-tail significance’.
If the probability value is less than the specified alpha value, then the observed t-value
is significant. The 95 per cent confidence interval indicates that 95 per cent of the time
the interval specified will contain the true difference between the population means.

SPSS: Analysis without Anguish
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As can be seen from the output, a significant difference exists between engine
efficiency with and without the additive. The additive significantly improves the
number of kilometres to the litre, t (21) = -8.66, p < .03).

Independent groups t-test

An independent groups t-test is appropriate when different participants have performed
in each of the different conditions, in other words, when the participants in one con-
dition are different from the participants in the other condition. This is commonly
referred to as a between-subjects design. Again, you wish to determine whether the
difference between means for the two sets of scores is significant. The independent
groups t-test has two additional assumptions.

1 Independence of groups — participants should appear in only one group and
these groups are unrelated.

2 Homogeneity of variance — the groups should come from populations with
equal variances. To test for homogeneity of variance, SPSS uses the Levene test
for equality of variances. If this test is significant (p < .05), then you reject the
null hypothesis and accept the alternative hypothesis that the variances are une-
qual. In this instance the unequal variance estimates are consulted. If the test is
not significant (p > .05), then you accept the null hypothesis that there are no
significant differences between the variances of the groups. In this case you
would consult the equal variance estimates. This explanation will make more
sense when you consult the output of the independent groups t-test.

Assumption 1 is a matter of research design while assumption 2 is tested in the inde-
pendent groups analysis. Before proceeding you need to check the normality of the
data. Because you have different participants in each condition, you need to check the
normality of each set of scores separately. This is achieved through the Explore dia-
logue box using the Factor List option.

To screen for normality

1 Select the Analyze menu.

2 Click on Descriptive Statistics and then Explore... to open the Explore dialogue
box.

3 Select the dependent variable(s) (i.e. without and withadd) and click on the &

button to move the variables into the Dependent List: box.

4 Select the grouping variable (i.e. cartype) and click on the [ button to move
this variable into the Factor List: box.

Dependent List: . oK
G withowt ”~
B withadd v Paste

Feset

Cancel

Help

Elilele

Label Cases by:

J

e st;j gt e -

@ Beth ( Statistics ¢ Plots Staﬁsticsv,.i Plots... j Ogtions... l

5 Click on OK.
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EXAMINE
VARIABLES=without withadd BY cartype
/COMPARE GROUP
/STATISTICS DESCRIPTIVES
/CINTERVAL 95
/MISSING LISTWISE
/NOTOTAL.
Descriptives
cartype Statistic Std. Error
without manual Mean 8.00 .863
95% Confidence Lower Bound 6.08
Interval for Mean Upper Bound 9.92
5% Trimmed Mean 7.94
Median 7.00
Variance 8.200
Std. Deviation 2.864
Minimum 4
Maximum 13
Range 9
Interquartile Range 5
Skewness .656 661
Kurtosis -.704 1.279
automatic  Mean 9.00 1.152
95% Confidence Lower Bound 6.43
[nterval for Mean Upper Bound 11.57
5% Trimmed Mean 8.89
Median 9.00
Variance 14.600
Std. Deviation 3.821
Minimum 4
Maximum 16
Range 12
Interquartile Range 6
Skewness .355 .661
Kurtosis -.253 1.279
withadd manual Mean 14.36 622
95% Confidence Lower Bound 12.98
Interval for Mean Upper Bound 15.75
5% Trimmed Mean 14.40
Median 14.00
Variance 4.255
Std. Deviation 2.063
Minimum 11
Maximum 17
Range 6
Interquartile Range 4
Skewness -.013 .661
Kurtosis -1.012 1.279
automatic  Mean 13.36 1.002
95% Contidence Lower Bound 11.13
Interval for Mean Upper Bound 15.60
5% Trimmed Mean 13.35
Median 12.00
Variance 11.055
Std. Deviation 3.325
Minimum 8
Maximum 19
Range 11
Interquartile Range 5
Skewness 169 .661
Kurtosis -.749 1.279

In reviewing the descriptive statistics and the other output such as stem-and-leaf plots
and boxplots (not shown), it is clear that there is minimal violation to the assumption
of normality.
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f"@ To conduct an independent groups t-test

1
2

Select the Analyze menu.

Click on Compare Means and then Independent-Samples T Test... to open
the Independent Samples T Test dialogue box.

Select the test variable(s) (i.e. without) and then click on the [®] button to move
the variables into the Test Variable(s): box.

Select the grouping variable (i.e. cartype) and click on the ] button to move the
variable into the Grouping Variable: box.

@ withadd Test Variable(s):
@ without

Reset

Cancel }
Help i

Grouping Vanable:

Defing Groups... T

Options... ‘

7

Click on the Define Groups... command pushbutton to open the Define Groups
sub-dialogue box.

In the Group 1: box, type the lowest value for the variable (i.e. /), then tab.
Enter the second value for the variable (i.e. 2) in the Group 2: box.

@ withadd Test Varablels):
B withaut
ﬁDéﬁne‘Gro’u‘gi @

& |Use specified values ] Continue 1

Group 1: h Cancel !

Group 2: {2 Help 2
& Cut point: ;

Options... l

Click on Continue and then OK.

T-TEST
GROUPS=cartype(1 2)
/MISSING=ANALYSIS
/NVARIABLES=without
/CRITERIA=CI(.95) .
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The syntax for the independent groups t-test is different from that of the repeated
measures t-test. In the case of the independent groups t-test you have a grouping vari-
able so you can distinguish between groups | and 2 when comparing engine efficiency.

Group Statistics

Std. Error
cartype N Mean Std. Deviation Mean
without manual 11 8.00 2.864 .863
automatic 11 9.00 3.821 1.152

Independent Samples Test

Levene’s Test for
Equality of Variances t-test for Equality of Means
95% Confidence Interval
f the Difference
Sig. Mean Std. Error otthe U ne

F Sig. i df (2-tailed) | Difference | Difference Lower Upper
without Equal
variances

assumed 172 .683 -.695 20 495 -1.000 1.440 -4.003 2.003
Equal variances

not assumed -.695 18.539 496 -1.000 1.440 -4.018 2.018

Given that Levene’s test has a probability greater than .05, you can assume that the
population variances are relatively equal. Therefore, you can use the t-value, df and
two-tail significance for the equal variance estimates to determine whether car type
differences exist. The two-tail significance for without additive indicates that p > .05
and thus is not significant. You therefore accept the null hypothesis and reject the alter-
native hypothesis. The two groups must come from the same population because no
significant differences exist, t (20) = -.695, p > .05.

Although it is possible to perform two t-tests with the one command, for the sake of
clarity two separate procedures are shown.

T-TEST
GROUPS = cartype(1 2)
/MISSING = ANALYSIS
/VARIABLES = withadd
/CRITERIA = CI(.95)

Grouup Statistics

Std. Error

cartype N Mean Std. Deviation Mean
withadd  manual 11 14.36 2.063 .622
automatic 11 13.36 3.325 1.002

Independent Samples Test

Levene’s Test for
Equality of Variances t-test for Equality of Means
95% Confidence Interval
f the Differen,
Sig. Mean Std. Error ° ' ce

F Sig. t df (2-tailed) | Difference | Difference Lower Upper
withadd Equal
variances

assumed 3.390 .080 .848 20 407 1.000 1.180 -1.461 3.461
Equal variances

not assumed .848 16.704 409 1.000 1.180 -1.492 3.492

m SPSS: Analysis without Anguish
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In relation to withadd, Levene’s test was not significant and thus we interpret the equal
variance estimates. Consulting our t-value, df and two-tail significance, again no sig-
nificant differences are apparent (p > .05). That is, there is no significant difference in
engine efficiency between manual and automatic cars either with or without the additive,
t (20) = .848, p > .05.

example

You have been asked to determine whether hypnosis enhances memory. Forty men and
women are given five minutes to attempt to memorise a list of unrelated words. They
are then asked to recall as many as they can. The next week they are asked to mem-
orise a similar list of words and then to recall as many as possible while under hyp-
nosis. You performed a study last year with another sample, so you have access to
descriptive statistics from a similar group of adults. The mean number of words
recalled in the earlier study, without hypnosis, was 34.6. Given the data in Prac6.sav,
your tasks are to:

Solutions

1 Determine whether the participants in the present study are comparable with
those in the earlier study in terms of recall in a normal state.

2 Determine whether there was any change in recall as a result of hypnosis for the
entire sample.

3 Determine whether men and women recall equal numbers of words when under
hypnosis.

Syntax

EXAMINE

VARIABLES=natrecal hyprecal BY gender
/PLOT BOXPLOT STEMLEAF
/COMPARE GROUP
/STATISTICS DESCRIPTIVES
/CINTERVAL 95
/MISSING LISTWISE
/NOTOTAL.

T-TEST
/TESTVAL = 34.6
/MISSING = ANALYSIS
/NVARIABLES = natrecal
/CRITERIA = CI(.95) .

T-TEST
PAIRS = natrecal WITH hypreca! (PAIRED)
/CRITERIA = CI(.95)
/MISSING = ANALYSIS.

T-TEST
GROUPS = gender(1 2)
/MISSING = ANALYSIS
/NARIABLES = hyprecal
/CRITERIA = CI(.95) .

CHAPTER 6 ¢ T-tests u
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Output

Assumption testing

Descriptives

gender | Statistic Std. Error
recall in natural female Mean 46.55 2.759
state 95% Confidence Lower Bound 40.77
Interval for Mean Upper Bound 52.33
5% Trimmed Mean 46.33
Median 45.50
Variance 152.261
Std. Deviation 12.339
Minimum 21
Maximum 76
Range 55
Interquartile Range 12
Skewness .357 512
Kurtosis 1.218 .992
male Mean 39.75 2.905
95% Confidence Lower Bound 33.67
Interval for Mean Upper Bound 45.83
5% Trimmed Mean 39.06
Median 36.50
Variance 168.724
Std. Deviation 12.989
Minimum 21
Maximum 71
Range 50
Interquartile Range 19
Skewness .881 512
Kurtosis 452 .992
recall under female Mean 69.95 2.790
hypnosis 95% Confidence Lower Bound 64.11
Interval for Mean Upper Bound 75.79
5% Trimmed Mean 70.00
Median 70.50
Variance 155.629
Std. Deviation 12.475
Minimum 45
Maximum 94
Range 49
Interquartile Range 15
Skewness -.218 512
Kurtosis 134 .992
male Mean 58.00 2.497
95% Confidence Lower Bound 52.77
Interval for Mean Upper Bound 63.23
5% Trimmed Mean 58.17
Median 58.50
Variance 124.737
Std. Deviation 11.169
Minimum 35
Maximum 78
Range 43
Interquartile Range 14
Skewness -.266 512
Kurtosis -.126 .992

Normality was assessed through the Explore Option. An examination of the output
reveals that the data are normally distributed for each group.
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One-sample t-tests

One-Sample Statistics

Std. Error
N Mean Std. Deviation Mean
recall in natural state 40 43.15 12.970 2.051

One-Sample Test
Test Value = 34.6

95% Confidence Interval of
the Difference

Mean
t df Sig. (2-tailed) Difference Lower Upper
recall in natural state | 4.169 39 .000 8.550 4.40 12.70

The t-value is significant (p < .05) and therefore it can be concluded that the present
sample is significantly different from the previous sample. Inspection of the means
suggests that the present sample has better word recall than that of the earlier sample,
t(39) =4.169, p < .05.

T-tests for paired samples

Paired Samples Statistics

Std. Error
Mean N Std. Deviation Mean
Pair 1 recall in natural state 43.15 40 12.970 2.051
recall under hypnosis 63.98 40 13.161 2.081
Paired Samples Correlations
N Correlation Sig.
Pair 1 recall in natural
state & recall
under hypnosis 40 .283 077
Paired Samples Test
Paired Differences
95% Confidence Interval
Std Std. Error of the Difference Sig
Mean Deviation Mean Lower Upper T df (2-tailed)
Pair 1 recall in natural
state - recall
under hypnosis | -20.825 15.647 2.474 -25.829 -15.821 -8.418 39 .000

The t-value is significant (p < .05) and therefore it can be stated that there is a signifi-
cant improvement in recall when the participants are under hypnosis, t (39) = -8.418,
p < .05.

T-tests for independent group samples

Group Statistics

Std. Error

gender N Mean Std. Deviation Mean
recall under hypnosis female 20 69.95 12.475 2.790
male 20 58.00 11.169 2.497

KaRaNLIK
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Independent Samples Test

Levene’s Test for
Equality of Variances t-test for Equality of Means
95% Confidence Interval
Di
Sig. Mean Std. Error of the Difference

F Sig. t df (2-tailed) | Difference | Difference Lower Upper
recall Equal
under variances

hypnosis  assumed .036 .851 3.192 38 .003 11.950 3.744 4.370 19.530
Equal variances

not assumed 3.192 37.544 .003 11.950 3.744 4.367 19.533

Given that the Levene’s test has a probability greater than .05 it can be assumed that
there is homogeneity of variance. From the equal estimates t-value it can be seen
that there is significance (p < .05) and therefore it can be stated that there was a
significant difference between men and women in the recall of words under hyp-
nosis, t (38) = 3.192, p < .05. Inspection of the means in the group statistics table

suggests that women (Mean = 69.95) recalled more words under hypnosis than men
(Mean = 58).
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One-way between-groups
ANOVA with post-hoc
comparisons

. In the last chapter you tested the null hypothesis that two population means were
equal. When you wish to compare the means of more than two groups or levels of an
independent variable, a one-way analysis of variance (ANOVA) is appropriate.

At the heart of ANOVA is the notion of variance. The basic procedure is to derive two
different estimates of population variance from the data, then calculate a statistic from
the ratio of these two estimates. One of these estimates (between-groups variance) is a
measure of the effect of the independent variable combined with error variance. The
other estimate (within-groups variance) is of error variance by itself. The F-ratio is the
—_ ratio of between-groups variance to within-groups variance. A significant F-ratio indi-

cates that the population means are probably not all equal. Because the null hypothesis

is rejected if any pair of means is unequal, where the significant differences lie needs
— to be worked out. This requires post-hoc analysis.

Post-hoc analysis involves hunting through the data for any significance, that is, doing
an entire set of comparisons. This type of testing carries risks of type I errors. Unlike
planned comparisons, post-hoc tests are designed to protect against type I errors, given
that all the possible comparisons are going to be made. These tests are stricter than
planned comparisons and so it is harder to obtain significance.

There are a number of post-hoc tests available. The more options a test offers, the
stricter its determination of significance. The Scheffe test, for example, allows every
possible comparison to be made but is tough on rejecting the null hypothesis. In con-
trast, Tukey’s honestly significant difference (HSD) test is more lenient, but the types
of comparison that can be made are restricted. This chapter illustrates the Tukey HSD
post-hoc test.

Assumption testing

Before conducting the ANOVA the necessary assumptions must be met. The assump-
tions for ANOVA are the same as those for the t-test.

The two assumptions of concern are:

_ 1 Population normality — populations from which the samples have been drawn
should be normal. Check this for each group using normality statistics such as
skewness and Shapiro-Wilks.

2 Homogeneity of variance — the scores in each group should have homogeneous
variances. As with the t-test, Levene’s test determines whether variances are equal
or unequal.

CHAPTER 7 ® One-way between-groups ANOVA with post-hoc comparisons
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Working example

An economist wished to compare household expenditure on electricity and gas in four
major cities in Australia. She obtained random samples of 25 two-person households
from each city and asked them to keep records of their energy expenditure over a six-
month period. Note that this is an independent groups design because different house-
holds are in different cities. If the same participants were in all conditions, then it
would be a within-subjects or repeated measures design. A repeated measures design
requires a different class of procedures, so this design is discussed in chapter 10.

The data file can be found in Work7.sav on the website that accompanies this title and
is shown in the following figure.

{Bl Work7"- SP5S Bata Editor

SN L.

L

571

To conduct a one-way ANOVA with post-hoc analysis

Select the Analyze menu.

2 Click on Compare Means and One-Way ANOVA... to open the One-Way
ANOVA dialogue box.

3 Select the dependent variable (i.e. cos?) and click on the ] button to move the
variable into the Dependent List: box.

4 Select the independent variable (i.e. city) and click on the ] button to move the
variable into the Factor: box.

@%

Dependent List: oK
@ cost of electricity and ¢

Paste

Reset

Cancel

Factor: Help

 [efElefels

Cortrasts... l Post Hoc... Options...
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5  Click on the Options... command pushbutton to open the One-Way ANOVA:
Options sub-dialogue box.

6  Click on the check boxes for Descriptive and Homogeneity-of-variance.

One-Way ANOVA: Options

-~ Statistics

V' Descriptive ' -
C |

™ Fixed and random effects .—-EE?—-‘

IV Homogeneity of variance test Help

[™ Brown-Forsythe

[ Welch

I™ Means plot

- Missing Values
¢ Exclude cases analysis by analysis

" Exclude cases listwise

Click on Continue.

Click on the Post Hoc... command pushbutton to open the One-Way ANOVA:
Post Hoc Multiple Comparisons sub-dialogue box. You will notice that a
number of multiple comparison options are available. In this example you will
use the Tukey’s HSD multiple comparison test.

9 Click on the check box for Tukey.

One-Way ANOVA: Post Hoc Multiple Comparisons

EQU al Vanances ﬁssumed et A R

~ Lsh ~ S-MK [~ Waller-Duncan
[~ Bonfamorni v Tukey

[~ Sidak [ Tukey'sb I~ Dunnatt

[~ Scheffe {™ Duncan il €

[T REGWF [ Hochbergs GT2
I~ REGWG [ Gabrel

- Equal Vanances ot Assumed
[~ Tamhanes T2 [ Dunnett’s T2 [ Games-Howell [~ Dunrett'sC

Signfficance tevel: i,C«S

[ Continue i Cancel Help

10 Click on Continue and then OK.

ONEWAY

cost BY city

/STATISTICS DESCRIPTIVES HOMOGENEITY
/MISSING ANALYSIS

/POSTHOC = TUKEY ALPHA(.05).
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Descriptives
cost of electricity and gas

95% Confidence

Interval for Mean

Std. Std. Lower Upper
N Mean Deviation Error Bound Bound Minimum | Maximum
Adelaide 25 497.28 56.628 11.326 473.91 520.65 383 621
Hobart 25 515.84 56.529 11.306 492.51 539.17 397 647
Melbourne 25 531.20 63.976 12.795 504.79 557.61 397 677
Perth 25 555.12 72.576 14.515 525.16 585.08 429 739
Total 100 524.86 65.385 6.539 511.89 537.83 383 739

In interpreting this output you must first ensure that the homogeneity assumption has
not been violated. Levene’s test for homogeneity of variances is not significant (p > .05)
and therefore you can be confident that the population variances for each group are
approximately equal.
Test of Homogeneity of Variances
cost of electricity and gas
Levene Statistic df1 df2 Sig.
817 3 96 488

To determine whether you have a significant F-ratio you use the degrees of freedom
(df) (3, 96), the F-ratio and the F-probability. Again, the correct way to determine sig-
nificance is to use the Critical F tables. Significance can also be determined by looking
at the F-probability value. Given that p < .05 you can reject the null hypothesis and
accept the alternative hypothesis that states that expenditure on electricity and gas is
different across capital cities, F(3,96) = 3.802, p < .05.

ANOVA
cost of electricity and gas
Sum of Mean
squares df Square F Sig.
Between Groups 44947.000 3 | 14982.333 3.802 .013
Within Groups 378299.040 96 3940.615
Total 423246.040 99

Having obtained a significant result you can also go further and determine, using a
Tukey HSD test, where the significance lies; that is, between which cities is there a
significant difference in energy costs? You can see by looking at the results of the
Tukey test in the table that follows that Adelaide and Perth have significantly different
mean energy costs.

Muitiple Comparisons
Dependent Variable: cost of electricity and gas

Tukey HSD

Mean 95% Confidence Interval

Difference Lower Upper

(1) city (J) city (I-J) Std. Error Sig. Bound Bound
Adelaide Hobart -18.560 17.755 723 -64.98 27.86
Melbourne -33.920 17.755 231 -80.34 12.50
Perth -57.840" 17.755 .008 -104.26 -11.42
Hobart Adelaide 18.560 17.755 723 -27.86 64.98
Melbourne -15.360 17.755 .823 -61.78 31.06
Perth -39.280 17.755 127 -85.70 7.14
Melbourne Adelaide 33.920 17.755 231 -12.50 80.34
Hobart 15.360 17.755 .823 -31.06 61.78
Perth -23.920 17.755 .535 -70.34 22.50
Perth Adelaide 57.840* 17.755 .008 11.42 104.26
Hobart 39.280 17.755 127 -7.14 85.70
Melbourne 23.920 17.755 .535 -22.50 70.34

*The mean difference is significant at the .05 level.
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Practice example

A biologist wished to examine the nutrient value of six different food supplements.
One hundred and fifty-four rats of the same species were randomly assigned to one of
six groups. Each group had a different supplement added to its food, and the rats’
weight gain over the ensuing six months was recorded in grams. Given the data in
Prac7.sav, your tasks are to:

1 Test the underlying assumptions of ANOVA.

2 Determine whether there are significant differences in weight gain across the
food supplements.

3 Locate the source of these differences using post-hoc analysis.

Solutions

Syntax

EXAMINE

VARIABLES=wtgain BY supp
/COMPARE GROUP
/STATISTICS DESCRIPTIVES
/CINTERVAL 95

/MISSING LISTWISE
/NOTOTAL.

ONEWAY

wtgain BY supp

/STATISTICS HOMOGENEITY
/MISSING ANALYSIS
/POSTHOC = TUKEY ALPHA(.05).

Output

Assumption Testing

Normality
Descriptives
food supplement Statistic Std. Error

weight gain  supplement A Mean 12.00 1.087
95% Confidence Lower Bound 9.74
Interval for Mean Upper Bound 14.26
5% Trimmed Mean 12.05
Median 11.00
Variance 26.000
Std. Deviation 5.099
Minimum 1
Maximum 22
Range 21
Interquartile Range 7
Skewness .062 491
Kurtosis -195 953

(continued)
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Descriptives (continued)

food supplement Statistic Std. Error
supplement B Mean 15.44 1.171

95% Confidence Lower Bound 13.02

Interval for Mean Upper Bound 17.86

5% Trimmed Mean 15.26

Median 16.00

Variance 34.257

Std. Deviation 5.853

Minimum 7

Maximum 27

Range 20

Interquartile Range 9

Skewness 486 464

Kurtosis -.638 .902
supplement C Mean 8.14 734

95% Confidence Lower Bound 6.61

Interval for Mean Upper Bound 9.66

5% Trimmed Mean 7.98

Median 6.50

Variance 11.838

Std. Deviation 3.441

Minimum 4

Maximum 15

Range 11

Interquartile Range 5

Skewness 969 491

Kurtosis -.375 .953
supplement D Mean 8.41 .400

95% Confidence Lower Bound 7.58

Interval for Mean Upper Bound 9.23

5% Trimmed Mean 8.59

Median 9.00

Variance 4.328

Std. Deviation 2.080

Minimum 2

Maximum 1

Range 9

Interquartile Range 3

Skewness -1.367 448

Kurtosis 2.538 .872
supplement E Mean 1.13 133

95% Confidence Lower Bound .86

Interval for Mean Upper Bound 1.41

5% Trimmed Mean 1.15

Median 1.00

Variance .533

Std. Deviation 730

Minimum 0

Maximum 2

Range 2

Interquartile Range 1

Skewness -.214 427

Kurtosis -1.019 .833
supplement F Mean 6.64 .207

95% Confidence Lower Bound 6.22

Interval for Mean Upper Bound 7.07

5% Trimmed Mean 6.62

Median 7.00

Variance 1.201

Std. Deviation 1.096

Minimum 5

Maximum 9

Range 4

Interquartile Range 1

Skewness .061 441

Kurtosis -.819 .858

m SPSS: Analysis without Anguish

KaRaNLIK



The distributions of weight gain scores for each food supplement, except for sup-
plement D, are normal. In the case of weight gain for group D, there is a slight nega-
tive skew and kurtosis. However, because only one of six groups is affected, it is
appropriate to proceed with the ANOVA.

Test of Homogeneity of Variances

weight gain
Levene Statistic df1 df2 Sig.
19.822 5 148 .000
ANOVA

weight gain

Sum of Mean

squares df Square F Sig.
Between Groups 3194.264 5 638.853 53.203 .000
Within Groups 1777.165 148 12.008
Total 4971.429 1583

Multiple Comparisons

Dependent Variable: weight gain

Tukey HSD
Mean 95% Confidence Interval
Difference Lower Upper
(1) food supplement (J) food supplement (I-J) Std. Error Sig. Bound Bound
supplement A supplement B *-3.440 1.013 .01 -6.36 -.52
supplement C *3.864 1.045 .004 .85 6.88
supplement D *3.593 .995 .006 72 6.47
supplement E *10.867 973 .000 8.06 13.68
supplement F *5.357 .987 .000 2.51 8.21
supplement B supplement A *3.440 1.013 .011 .52 6.36
supplement C *7.304 1.013 .000 4.38 10.23
supplement D *7.033 .962 .000 4.26 9.81
supplement E *14.307 .938 .000 11.60 17.02
supplement F *8.797 .954 .000 6.04 11.55
supplement C supplement A *-3.864 1.045 .004 -6.88 -.85
supplement B *-7.304 1.013 .000 -10.23 -4.38
supplement D -.271 .995 1.000 -3.14 2.60
supplement E *7.003 973 .000 4.19 9.81
supplement F 1.494 .987 657 -1.36 4.34
supplement D supplement A *-3.593 .995 .006 -6.47 -72
supplement B *-7.033 .962 .000 -9.81 -4.26
supplement C 271 .995 1.000 -2.60 3.14
supplement E *7.274 919 .000 4.62 9.93
supplement F 1.765 .935 414 -.93 4.46
supplement E supplement A *-10.867 .973 .000 -13.68 -8.06
supplement B *-14.307 .938 .000 -17.02 -11.60
supplement C *-7.003 973 .000 -9.81 -4.19
supplement D *-7.274 919 .000 -9.93 -4.62
supplement F *-5.510 911 .000 -8.14 -2.88
supplement F supplement A *-5.357 .987 .000 -8.21 -2.51
supplement B *-8.797 954 .000 -11.55 -6.04
supplement C -1.494 .987 .657 -4.34 1.36
supplement D -1.765 .935 414 -4.46 .93
supplement E *5.510 911 .000 2.88 8.14

* The mean difference is significant at the .05 level.

There is a significant difference in weight gain across the different food supplements,
F(5,148) = 53.203, p < .05. However, the homogeneity of variance assumption has
been violated (p < .05) and therefore any interpretation of the main effect must be
undertaken with caution. The results of the HSD post-hoc test identify where differ-
ences in weight gains lie.
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One-way between-groups
ANOVA with planned
comparisons

Planned (or a priori) comparisons are used when you have specific expectations or
predictions about some of the results. These comparisons are often of theoretical
importance and are planned from the onset of the study. Post-hoc comparisons, on the
other hand, such as Tukey’s honestly significantly different (HSD) test outlined in
chapter 7, are not theoretically driven. Instead, every possible comparison is performed
to detect significant effects.

Both planned and post-hoc analyses have problems with type I and type II error prop-
erties. For example, in relation to planned comparisons there are problems associated
with performing multiple statistical tests on a set of data. Such action increases the
vulnerability of the test to Type I errors. The more tests you perform, the greater the
chances of Type [ error on at least one of those tests. You should be familiar with two
types of Type I error rate. These include:

1 The per comparison error rate — the error rate in a single comparison. For
each comparison that you make, the alpha level is set at .05.

2 The familywise error rate — the cumulative effects of doing many separate
tests. It is the probability that you have made at least one type I error in the
complete set of comparisons you have undertaken. For example, if you wish to
make three comparisons, each at an alpha level of .05, then the familywise error
rate would be 0.15, which is equal to 3 x .05.

There is much debate concerning whether the familywise error rate should be controlled
when performing multiple planned comparisons. In most instances you are permitted to
perform one less comparison than the number of levels or groups of your independent
variable. For example, with three levels, you could perform two comparisons without
any difficulty. However, if further comparisons are required using the same data, then a
more strict alpha level should be adopted. The Bonferroni test assists you in determining
the appropriate alpha level to be used to evaluate the significance of the comparisons.
If you wish to conduct four comparisons using a familywise error rate of .15, then each
comparison would have to be evaluated against an alpha level of .025 (.15/4 = .025).

In chapter 7 you discovered how post-hoc tests, such as Tukey’s HSD test, can be used
to locate significant differences among groups on a dependent variable. However, if
you have theoretical reasons for hypothesising differences, you can also conduct
planned comparisons to investigate the nature of those differences. A comparison
between any two of the group means is referred to as a simple pairwise comparison. It
is also possible to conduct more complex planned or post-hoc comparisons.

In ANOVA the null hypothesis states that all population means associated with each
group or condition under investigation are the same. Furthermore, if the null hypothesis
is true, the difference (comparison value) between any simple or complex comparison
of population means must be zero. To specify the comparison between any mean (or
average of a set of means) with any other mean (or average of a different set of means)
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requires that means for the appropriate groups are weighted using a set of coefficients.
A description of how these coefficients are established is beyond the scope of this chapter,
but information regarding coefficients can be obtained from any good statistical text.

Assumption testing

In relation to assumption testing, planned and post-hoc analyses are based on the ana-
lytic procedure that precedes them. In this chapter you are addressing the use of
planned comparisons with the one-way ANOVA procedure, thus the assumptions
underlying this test apply.

Working example

A dietary consultant has asked you to test the efficacy of three weight-reduction pro-
grams. Carbohydrates were restricted in program A, protein was restricted in program
B and fats were restricted in program C. Ten overweight volunteers were randomly
assigned to each of the programs, and their weight loss after eight weeks was recorded
in kilograms. Positive scores signify a weight drop. The dietitian predicted that the diet
type would influence the weight loss, and that the loss would be greatest for those
restricting fats (program C). Before analysis, checks for normality were conducted and
considered to be acceptable.

The data file can be found in Work8.sav on the website that accompanies this title and
is shown in the following figure.

dist | wtloss | s = . » -] o . -
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1 Select the Analyze menu.

2 Click on Compare Means and One-Way ANOVA... to open the One-Way
ANOVA dialogue box.

3  Select the dependent variable (i.e. wtloss) and click on the button to move the
variable into the Dependent List: box.
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4 Select the independent variable (i.e. dief) and click on the ] button to move the
variable into the Factor: box.

5 Click on the Options... command pushbutton to open the One-Way ANOVA:
Options sub-dialogue box.

6  Select the check boxes for Descriptive and Homogeneity of variance.

- Statistics

¥ Descriptive ) -

&l
™ Fixed and random effects ,Eainfi..‘
V' Homogeneity of variance test Help !
7 Brown-Forsythe

r Welch

I™ Means plot
~ Missing Values

¢ Exclude cases analysis by analysis

O Exclude cases listwise

7 Click on Continue.

Click on the Contrasts... command pushbutton to open the One-Way ANOVA:
Contrasts sub-dialogue box.

9 In the Coefficients: box, type the value of the coefficient for the first group
(i.e. -1) and click on Add to move the coefficient into the box below.

10  In the Coefficients: box, type the value of the coefficient for the second group
(i.e. -1) and click on Add.

11 In the Coefficients: box, type the value of the coefficient for the third group
(i.e. 2) and click on Add. If all the coefficients have been entered correctly, the
Coefficient Total: should equal zero.

I~ Polynomial
~Contrast 1of 1

Continue

Cancel

Help

il

Coefficient Total: $.000

12 Click on Continue and then OK.

ONEWAY
wtloss BY diet
/CONTRAST=-1-12
/STATISTICS DESCRIPTIVES HOMOGENEITY
/MISSING ANALYSIS .
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Descriptives

weight loss

95% Confidence

interval for Mean

Std. Std. Lower Upper
N Mean | Deviation | Error | Bound Bound | Minimum | Maximum
restricted carbohydrate } 10 4.90 1.595 504 3.76 6.04 3 7
restricted protein 10 5.50 1.581 .500 4.37 6.63 3 8
restricted fat 10 8.40 1.776 .562 7.13 9.67 5 11
Total 30 6.27 2.227 407 5.43 7.10 3 11

An examination of the Levene test for homogeneity of variances (below) suggests that
this assumption has not been violated (p > .05) and therefore interpretation of the
ANOVA can proceed.

Test of Homogeneity of Variances

weight loss
Levene Statistic df1 df2 Sig.
.038 2 27 .963
ANOVA
weight loss
Sum of Mean
sqguares df Square F Sig.
Between Groups 70.067 2 35.033 12.817 .000
Within Groups 73.800 27 2.733
Total 143.867 29

The F-ratio with an F-probability value less than .05 is significant, suggesting that type
of diet does significantly influence weight loss, F(2,27) = 12.817, p < .05.

Means and standard deviations for each group are illustrated. The contrast coefficient
matrix gives the coefficients that have been assigned for each group or level of the
independent variable. For example, program A, program B and program C have
coefficients of 1, 1 and 2 respectively.

Contrast Coefficients

diet program
restricted restricted
Contrast carbohydrate protein restricted fat
1 -1 -1 2
Contrast Tests
Value of Sig.
Contrast | contrast Std. Error t df (2-tailed)
weight loss Assume equal variances 1 6.40 1.281 4.998 27 .000
Does not assume equal variances 1 6.40 1.329 4.815 16.327 .000

You have not violated the assumption of homogeneity of variance so you can consult
the ‘Assume equal variances’ row for Contrast 1. To interpret this contrast you need to
examine both the T-value and the T-probability value. A T-value of 4.988 is highly sig-
nificant (T-probability < .05). Because you have made only one comparison, it is not
necessary to adjust this significance level to evaluate the comparison.
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An examination of the means for each of these groups, located in the descriptive stat-
istics section of the output, indicates that a significantly greater reduction in weight
was made by those in program C than in either of the other programs. Therefore, you
can conclude that individuals restricting their fat intake lose significantly more weight
than do those restricting either their protein or carbohydrate intake, F(1,27) = 24.98,
p < .05.

As outlined above, to report the planned comparison, the T-value is squared to obtain
an F-value. Also note that the dfl for planned comparisons is always 1. The df2 value

is that which corresponds to the within-groups estimate in the ANOVA summary
table.

Practice example

You will remember the practice example in chapter 7 that examined the effect of food
supplements on weight gain in rats. One hundred and fifty-four rats were randomly
assigned to receive one of six food supplements, and their weight gain over six months
was recorded. Given the data in Prac8.sav, your tasks are to:

1 Test the underlying assumptions of ANOVA.

2 Determine whether there are significant differences in weight gain across the six
food supplements.

3 Test the hypothesis that supplement B is associated with a significantly higher
weight gain than that associated with the other five supplements.

Solutions

Syntax

ONEWAY
wigain BY supp
/CONTRAST=-15-1-1-1-1
/STATISTICS DESCRIPTIVES HOMOGENEITY
/MISSING ANALYSIS .

Output

#0000 RE00CE00EE008088E8303000000800000000000000000000ETIN0EEINN0000LPNR000RPTRIRTIROREERLIERERESS

Assumption testing

You will remember that you tested these assumptions as part of the Practice example
in chapter 7, so refer to the previous output.

Descriptives

weight gain
95% Confidence
Interval for Mean
Std. Std. Lower Upper
N Mean Deviation Error Bound Bound | Minimum | Maximum
supplement A 22 12.00 5.099 | 1.087 9.74 14.26 1 22
supplement B 25 15.44 5.853 11471 13.02 17.86 7 27
supplement C 22 8.14 3.441 734 6.61 9.66 4 15
supplement D 27 8.41 2.080 400 7.58 9.23 2 11
supplement E 30 1.13 .730 133 .86 1.41 0 2
supplement F 28 6.64 1.096 .207 6.22 7.07 5 9
Total 154 8.29 5.700 459 7.38 9.19 0 27
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The ANOVA shows that there is a significant difference in weight gain across the
different food supplements (p < .05) — F(5,148) = 53.203, p < .05.

Test of Homogeneity of Variances

weight gain
| Levene Statistic df1 df2 Sig.
[ 19.822 5 148 .000
ANOVA
weight gain
Sum of Mean
squares df Square F Sig.
Between Groups 3194.264 5 638.853 53.203 .000
Within Groups 1777.165 148 12.008
Total 4971.429 153

Because the homogeneity of variance assumption has been violated (p < .05), in inter-
preting the constrast tests, we need to consult the T-probability value in the ‘Does not
assume equal’ row.

Contrast Coefficients

food supplement
Contrast supplement A | supplement B | supplement C | supplement D | supplement E | supplement F
1 -1 5 -1 -1 -1 -1
Contrast Tests
Value of Sig.

Contrast | contrast Std. Error t df (2-tailed)

weight gain  Assume equal variances 1 40.88 3.791 10.783 148 .000
Does not assume equal variances 1 40.88 6.016 6.795 26.752 .000

This is significant (p < .035) so we have shown that there is a significantly greater weight
gain for supplement B than for any of the other five food supplements, F(1,148) = 46.17,
p < .05. Remember, in reporting your result, square the appropriate t-value to obtain an
F-value; also remember that df1 for planned comparisons is always 1 and that df2 value
corresponds to the within-groups estimate in the ANOVA summary table.
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Two-way between-groups
ANOVA

The two-way ANOVA operates in the same manner as the one-way ANOVA except that
you are examining an additional independent variable. Each independent variable may pos-
sess two or more levels. In a two-factor between-groups design, each participant has been
randomly assigned to only one of the different levels of each independent variable. Each
of the different cells represents the unique combinations of the levels of the two factors.

Assumphon testing

Before you can conduct the two-way ANOVA, you must ensure that the necessary
assumptions are met. The assumptions for two-way ANOVA are the same as those for
the one-way ANOVA:

1 Population normality — the populations from which the samples have been
drawn should be normal. Check this for each group using normality statistics
such as skewness and Shapiro-Wilks.

2 Homogeneity of variance — the scores in each group should have homo-
geneous variances.

You are primarily concerned with violations to the second assumption because such
violations could mean that your data have been evaluated at a significance level greater
than you initially assumed. Rather than being significant at the alpha level of .05, your
results may really be significant at only an alpha level of .10. This is because violations
of the homogeneity assumption distort the shape of the F-distribution such that the
critical F-value no longer corresponds to a cut-off of 5 per cent.

Workmg example

A toy distributor wished to determine which stores were the most successful in selling
their stock. He wished to compare the sales in different types of store in different
locations: in discount toy stores, department stores and variety stores, and stores in
either the central city district or in suburban shopping centres. Therefore, the first
independent variable was store type, with three levels; the second independent variable
was location, with two levels; and the dependent variable was the amount of toy sales
in $1000s per week. Therefore, you have a 3 x 2 factorial design with six data cells
(3 x 2 = 6). Four stores were randomly chosen for each of the six cells (n = 4); sales
from a total of 24 stores were recorded (N = 24).

The toy distributor wishes to ask three questions:

1 Does the type of store influence the sales of toys?
2 Does the location of the store influence the sales of toys?
3 Does the influence of the store type on toy sales depend on the location of the store?
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Questions 1 and 2 refer to main effects, while question 3 examines the interaction of
the two independent variables on the dependent variable.

The data file can be found in Work9.sav on the website that accompanies this title and
is shown in the following figure.

B Worko - $PSS Data Editor
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To conduct o two-way ANCVA

Select the Analyze menu.

2 Click on General Linear Model and then Univariate... to open the Univariate
dialogue box.

3 Select the dependent variable (i.e. sales) and click on the ™ button to move the
variable into the Dependent Variable: box.

4 Select the independent variables (i.e. location and rype) and click on the P
button to move the variables into the Fixed Factor(s): box.

Dependent Vardable: Maodel...

Wtoy sales in $1008 per-

Fixed Factoris):

Random Factoris):
Save... f

Covariateis);

1 WLS Weight:

GK l Paste l Resetl Cance[! Help *

5 Click on the Options... command pushbutton to open the Univariate: Options
sub-dialogue box.

6 In the Display box, click on the Descriptive statistics, Estimates of effect size,
Observed power and Homogeneity tests check boxes.
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-~ Egtimated Marginal Means
Factoris) and Factor Interactions: Display Means for:
OVERALL
lacation
type
focationtyps
- Display
[V Descrptive datistics ¥ Homogeneity tests
¥ Estimates of effect size [~ Spread vs. lavel plot
V¥ Observed power [~ Residual plot ;
[~ Parameter estimates [~ Lack of fit
[~ Cantrast coefficient matrix [T General estimable function
Signfficance fevel: |.05 Corfidence intervals are $5%
Continue Cancel ! Help

7 Click on Continue and then OK.

UNIANOVA
sales BY location type
/METHOD = SSTYPE(3)
/INTERCEPT = INCLUDE
/PRINT = DESCRIPTIVE ETASQ OPOWER HOMOGENEITY
/CRITERIA = ALPHA(.05)
/DESIGN = location type location*type .

Descriptive Statistics

Dependent Variable: toy sales in $1000 per week

location of store type of toy store Mean Std. Deviation N
city central variety store 3.00 3.162 4
department store 10.00 4.761 4
di tt 14.00 3.916 4
iscount toy store 9.00 5.970 12
Total 11.00 3.916 4
suburban shopping centre variety store 12.00 5.477 4
department store 10.00 4.082 4
di  tov st 11.00 4.200 12
iscount toy store 7.00 5398 8
Total 11.00 4.870 8
Total variety store 12.00 4.276 8
department store 10.00 5.150 24
discount toy store
Total
Levene’s Test of Equality of Error Variances®
Dependent Variable: toy sales in $1000 per week
F df1 df2 Sig.
1.000 5 18 .446

Tests the null hypothesis that the error variance of the dependent variable is equal across groups.
a Design: Intercept+location+type+location * type

The Levene’s test tells us that the homogeneity of variance assumption has not been
violated. The output illustrates that the main effects for location and store type are not
significant (p > .05). Therefore, neither store type nor location significantly influences
the sales of toys.
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Tests of Between-Subjects Effects

Dependent Variable: toy sales in $1000 per week

Type lHl Sum df Mean F Sig. Partial Eta Noncent. Observed

Source of Squares Square Squared Parameter Power®
Corrected Model 5280.000 5 56.000 3.055 .036 .459 15.273 742
Intercept 2400.000 1 2400.000 130.909 .000 879 130.909 1.000
Locati 24.000 1 24.000 1.309 .268 .068 1.309 192

ocation 112.000 2 56.000 3.055 072 253 6.109 517
Type 144.000 2 72.000 3.927 .038 304 7.855 .630
location * type 330.000 18 18.333
Error 3010.000 24
Total 610.000 23
Corrected Total

a Computed using alpha = .05
b R squared = .459 (adjusted R squared = .309)

Because neither main effect is significant, post-hoc analyses are not required. If signifi-
cant main effects had been obtained, a comparison of marginal means for each effect
would have been necessary. You may have noticed that means can be displayed for par-
ticular factors in the Univariate Options dialogue box.

The output also shows that there is a significant interaction effect (p < .05) for location
* type. That is, the influence of store type on sales does depend on the location of the
store, F(2,18) = 3.927, p < .05).

With a significant interaction effect you are interested in conducting a simple effects
analysis, and simple comparisons if the simple effects are significant. In addition,
interpretation is facilitated by plotting the cell means.

Effect sizes and observed power are also provided. Profile plots could be obtained as
part of the analysis but the following procedure gives a clearer picture of the interaction.

To plot the cell means

Select the Graphs menu.
Click on Line... to open the Line Charts dialogue box.

umn—ar{gy

Click on the Multiple box and ensure that the Summaries for groups of cases
radio button has been selected.

'\ Simple

Cancel 1
E Multiple Help }
;k; Drop-ine

- Data in Chan Are ,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

. & Summanes for groups of cases
4 (" Summaries of separate variables
" ™ Values of individual cases

4 Click on the Define command pushbutton to open the Define Multiple Line:
Summaries for Groups of Cases sub-dialogue box.

5 In the Lines Represent box, select the Other summary function radio button.
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6 Select the dependent variable (i.e. sales) and click on the ] button to move the
variable into the Variable: box.

7 Select the independent variable with the most levels (i.e. fype) and click on the
(] button to move the variable into the Category Axis: box.

8 Select the other independent variable (i.e. location) and click on the [« button to
move the variable into the Define Lines by: box. You will notice a Titles...
command pushbutton in the bottom right-hand side of the window, which
allows you to give titles to the lines of the graph. You can add a title for your
graph if you want to.

- Lines Represent

0K
" 'Nofcases " % of cases «——————-—j
" Cum. n of cases € Cum. % of cases Paste ]

¥ Other summary function Reset ]
: Variable:
[® MEAt 30y sales in $100 Gancs |

Category Axis:
—
J®type of toy store hype
., Define Lines by:
;y} location of store floca

- Template
Titles... |
{1" Usa chart specfications from:

1 Fife QOptions...

9 Click on Continue and then OK.

GRAPH
/LINE(MULTIPLE)MEAN(sales) BY type BY location
/TITLE= 'Comparison of Sales'.

Comparison of Sales

focation of store

city certral

suburban

- ghopping
centre

= N
=3 = o 0
i i 1 H

Mean toy sales in $1000 per week

F
H

2~

I 1] 1
vaniety store departmert store discount toy store

type of toy store
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The graph shows that for suburban shopping centres, the type of store has no influence
on the sale of toys. However, in the city centre, the type of store has considerable
impact: discount toy stores have the highest sales.

When you have obtained a significant interaction, it is necessary to conduct an analysis
of simple effects. That is, you need to look at the effect of one factor at only one level
of the other factor. For example, you may be interested in looking at the effect of
location on the variety stores, department stores or discount toy stores. Likewise, you
could analyse the effect of the type of store just in the city centre or just for suburban
shopping centres. In each case you would be analysing simple effects. If you were
interested in looking at suburban shopping centres, you would first have to select only
those cases in which stores were located in the suburbs. You can achieve this by using
the Select Cases option in the Data menu or clicking the Select Cases tool.

USE ALL.

COMPUTE filter_$=(location = 2).

VARIABLE LABEL filter_$ 'location = 2 (FILTER)".
VALUE LABELS filter_$ 0 ‘Not Selected' 1 'Selected'.
FORMAT filter_$ (f1.0).

FILTER BY filter_$.

EXECUTE .

You would then conduct a one-way ANOVA for store type for only these selected cases.

ONEWAY
sales BY type
/STATISTICS DESCRIPTIVES HOMOGENEITY
/MISSING ANALYSIS .

Descriptives

toy sales in $1000 per week

N Mean Std. Std. 95% Confidence Minimum Maximum
Deviation Error Interval for Mean

Lower Upper

Bound Bound
variety store 4 11.00 3.916 1.958 4.77 17.23 6 15
department store 4 12.00 5477 | 2739 3.28 20.72 6 18
di tt + 4 10.00 4.082 2.041 3.50 16.50 6 14
T'Stc“’“” Oy store 12 11.00 4200 1212 8.33 13.67 6 18

ota

Test of Homogeneity of Variances

toy sales in $1000 per week

Levene Statistic df1 df2 Sig.
1.050 2 9 .389
ANOVA
toy sales in $1000 per week
Sum of df Mean Square F Sig.
squares
Between Groups 8.000 2 4.000 194 .827
Within Groups 186.000 9 20.667
194.000 1
Total

Having conducted this analysis, you could take this simple effect and perform simple
comparisons. However, simple comparisons are usually performed only if the relevant
simple effect proves to be significant. In this case, the effect is not significant.
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If simple comparisons were required, then appropriate coefficients would have to be
determined. That is, you would need to establish which means you were interested in
comparing. For example, if you have obtained a significant simple effect for store type
in suburban shopping centres, then you may be interested in determining whether dis-
count stores had higher sales than department or variety stores. Remember, you are
still only dealing with suburban shopping centres.

ONEWAY
sales BY type
/CONTRAST=-1-12
/STATISTICS DESCRIPTIVES HOMOGENEITY
/MISSING ANALYSIS .

Consistent with conducting trend analysis, it is also important to remember that the
significance of the contrast F-ratio must be evaluated using the residual mean square
from the omnibus test. That is, the residual mean square from the original two-way
ANOVA summary table is used. For this example, the mean square residual for the
two-way ANOVA is equal to 718.333. Again, the first degree of freedom (df) for all
contrasts is 1, while the second df is the value for the residual estimate from the two-
way ANOVA summary table (i.e. 18).

SPSS can also be used to analyse data from more complex factorial designs with three
or more independent variables. With these designs, the interpretation of interaction
effects becomes extremely complex.

Practice example

A researcher is interested in determining the effect of density of traffic (light, medium
or peak) and type of intersection (lights or roundabouts) on the number of accidents.
Given the data in Prac9.sav, your tasks are to:

1 Check for violations of assumptions.

2 Determine whether traffic density influences the number of accidents.

3 Determine whether type of intersection influences the number of accidents.

4 Determine whether the influence of traffic density on the number of accidents

depends on the type of intersection.

Solutions
i) Syntax

EXAMINE
VARIABLES=accident BY density intersec
/PLOT NONE
/STATISTICS DESCRIPTIVES
/CINTERVAL 95
/MISSING LISTWISE
/NOTOTAL.
UNIANOVA
accident BY density intersec
/METHOD = SSTYPE(3)
/INTERCEPT = INCLUDE
/PRINT = ETASQ OPOWER HOMOGENEITY
/CRITERIA = ALPHA(.05)
/DESIGN = density intersec density*intersec .
ONEWAY
accident BY density
/STATISTICS DESCRIPTIVES HOMOGENEITY
/MISSING ANALYSIS
/POSTHOC = TUKEY ALPHA(.05).
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Output

Assumption testing

Normality
Descriptives
I density of traffic Statistic Std. Error
number of accidents light: 7pm to 7am Mean 7.0000 1.90863

95% Confidence Lower Bound 2'4822
Interval for Mean Upper Bound 123'3144
5% Trimmed Mean 6.5000
Median 29.143
Variance 5'39838
St.d.' Deviation 15.00
Minimum 15.00
Maximum 10.50
Range .203 752
Interquartile Range 1168 1481
Skewness
Kurtosis

medium: 10am to 4pm | Mean 13.6250 1.72106
95% Confidence Lower Bound 13'2323
|n°terv§al for Mean Upper Bound 13,5278
5% Trimmed Mean 13.5000
Median 23.696
Variance 4'868788
Std. Deviation 21.00
Minimum 13.00
Maximum 9.25
Range 195 752
Interquartile Range 1456 1481
Skewness
Kurtosis

peak hour: 7am to Mean 14.7500 1.52069

10am and 4pm to 7pm | 95% Confidence Lower Bound 11'12’41
Interval for Mean Upper Bound 12‘3222
5% Trimmed Mean 16.0000
Median 18.500
Variance 4'3091 g)g
St.d'. Deviation 21.00 |
Minimum 12.00
Maximum 7.50
Range - 117 752
Interquartile Range 1405 1.481
Skewness
Kurtosis

CHAPTER 9 ¢ Two-way between-groups ANOVA

KaRaNLIK



Descriptives

type of intersection Statistic Std. Error

number of accidents lights Mean 10.5833 1.96738
95% Confidence Lower Bound 12-2?32
Interval for Mean Upper Bound 10.5926
5% Trimmed Mean 10.5000
Median 46.447
Variance 6'81538
St'd.' Deviation 21.00
Minimum 21.00
Maximum 11.75
Range -151 637
Interquartite Range 1,088 1.232
Skewness
Kurtosis

roundabouts Mean 13.0000 1.33144

95% Confidence Lower Bound 1?'8282
Inotervgl for Mean Upper Bound 12.9444
5% Trimmed Mean 12.5000
Median 21.273
Variance 4'6162(2)3
St.d.. Deviation 21.00
Minimum 15.00
Maximum 7.75
Range 207 637
Interquartile Range 1006 122
Skewness
Kurtosis

The distributions of accident scores for each type of intersection and each level of
traffic density are normal, as evidenced by the reasonably low skewness statistics,

Levene’s Test of Equality of Error Variances?

Dependent Variable: number of accidents

F df1

df2

Sig.

947

5 18

475

Tests the null hypothesis that the error variance of the dependent variable is equal across groups.

a Design: Intercept+density+intersec+density * intersec

Levene’s test is not significant and therefore homogeneity of variance can be assumed.

Tests of Between-Subjects Effects

Dependent Variable: number of accidents

Type Il Sum df Mean F Sig. Partial Eta Noncent. Observed

Source of Squares Square Squared Parameter Power?
Corrected Model ©436.708 5 87.342 4.580 .007 .560 22.901 .909
Intercept 3337.042 1 3337.042 174.994 .000 907 174.994 1.000
D it 280.583 2 140.292 7.357 .005 450 14.714 .893

ensity 35.042 1 35.042 1.838 192 093 1.838 250
Intersect 121.083 2 60.542 3.175 .066 .261 6.350 .534
density * intersec 343.250 18 19.069
Error 4117.000 24
Total 779.958 23
Corrected Total

a Computed using alpha = .05
b R squared = .560 (adjusted R squared = .438)
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The output shows that the main effect for traffic density is significant, F(2,18) = 7.357,
p < .05, but the type of intersection is not significant (p > .05). In addition, the inter-
action effect is not significant (p > .05). So the effect of density does not depend on the
type of intersection.

To locate the source of difference caused by traffic density, a one-way ANOVA with
post-hoc tests can be done.

Descriptives

number of accidents

N Mean Std. Std. 95% Confidence Minimum Maximum
Deviation Error Interval for Mean

Lower Upper

Bound Bound
light: 7pm to 7am 8 7.0000 5.39841 : 1.90863 2.4868 11.5132 .00 15.00
mediumn: 10am to 4pm 8| 13.6250 4.86790 | 1.72106 9.5553 17.6947 8.00 21.00
peak hour: 7am to 10am and 4pm to 7pm 8| 14.7500 4.30116 | 1.52069 11.1541 18.3459 9.00 21.00
Total 24 | 11.7917 5.82334 | 1.18868 9.3327 14.2506 .00 21.00

Test of Homogeneity of Variances

number of accidents
Levene Statistic df1 df2 Sig.
192 2 21 .827

Mulitiple Comparisons

Dependent Variable: number of accidents

Tukey HSD
(J) density of traffic Mean Std. Error Sig. 95% Confidence Interval
Difference (I-

(1) density of traffic J) Lower Bound Upper Bound
light: 7pm to 7am medium: 10am to 4pm *-6.62500 2.43822 .033 -12.7707 -.4793

peak hour: 7am to

10 d4 to 7 *-7.75000 2.43822 .012 -13.8957 -1.6043

, '0am and 4pm 1o /pm *6.62500 2.43822 033 4793 12.7707

medium: 10am to 4pm light: 7pm to 7am

peak hour: 7am to -1.12500 2.43822 890 -7.2707 5.0207

10am and 4pm to 7pm *7.75000 2.43822 012 1.6043 13.8957
peak hour: 7am to light: 7pm to 7am 1.12500 2.43822 .890 -5.0207 7.2707
10am and 4pm to 7pm medium: 10am to 4pm

* The mean difference is significant at the .05 leve!.

These results suggest that there are significant differences between light traffic and
medium and peak density, but not between medium and peak density. An examination
of the means suggests that there are least accidents in light traffic, with no differences
between medium and peak traffic.
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One-way repeated measures
ANOVA

In chapter 7 you examined the analysis of an independent groups experimental design
in which a different group of participants served in each of the conditions. That is, you
used an independent groups ANOVA to detect differences in group means.

You are now interested in refining the experimental design to increase its sensitivity to
detecting differences in the dependent variable. A major source of experimental error
is individual differences, which can be controlled by using a repeated measures or
within-subjects design. By having the same participants perform under every con-
dition, you eliminate systematic bias attributable to participants in one group being
different from the participants in other groups.

Assumption testing

Three of the four assumptions underlying the repeated measures ANOVA are similar to
those of the independent groups design:

1 Random selection — the sample should be independently and randomly
selected from the population of interest.

Normality — each population of scores should have a normal distribution.

Homogeneity of variance — the different populations of scores should have
homogeneous variances. This is assessed by obtaining variances for each group
and dividing the largest variance by the smallest variance to obtain an F-max
value. If this ratio is greater than three, then the assumption has been violated
and the resulting F-ratio must be evaluated at a more conservative alpha level.

4 Sphericity — the variance of the population difference scores for any two con-
ditions should be the same as the variance of the population difference scores
for any other two conditions.

Assumption | is a matter of research design while assumption 2 can be tested by using
statistics outlined in chapter 3. Assumptions 3 and 4 are assessed as part of the
analysis.

Working example

You wish to determine whether practice increases the ability to solve anagrams. Eight
participants were asked to solve as many anagrams as possible in ten minutes. They
were then allowed to practise for an hour before being asked to complete another ten-
minute timed task. Participants were then given another practice session and another
timed task. The number of anagrams correctly solved was recorded.

The data file can be found in Work10.sav on the website that accompanies this title and
is shown in the following figure.
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To conduct a repeated measures ANOVA

Select the Analyze menu.

Click on General Linear Model and then Repeated Measures... to open the
Repeated Measures Define Factor(s) dialogue box.

In the Within-Subject Factor Name: box, type the name for the within-subjects
factor (i.e. time).

In the Number of Levels: box, type the number of levels of that particular
factor (i.e. 3).

Click on Add to move this information into the box below.

MNumber of Levels:

Within-Subject Factor Name: l Define ,
]__

i Zirld l”time{.?} Cancel ’

Click on the Define command pushbutton to open the Repeated Measures sub-
dialogue box.
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7 Select the three within-subjects variables (i.e. timel, time2 and time3) and click

on the P button to move the variables into the Within-Subjects Variables
(time): box.

Within-Subjects Yanables  fime}: oK

Paste

Reset

Help

elifele]

Between-Subjects Factor{s):

Covariates:

Model... 1 Contrasts...i Plats... l Post Hov:.,(l Save... ! Options...l

8  Click on the Options... command pushbutton to open the Repeated Measures:
Options sub-dialogue box.

9 In the Display box, click on the Descriptive Statistics, Estimates of effect size
and Observed power check boxes.

~ Estimated Marginal Means
Factor(s} and Factor interactions: Display Means for:

OVERALL
fime

- Display

¥ Descriptive statistics ™ Transfomation matrix

{v Estimates of effect size | = 5 e

[¥ Observed power = 3

{~ Parameter estimates I™ Residual plots

I~ SSCP matrices I Lack of fit test

™ Residual SSCP matrix I~ General estimable function
Significance level: ICS Confidence intervals are 5%

[Continuel Cancel { Help

10 Click on Continue and then OK.
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GLM

time1 time2 time3

/WSFACTOR = time 3 Polynomial
/METHOD = SSTYPE(3)

/PRINT = DESCRIPTIVE ETASQ OPOWER
/CRITERIA = A’.PHA(.05)

/WSDESIGN = time .

Before interpretation of the output, the assumption of homogeneity of variance was
assessed by calculating F-max. No violation of this assumption was found.

For a one-way within-subjects ANOVA, SPSS produces a lot of output: statistics for
evaluating the sphericity assumption; traditional univariate ANOVA results; and
ANOVA results using multivariate tests. The summary tables for between-subjects
effects and within-subjects contrasts are not discussed here.

Descriptive Statistics

Mean Std. Deviation N
correct anagrams at time 1 68.2500 6.36396 8
correct anagrams at time 2 77.0000 7.92825 8
correct anagrams at time 3 86.1250 14.01466 8
Multivariate Tests?
Partial
Hypothesis Eta Noncent. Observed
Effect Value F df Error df Sig. | Squared | Parameter Power®
time Pillai's Trace 876 | 21.234 2.000 6.000 | .002 .876 42.469 .994
Wilks’ Lambda 124 | °21.234 2.000 6.000 | .002 .876 42.469 .994
Hotelling’s Trace 7.078 | °21.234 2.000 6.000 .002 .876 42.469 .994
Roy’s Largest Root 7.078 | °21.234 2.000 6.000 | .002 .876 42.469 .994
a Design: Intercept Within Subjects Design: time
b Computed using alpha = .05
¢ Exact statistic
Mauchly’s Test of Sphericity?
Measure: MEASURE_ 1
Epsilon®
Mauchly’s Approx. Greenhouse Huynh- Lower-
Within Subjects Effect W Chi-Square df Sig. -Geisser Feldt bound
Time .254 8.234 2 .016 573 612 .500

Tests the null hypothesis that the error covariance matrix of the orthonormalised transformed dependent variables is

proportional to an identity matrix.

a Design: Intercept Within Subjects Design: time

b May be used to adjust the degrees of freedom for the averaged tests of significance. Corrected tests are displayed in the
Tests of Within-Subjects Effects table.

Before you can interpret the F-ratio of the within-subjects effect (time), you must first
ensure that the assumption of sphericity has not been violated. The value for Mauchly
is equal to .254 and is significant (p < .05). You must therefore evaluate the obtained
F-ratio using new degrees of freedom (df) which are calculated using the Huynh-Feldt
Epsilon (.612). The new dfs are 1.22 and 8.56 (2 x .61, 14 x .61), compared with 2
and 14. An examination of the critical F-tables (available in any good statistical text)
indicates that the F-ratio is still significant when using the new dfs.
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Tests of Within-Subjects Effects
Measure: MEASURE_1

Type lil Partial
Sum of Mean Eta Noncent. Observed
Source Squares df Square F Sig. | Squared | Parameter Power?
Time Sphericity Assumed 1278.250 2 639.125 | 11.777 | .001 .627 23.554 979
Greenhouse-Geisser | 1278.250 | 1.145 | 1116.226 | 11.777 | .008 627 13.487 .876
Huynh-Feldt 1278.250 | 1.223 | 1045.066 | 11.777 .006 827 14.405 .894
Lower-bound 1278.250 | 1.000 | 1278.250 | 11.777 011 .627 11.777 .836
Error Sphericity Assumed 759.750 14 54.268
(time) Greenhouse-Geisser 759.750 | 8.016 94.778
Huynh-Feldt 759.750 | 8.562 88.736
Lower-bound 759.750 | 7.000 108.536

a Computed using alpha = .05

You will notice that both the multivariate and univariate summary tables show that the
result is significant. There is a large effect size but the study may be overpowered.
However, you have demonstrated that practice brings about changes in the ability to
solve anagrams, F(1.22, 8.56) = 11.77, p < .05. The exact location of these differences
requires that contrasts be performed. Post-hoc analysis of this nature is beyond the
scope of this chapter.

Practice example

A real estate agent wished to determine whether the number of house sales in ten dif-
ferent suburbs changed significantly over the four quarters of the year. She asked her
representatives in these ten suburbs to record the number of houses sold in each
quarter. Given the data in Prac1(Q.sav, your tasks are to:

1 Check your data for violations of assumptions.

2 Determine whether differences in the number of house sales exist across the
four quarters.

Solutions

Syntax

DESCRIPTIVES

VARIABLES=quart1 quart2 quart3 quart4

/STATISTICS=MEAN STDDEV VARIANCE MIN MAX KURTOSIS SKEWNESS .
GLM

quart1 quart2 quart3 quart4

/WSFACTOR = quarter 4 Polynomial

/METHOD = SSTYPE(3)

/PRINT = ETASQ OPOWER

/CRITERIA = ALPHA(.05)

/WSDESIGN = quarter .

Output

Assumption testing

Normality

Using descriptive statistics it can be seen that all variables are normally distributed.
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Descriptive Statistics

N Minimum | Maximum Mean Std. Variance Skewness Kurtosis
Statistic Statistic Statistic Statistic Statistic Statistic Statistic | Std. Error | Statistic | Std. Error
- quarti 10 3.00 13.00 8.6000 | 3.23866 10.489 -556 687 -.405 1.334
quart2 10 2.00 8.00 5.2000 | 1.87380 3511 -,.2233 .687 -.564 1.334
quart3 10 1.00 5.00 2.8000 | 1.31656 1.733 .088 .687 -751 1.334
quart4 10 .00 3.00 1.3000 .94868 .900 234 .687 -.347 1.334
o Valid N (listwise) 10

Homogeneity of variance

Examination of the variances for each of the variables shows that F-max is greater than

three (10.489/.900), and therefore results must be interpreted with caution because the
— assumption of homogeneity of variance has been violated.

The value of Mauchly is equal to .275 and is not significant, so the F-ratio can be

interpreted.

Mauchly’s Test of Sphericity®
Measure: MEASURE_1

Epsilon®
_ Mauchly's Approx. Greenhouse Huynh- Lower-
Within Subjects Effect W Chi-Square df Sig. -Geisser Feldt bound
Quarter 275 9.958 5 .079 .559 672 .333

—_— Tests the null hypothesis that the error covariance matrix of the orthonormalised transformed dependent variables is

proportional to an identity matrix.

a Design: Intercept Within Subjects Design: quarter

b May be used to adjust the degrees of freedom for the averaged tests of significance. Corrected tests are displayed in the
Tests of Within-Subjects Effects table.

An examination of the significance of the F-value for the variable quarter indicates that
the main effect is significant.

Tests of Within-Subjects Effects
Measure: MEASURE_1

. Type Il Partial
Sum of Mean Eta Noncent. | Observed
Source Squares df Square F Sig. | Squared | Parameter | Power?
Quarter Sphericity Assumed | 304.275 3 101.425 | 27.668 .000 755 83.005 1.000
— Greenhouse-Geisser | 304.275 1.676 181.572 | 27.668 | .000 .755 46.366 1.000
Huynh-Feldt 304.275 2.015 151.010 | 27.668 | .000 755 55.750 1.000
Lower-bound 304.275 1.000 304.275 | 27.668 | .001 .755 27.668 .996
_ Error Sphericity Assumed 98.975 27 3.666
(quarter)  Greenhouse-Geisser 98.975 | 15.082 6.562
Huynh-Feldt 98.975 | 18.134 5.458
Lower-bound 98.975 9.000 10.997

a Computed using alpha = .05

- Remembering that the homogeneity of variance assumption was violated, this could be
adjusted for by setting a more conservative alpha value. Because the F-ratio has such a
low probability, even with this new alpha level it is still significant. Therefore, it can
confidently be said that there are significant differences in the number of house sales
across the four quarters, F(3,27) = 27.668, p < .001.
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Two-way repeated measures
ANOVA

Assumphon testing

In the two-way repeated measures design you have two independent variables, with
two or more levels, which are within-subject in nature. That is, each participant per-
forms in all conditions.

The assumptions underlying the two-way repeated measures ANOVA are identical to
those outlined in the one-way repeated measures ANOVA.

Workmg example

To illustrate the two-way repeated measures ANOVA, you can use an example similar
to the one you used for the two-way independent groups design. Here, manager prod-
uctivity is considered, which is reflected in sales across various store types and
locations. Each manager oversees six stores: one of each type in each location.
Remember, you wish to determine the effect of store type (variety, department and dis-
count) and location (city centre or suburbs) on productivity, measured as sales of toys.
The first independent variable is type of store with three levels, the second independent
variable is location with two levels, and the dependent variable is the amount of toy
sales in $1000 per week. Therefore, you have a 3 x 2 factorial design with six data
cells (3 X 2 = 6). Given that four managers participated in each of the conditions, you
have a total of 24 observations.

You wish to ask three questions:

1 Does the store type influence the amount of toy sales?
2 Does the store location influence the amount of toy sales?
3 Does the influence of store type on the amount of toy sales depend on the

location of the store?

Questions 1 and 2 refer to main effects, while question 3 examines the effect of the
interaction of the two independent variables on the dependent variable.

The data file can be found in Work11.sav on the website that accompanies this title and
is shown in the following figure.

M SPSS: Analysis without Anguish
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To conduct a two-way repeated measures ANOVA

Select the Analyze menu.

Click on General Linear Model and then on Repeated Measures... to open
the Repeated Measures Define Factor(s) dialogue box.

In the Within-Subject Factor Name: box, type the name for the first within-
subjects factor (i.e. location).

In the Number of Levels: box, type the number of levels of that particular
factor (i.e. 2).

Click on Add to move this information into the box below.

In the Within-Subject Factor Name: box, type the name for the second within-
subjects factor (i.e. type).

In the Number of Levels: box, type the number of levels of that particular
factor (i.e. 3).

Click on Add to move this information into the box below.

Within-Subject Factor Name: | l Define !

Number of Levels: ‘ Reset I
location(Z} Cancel l
type(3}

Help

10

Click on the Define command pushbutton to open the Repeated Measures sub-
dialogue box.

Select the six within-subjects variables (i.e. locltypl, locltyp2, locltyp3,
loc2typl, loc2typ2, loc2typ3) and click on the ] button to move the variables
into their appropriate places within the Within-Subjects Variables (location,
type): box (i.e. locltypl -> {1,1}, locltyp2 -> 1,2}, etc.).

CHAPTER 11 ¢ Two-way repeated measures ANOVA—H
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Within-Subjects Variables  {location type):

loctyp1{1.1) Paste
loc 1typ2{1.2;
| 31.3)

Between-Subjects Factor{s):

Covariates:

Model... Contrasts... Plots... ‘ Post Hoc.’.l Save.., Options.., !

11 Click on the Options... command pushbutton to open the Repeated Measures:
Options sub-dialogue box.

12 In the Display box, click on the Descriptives, Estimates of effect size and
Observed power check boxes.

~ Estimated Marginal Means
Factor{s) and Facter Interactions: Display Means for:
OVERALLY
iocation 3
y
type

locationype

- Display

¥ Descriptive statistics [~ Transformation matrix

W Estimates of effect size [+

¥ Observed power |

I™ Parameter estimates I~ Residual plots

[~ SSCP matrices T~ Lack of fit test

[~ Residual SSCP matrix T~ General estimable function
Significance level: {05 Corfidence intervals are 95%

‘Continuel Cancel i Help ‘

13 Click on Continue and then OK.

GLM
loc1typ1 loc1typ2 loc1typ3 loc2typ1 loc2typ2 loc2typ3
/WSFACTOR = location 2 Polynomial type 3 Polynomial
/METHOD = SSTYPE(3)
/PRINT = DESCRIPTIVE ETASQ OPOWER
/CRITERIA = ALPHA(.05)
/WSDESIGN = location type location*type .

ﬂ SPSS: Analysis without Anguish
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Descriptive Statistics

Mean St. Deviation N

city, variety store 3.00 3.162 4

city department store 10.00 4.761 4

city discount store 14.00 3.916 4

suburb variety store 11.00 3.916 4

suburb department store 12.00 5.477 4

suburb discount store 10.00 4.082 4

Mauchly's Test of Sphericity®
Measure: MEASURE _1
Epsilon®
Mauchly’s Approx. Greenhouse Huynh-

Within Subjects Effect W Chi-Square df Sig. -Geisser Feldt Lower-bound
location 1.000 .000 0 . 1.000 1.000 1.000
type 918 A71 2 918 924 1.000 500
location * type .502 1.378 2 .502 .668 1.000 .500

Tests the null hypothesis that the error covariance matrix of the orthonormalised transformed dependent variables is

proportional to an identity matrix.

a Design: Intercept Within Subjects Design: location+type-+location*type

b May be used to adjust the degrees of freedom (df) for the averaged tests of significance. Corrected tests are displayed in
the Tests of Within-Subjects Effects table.

Tests of Within-Subjects Effects
Measure: MEASURE_1

Type lll Sum Mean Partial Eta Noncent. Observed
Source of Squares df Square F Sig. Squared Parameter Power®
location Sphericity Assumed 24.000 1 24.000 6.000 | .092 .667 6.000 .395
Greenhouse-Geisser 24.000 1.000 24.000 6.000 | .092 667 6.000 .395
Huynh-Feldt 24.000 | 1.000 24.000 6.000 | .092 .667 6.000 .395
Lower-bound 24.000 | 1.000 24.000 6.000 | .092 667 6.000 .395
Error (location) Sphericity Assumed 12.000 3 4.000
Greenhouse-Geisser 12.000 | 3.000 4.000
Huynh-Feldt 12.000 3.000 4.000
Lower-bound 12.000 | 3.000 4.000
type Sphericity Assumed 112.000 2 56.000 10.723 | .010 .781 21.447 .891
Greenhouse-Geisser 112.000 1.849 60.589 10.723 | .013 .781 19.823 .865
Huynh-Feldt 112.000 2.000 56.000 10.723 | .010 .781 21.447 .891
Lower-bound 112.000 1.000 | 112.000 10.723 | .047 .781 10.723 .600
Error(type) Sphericity Assumed 31.333 6 5.222
Greenhouse-Geisser 31.333 | 5.546 5.650
Huynh-Feldt 31.333 | 6.000 5.222
Lower-bound 31.333 3.000 10.444
location * type Sphericity Assumed 144.000 2 72.000 1929 | 226 .391 3.857 .260
Greenhouse-Geisser 144.000 1.335 | 107.857 1.929 | 248 .391 2.575 .200
Huynh-Feldt 144.000 | 2.000 72.000 1.929 | 226 .391 3.857 .260
Lower-bound 144.000 | 1.000 | 144.000 1.929 | 259 .391 1.929 168
Error (location*type)  Sphericity Assumed 224.000 6 37.333
Greenhouse-Geisser 224.000 | 4.005 55.926
Huynh-Feldt 224.000 | 6.000 37.333
Lower-bound 224.000 3.000 74.667

a Computed using alpha = .05

The main effect for location is not significant and thus you can conclude that the location
of the store does not influence the amount of toy sales.

Because the Mauchly test of sphericity for store type is not significant, you have not
violated this assumption. The main effect for type of store is significant (p < .05) and
so you can conclude that toy sales are influenced by the type of store in which they are
sold, F(2,6) = 10.723, p < .05. There is a large effect size and the power of the study is
good.

Because the Mauchly test of sphericity for the interaction is not significant, you have
not violated this assumption. The location by type of store interaction effect is not sig-
nificant and therefore you can conclude that the differences in sales across type of
store do not depend on the location of the store.
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Practice

If post-hoc analysis were to follow, you would conduct a comparison of marginal
means for the significant main effect, which can be calculated from the cell means in
the output.

example

A graphic designer wished to determine which combination of colours and backgrounds
produce the most aesthetically pleasing display. Five participants were exposed to two
different types of background (hatched and spotted) and lettering of four different
colours (red, blue, green and yellow). Participants were requested to rate the pleasing
nature of these displays on a 20-point scale (1 = least pleasing to 20 = most pleasing).
Given the data in Pracl1.sav, your tasks are to:

Solutions

1 Check the data for violations of assumptions.

2 Determine whether background influences the participants’ ratings.

3 Determine whether colour of lettering influences the participants’ ratings.

4 Determine whether the influence of background on rating depends on letter
colouring.

Syntax

DESCRIPTIVES
VARIABLES=b1c1 bi1c2 b1c3 bicd b2ct b2c2 b2c3 b2c4
/STATISTICS=MEAN STDDEV MIN MAX KURTOSIS SKEWNESS .
GLM
bic1 b1c2 b1c3 b1c4 b2c1 b2c2 b2c3 b2c4
/WSFACTOR = bground 2 Polynomial colour 4 Polynomial
/METHOD = SSTYPE(3)
/PRINT = ETASQ OPOWER
/CRITERIA = ALPHA(.05)
/WSDESIGN = bground colour bground*colour .

Output

Assumption testing

Normality
Descriptive Statistics
N Minimum | Maximum Mean Std. Variance Skewness Kurtosis
Statistic Statistic Statistic Statistic Statistic Statistic Statistic | Std. Error | Statistic | Std. Error

hatch, red 5 1.00 9.00 4.8000 | 3.19374 10.200 .301 913 -1.344 2.000
hatch, blue 5 3.00 13.00 8.0000 | 4.12311 17.000 .000 913 -1.893 2.000
hatch, green 5 5.00 14.00 10.2000 | 3.42053 11.700 -.845 913 699 2.000
hatch, yeliow 5 4.00 12.00 8.0000 | 3.39116 11.500 192 913 -2.234 2.000
spotted, red 5 3.00 10.00 6.8000 | 3.11448 9.700 .060 913 -2.299 2.000
spotted, biue 5 5.00 15.00 9.4000 | 4.15933 17.300 .397 913 -1.578 2.000
spotted, green 5 9.00 18.00 13.2000 | 3.49285 12.200 310 913 -.644 2.000
spotted, yellow 5 7.00 15.00 10.4000 | 3.84708 14.800 458 913 -2.939 2.000
Valid N (listwise) 5

From the descriptive statistics it iS necessary to examine the skewness and kurtosis
statistics. Although the kurtosis is marked for several variables, the skewness is
minimal and thus we can say that we have not violated the normality assumption.

WSPSS: Analysis without Anguish
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Examination of the variances shows that our F-max is not greater than three (17.3/9.7 = 1.78),
so homogeneity of vartance is assumed.

Mauchly’s Test of Sphericity?

Measure: MEASURE_1

Epsilon®
Mauchly’s Approx. Greenhouse Huynh-
Within Subjects Effect W Chi-Square df Sig. -Geisser Feldt Lower-bound
bground 1.000 .000 0 . 1.000 1.000 1.000
colour 510 1.833 5 .879 729 1.000 .333
bground * colour .103 6.192 5 .315 470 .650 .333

Tests the null hypothesis that the error covariance matrix of the orthonormalised transformed dependent variables is

proportional to an identity matrix.

a Design: Intercept Within Subjects Design: bground+colour+bground*colour

b May be used to adjust the degrees of freedom for the averaged tests of significance. Corrected tests are displayed in the
Tests of Within-Subjects Effects table.

Tests of Within-Subjects Effects

Measure: MEASURE_1

Type il
Sum of Mean Partial Eta Noncent. Observed
Source Squares df Square F Sig. Squared Parameter Power?
bground Sphericity Assumed 48.400 1 48.400 | 30.488 | .005 .884 30.488 .980
Greenhouse-Geisser 48.400 1.000 48.400 | 30.488 | .005 .884 30.488 .980
Huynh-Feldt 48.400 1.000 48.400 30.488 | .005 .884 30.488 .980
Lower-bound 48.400 1.000 48.400 | 30.488 | .005 .884 30.488 .980
Error(bground) Sphericity Assumed 6.350 4 1.588
Greenhouse-Geisser 6.350 4.000 1.588
Huynh-Feldt 6.350 4.000 1.588
Lower-bound 6.350 4.000 1.588
colour Sphericity Assumed 175.700 3 58.567 45.196 | .000 919 135.588 1.000
Greenhouse-Geisser 175.700 2.187 80.330 45196 | .000 919 98.854 1.000
Huynh-Feldt 175.700 3.000 58.567 | 45.196 | .000 919 135.588 1.000
Lower-bound 175.700 1.000 175.700 | 45.196 | .003 919 45.196 .998
Error{colour) Sphericity Assumed 156.550 12 1.296
Greenhouse-Geisser 15.550 8.749 1.777
Huynh-Feldt 15.550 | 12.000 1.296
Lower-bound 15.550 4.000 3.888
bground * colour Sphericity Assumed 3.400 3 1.133 2.325 | 127 .368 6.974 446
Greenhouse-Geisser 3.400 1.410 2.411 2.325 | 184 .368 3.278 271
Huynh-Feldt 3.400 1.950 1.744 2.325 | 162 .368 4.532 .335
Lower-bound 3.400 1.000 3.400 2.325 | 202 .368 2.325 .219
Error(bground*colour)  Sphericity Assumed 5.850 12 .488
Greenhouse-Geisser 5.850 5.640 1.037
Huynh-Feldt 5.850 7.798 .750
Lower-bound 5.850 4.000 1.463

a Computed using alpha = .05

The main effect for background is significant (p < .05) and so it can be concluded that
type of background does affect the participants’ ratings, F(1,4) = 30.488, p < .05.

Because the Mauchly test of sphericity for colour is not significant, this assumption
has not been violated.

The main effect for colour is significant (p < .05) and therefore it can be said that the
colour of lettering does affect the participants’ ratings, F(3,12) = 45.196, p < .05.

Because the Mauchly test of sphericity for the interaction effect (background by
colour) is not significant, this assumption has not been violated.

The background by colour interaction effect is not significant and so it can be con-
cluded that although main effects for both background and colour independently were
significant, the eftfect of one independent variable does not depend on the effect of the
other in influencing the participants’ ratings of pleasing nature. In other words, back-
ground does not depend on colour in influencing participants’ ratings, F(3, 12) = 2.325,
p > .05.

CHAPTER 11 o Two-way repeated measures ANOVA m
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Trend analysw

Sometimes, having determined that a significant effect exists, you may wish to deter-
mine the nature of this relationship by examining trends in the data. Post-hoc and
planned comparisons could be performed between the treatment means, as discussed
in chapters 7 and 8. This chapter discusses how you can test for different trends in the
data — for example, a trend may be linear, quadratic or cubic. However, trend analysis
is only appropriate when:

1 The levels of the independent variable can be considered to form an increasing
or decreasing continuum.

2 The intervals between adjacent levels of the independent variable are equal or
proportional.

When you conduct planned comparisons you use coefficients to pick out and represent
a particular combination of means you wish to compare. When you conduct trend
analysis you also use coefficients, but the coefficients you select, when plotted, define
the particular shape of the curve that you are testing. These coefficients can be found
in the tables of any good statistical text, but when conducting trend analysis within
SPSS for Windows, linear and quadratic trend options already exist. In essence, trend
analysis is a special case of planned comparisons.

Assumphon testing

As outlined in chapter 11, trend analysis follows ANOVA and therefore the assump-
tions of ANOVA must be met.

Workmg example

A cognitive psychologist was interested in whether reaction time (RT) declined as a
function of age. She obtained random samples of 25 people from each of four age
groups and measured the time it took each participant to press a button in response to
a visual cue. The age groups she chose were 15-20 years, 3540 years, 55-60 years
and 75-80 years. The researcher anticipated that reaction time would increase consis-
tently with age.

The data file can be found in Work 12.sav on the website that accompanies this title and
is shown in the following figure.
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%f"b To conduct a linear trend analysis

Select the Analyze menu.

Click on Compare Means and One-Way ANOVA... to open the One-Way
ANOVA dialogue box.

Select the dependent variable (i.e. rt) and click on the ] button to move the
variable into the Dependent List: box.

Select the independent variable (i.e. age) and click on the [] button to move the
variable into the Factor: box.

Click on the Options... command pushbutton to open the One-Way ANOVA:
Options sub-dialogue box.

Select the check boxes for Descriptive and Homogeneity-of-variance.

¥ Descriptive

™ Fixed and random effects
¥ Homogeneity of variance test Help
™ Brown-Forsythe
™ Welch

Cancel

g—Missing Values

™ Means plot

¢ Exclude cases analysis by analysis
" Exclude cases listwise

7
8

Click on Continue.

Click on the Contrasts... command pushbutton to open the One-Way ANOVA:
Contrasts sub-dialogue box.

CHAPTER 12 o Trend analysis
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9  Select the Polynomial check box.
10 In the Degree: drop-down list, ensure that the Linear trend is selected.

~

l Cortinue i
Cancel f

Help

Cosfficients:

Coefficient Total: 0.00C

11 Click on Continue and then OK.

ONEWAY
rt BY age
/POLYNOMIAL= 1
/STATISTICS DESCRIPTIVES HOMOGENEITY
/MISSING ANALYSIS .

Descriptives

rt

95% Confidence Interval

for Mean
Std. Lower Upper
N Mean Deviation | Std. Error Bound Bound Minimum | Maximum

15-20 25 | 497.2800 | 56.62782 | 11.32556 473.9052 520.6548 383.00 621.00
35-40 25 | 515.8400 | 56.52925 | 11.30585 492.5059 539.1741 397.00 647.00
55-60 25 | 531.2000 | 63.97591 | 12.79518 504.7920 557.6080 397.00 677.00
75-80 25 | 555.1200 | 72.57601 | 14.51520 525.1621 585.0779 429.00 739.00
Total 100 | 524.8600 | 65.38511 6.53851 511.8862 537.8338 383.00 739.00

The Levene test for homogeneity of variances is not significant (p > .05), indicating
that the assumption has not been violated.

Test of Homogeneity of Variances

rt

Levene Statistic df1 df2 Sig.
.817 3 96 .488
ANOVA
rt
Sum of
squares df Mean Square F Sig.
Between Groups  (Combined) 44947.000 3 14982.333 3.802 .013
Linear Term Contrast 44594.568 1 44594568 11.317 .001
Deviation 352.432 2 176.216 .045 .956
Within Groups 378299.040 96 3940.615
Total 423246.040 99

WSPSS.' Analysis without Anguish
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Practice

The ANOVA summary table shows a significant between-groups F-ratio (p < .05) and
therefore you can conclude that reaction time differs significantly across age groups,
F(3,96) = 3.802, p < .05. Furthermore, by examining the linear term, which is also
significant (p < .05), you can also conclude that reaction time increases consistently
across age groups. Plotting these means illustrates a linear trend, as evident in the
following figure. Remember, you can plot means using the Graphs menu and Line
Charts sub-menu.
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540.00 -4

v 530,00

Mean

520 00 —

P

£10.00 ~4

500.00

490 .00

i
15-20 35.40 5560 75.80
age group

Trend analyses can also be conducted in the case of a one-way repeated measures
design or two-way independent and repeated measures designs. First, the relevant
simple effect must be extracted using the Select Cases... option in the Data menu or
toolbar, then analysis for trend components is conducted using the Contrasts... pro-
cedure available in the One-Way ANOVA sub-menu. In the case of two-way designs,
it is important to remember that the error term for the different trend F-ratios will be
the within-groups or residual mean square from the overall ANOVA. That is, the mean
square from the two-way ANOVA summary table is used.

example

Researchers wished to examine the effect of caffeine on the performance of a simple
motor task. Sixty participants performed under one of three caffeine consumption con-
ditions (0.00, 150 and 300 millilitres) and were required to perform a sequential finger-
tapping task. The number of errors made was recorded. Given the data in Pracl2.sav,
your tasks are to:

1 Check for violations of assumptions.

2 Determine whether caffeine consumption significantly influences ability to
perform the task accurately (that is, the number of errors made).

3 Determine whether this trend is linear.

CHAPTER 12 ¢ Trend analysis
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Solutions
Syntax

00 000000000000 000000 00 II000QINNttElNtttniltietittitiscsitissnsitiitisstionssstonssstnnnetissososvtoonssssss

EXAMINE
VARIABLES=errors BY caffeine
/PLOT NONE
/STATISTICS DESCRIPTIVES
/CINTERVAL 95
/MISSING LISTWISE
/NOTOTAL.

ONEWAY
errors BY caffeine
/POLYNOMIAL= 1
/STATISTICS HOMOGENEITY
/MISSING ANALYSIS .

GRAPH
/LINE(SIMPLE)=MEAN(errars) BY caffeine
/MISSING=REPORT.

Output

Assumption testing

Normality
Descriptives
[ caffeine consumption Statistic Std. Error
number of errors 0.00 caffeine Mean 1.25 315
95% Confidence Lower Bound .59
Interval for Mean Upper Bound 1.91
5% Trimmed Mean 1.11
Median 1.00
Variance 1.987
Std. Deviation 1.410
Minimum 0
Maximum 5
Range 5
Interquartile Range 2
Skewness 1.386 512
Kurtosis 1.628 .992
150 ml caffeine Mean 5.15 499
95% Confidence Lower Bound 411
Interval for Mean Upper Bound 6.19
5% Trimmed Mean 5.06
Median 4.50
Variance 4.976
Std. Deviation 2.231
Minimum 2
Maximum 10
Range 8
interquartile Range 4
Skewness 771 512
Kurtosis -.300 .992
300 ml catfeine Mean 10.40 .825
95% Confidence Lower Bound 8.67
Interval for Mean Upper Bound 12.13
5% Trimmed Mean 10.50
Median 11.00
Variance 13.621
Std. Deviation 3.691
Minimum 3
Maximum 16
Range 13
Interquartile Range 5
Skewness -.640 512
Kurtosis -.206 .992
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Skewness and kurtosis statistics indicate that the number of errors is relatively nor-
mally distributed across cafteine groups.

Test of Homogeneity of Variances
number of errors
Levene Statistic df1 df2 Sig.
6.690 2 57 .002

The Levene test for homogeneity of variance is significant (p < .05) and so the linear
trend must be interpreted with caution. It may be preferable to assess the F-value at a
more conservative alpha level of .001.

- ANOVA
number of errors
Sum of
— squares df Mean Square F Sig.
Between Groups  (Combined) 843.300 2 421.650 61.452 .000
Linear Term Contrast 837.225 1 837.225 122.019 .000
_— Deviation 6.075 1 6.075 .885 .351
Within Groups 391.100 57 6.861
Total 1234.400 59

The linear trend is still significant at this more conservative alpha level and so it can
be said that there is a significant linear trend in the data. That is, as caffeine consump-
tion increases so does the number of errors made in the motor task, F(2,57) = 61.452,
p < .001. This trend is depicted in the following figure.

Mean number of errors

G -4

i T i
0.00 caffeine 150 mi caffeine 300 mi caffeine

caffeine consumption

CHAPTER 12 ¢ Trend analysisw

KaRaNLIK



13

Mixed/split plot design
(SPANOVA)

In the two-way mixed designs sometimes called a split plot ANOVA or SPANOVA,
there are repeated measures on one independent variable and independent groups on
the other independent variable.

Assumphon testing

The assumptions underlying the SPANOVA are the same as those for the independent
groups and repeated measures ANOVAs. A further assumption specifically applies to
this analysis:

1 Homogeneity of intercorrelations — the pattern of intercorrelations among
the various levels of the repeated measures factor(s) should be consistent from
level to level of the between-subjects factor(s). This assumption is tested using
Box’s M statistic. This statistic is very sensitive so it is recommended that an
alpha level of .001 be used in its interpretation. Homogeneity is present when
the statistic is not significant (p > .001).

Workmg example

A therapist wishes to determine the efficacy of a new treatment program for
depression. She randomly assigns eight participants to either the treatment group or the
control group. She asks each participant to complete a depression inventory before the
treatment starts, immediately the treatment finishes and three months after completion.
The first independent variable, time of test, is within-subjects in nature and has three
levels. The second independent variable, treatment status, is a between-subjects factor
with two levels. The dependent variable is the score on the depression inventory.
Therefore, you have a 3 x 2 factorial design with six data cells (3 X 2 = 6) and 48
observations.

The therapist wishes to ask three questions:

1 Do depression scores change with time?

2 Is the treatment more effective than the control?

3 Are there differential changes in depression scores for the treatment and control
groups?

Questions 1 and 2 refer to main effects, while question 3 examines the effects of the
interaction of the two independent variables on the dependent variable. The data file
can be found in Work13.sav on the website that accompanies this title and is shown in
the following figure.
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B Worki3 - SPSS Data Editor
Data
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To conduct a SPANOVA

Select the Analyze menu.

2 Click on General Linear Model and then on Repeated Measures... to open
the Repeated Measures Define Factor(s) dialogue box.

3 In the Within-Subject Factor Name: box, type a name for the within-subjects
factor (i.e. time), then tab. In the Number of Levels: box, type the number of
levels of this factor (i.e. 3).

4 Click on Add to move this information into the box below.

5 Click on the Define command pushbutton to open the Repeated Measures sub-
dialogue box.

6 Select the variables representing the within-subjects factor (i.e. pretest, posttest
and followup) and click on the P button to move these variables into the
Within-Subjects Variables: (time) box.

7  Select the between-subjects variable (i.e. trear) and click on the [ button to
move this variable into the Between-Subjects Factor(s): box.
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KaRaNLIK



Within-Subjects Variables  ftime): 0K

| Ai vi pretest(T) Paste l

posttest/)
followupid) Reset f
_tep |

Between-Subjects Factor(s):

Covarates:

Modet... i Contrasts..'i Plots... i Post Hoc,..J Save... 1 Oplionsm}

8  Click on the Options... command pushbutton to open the Repeated Measures:
Options sub-dialogue box.

9 In the Display box, click on the Descriptives, Estimates of effect size,
Observed power and Homogeneity tests check boxes.

;- Estimated Marginal Means
Factoris} and Factor Interactions: Display Means for:
OVERALL

treat 5
time il
treat lime

~ Display e

¥ Descrptive statistics I~ Transformation matrix

¥ Estimates of effect size ¥ Homogeneity tests

¥ Observed power T~ Spread vs. level plots

T~ Parameter estimates T~ Residual plots

T~ SSCP matdces I Lack of fit test

™ Residual SSCP matrix I~ General estimable function
Significance level: g.O‘E Canfidence intervals are $5%

lCDminuel Cancel i Help }

10 Click on Continue and then OK.

GLM
pretest posttest followup BY treat
/WSFACTOR = time 3 Polynomial
/METHOD = SSTYPE(3)
/PRINT = DESCRIPTIVE ETASQ OPOWER HOMOGENEITY
/CRITERIA = ALPHA(.05)
/WSDESIGN = time
/DESIGN = treat .
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Descriptive Statistics

treatment status Mean Std. Deviation N

pre treatment depression score treatment group 37.00 3.162 4
control group 29.00 3.916 4
Total 33.00 5.398 8

post treatment depression score treatment group 30.00 4.761 4
control group 28.00 5.477 4
Total 29.00 4.870 8

follow up depression score treatment group 26.00 3.916 4
control group 30.00 4.082 4
Total 28.00 4.276 8

Box’s Test of Equality of Covariance Matrices®

Box’s M
F

df1

df2

Sig.

9.081
.659

6
260.830
.683

Tests the null hypothesis that the observed covariance

matrices of the dependent variables are equal across groups.

a. Design: Intercept+treat
Within-Subjects Design: time

Because Box’s M statistic is not significant (p > .001), you have not violated the
assumption of homogeneity of variance—covariance matrices.

The Mauchly test of sphericity for time below is also not significant (p > .05) and so
you have not violated the sphericity assumption.

Measure: MEASURE_1

Mauchly’s Test of Sphericity®

Epsilon?
Mauchly’s Approx. Greenhouse Huynh- Lower-
Within Subjects Effect w Chi-Square df Sig. -Geisser Feldt bound
time 577 2.749 2 .253 .703 1.000 500

Tests the nuil hypothesis that the error covariance matrix of the orthonormaiised transformed dependent variables is
proportional to an identity matrix.
a. May be used to adjust the degrees of freedom for the averaged tests of significance. Corrected tests are displayed in the

Tests of Within-Subjects Effects table.

b. Design: Intercept+treat

Within Subjects Design: time
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KaRaNLIK



Measure: MEASURE_1

Tests of Within-Subjects Effects

Type Il Il
Sum of Mean Partial Eta | Noncent. | Observed
Source Squares df Square F Sig. Squared | Parameter | Power?
time Sphericity Assumed 112.000 2 56.000 | 2.632 | .113 .305 5.264 424
Greenhouse-Geisser 112.000 | 1.406 79.686 2.632 137 .305 3.699 .340
Huynh-Feldt 112.000 | 2.000 56.000 | 2.632 | 113 .305 5.264 424
Lower-bound 112.000 | 1.000 | 112.000 | 2.632 | .156 .305 2.632 .278
time * treat Sphericity Assumed 144.000 2 72.000 | 3.384 .068 .361 6.768 525
Greenhouse-Geisser | 144.000 | 1.406 | 102.453 | 3.384 .093 .361 4.756 421
Huynh-Feldt 144.000 | 2.000 72.000 | 3.384 | .068 .361 6.768 .525
Lower-bound 144.000 | 1.000 | 144.000 3.384 115 .361 3.384 341
Error(time)  Sphericity Assumed 255.333 12 21.278
Greenhouse-Geisser | 255.333 | 8.433 30.277
Huynh-Feldt 255.333 | 12.00 21.278
Lower-bound 255.333 0 42.556
6.000
a. Computed using alpha = .05
Levene's Test of Equality of Error Variances®
F df1 df2 Sig.
pre treatment depression score .200 1 6 670
post treatment depression score .231 1 6 .648
follow up depression score 273 1 6 .620

Tests the null hypothesis that the error variance of the dependent variable is equal across groups.
a. design: Intercept+treat

Within Subjects Design: time

Levene’s test for homogeneity of variance is not significant, so this assumption is not

violated.

The main effect for time is not significant (p > .035) and therefore you can conclude
that depression scores did not change significantly from the pretest to the followup.

The main effect for treatment is also not significant (p > .035) and so those participants
in the treatment group did not fare any better than those in the control group. Conse-
quently, the therapist must be very disappointed!

Measure: MEASURE_1
Transformed Variable: Average

Tests of Between-Subjects Effects

Type IIt Sum Mean Partial Eta Noncent. Observed
Source of Squares df Square F Sig. Squared Parameter Power?
Intercept 21600.000 1 21600.000 | 1735.714 .000 .997 1735.714 1.000
treat 24.000 1 24.000 1.929 214 .243 1.929 217
Error 74.667 6 12.444

a. Computed using alpha = .05

Lastly, the interaction effect is not significant (p > .05). Had the main effect for time or
the interaction been significant, you would have needed to locate the source of these
differences using post-hoc analysis.
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Practice example

In designing a new concert hall an architect wished to determine whether the size of
the auditorium and the choice of sound-proofing material influenced the quality of the
acoustics. Two sizes of auditorium were investigated (smail and large), with four dif-
ferent types of sound-proofing material. Ten different conductors were randomiy
assigned to the different-sized auditoriums. These conductors listened to four orches-
tral performances under different sound-proofing conditions. Conductors were asked to
rate the quality of sound using a 20-point rating scale (1 = poor sound to 20 = excellent
sound). Given the data in Prac13.sav, your tasks are to:

1 Check the data for violation of assumptions.

2 Determine whether auditorium size influences sound quality.

3 Determine whether sound-proofing material influences sound quality.

4 Determine whether the influence of auditorium size on sound quality depends

on sound-proofing material.

Solutions

37 Syntax

EXAMINE

VARIABLES=sp1 sp2 sp3 sp4 BY audit

/PLOT BOXPLOT

/COMPARE GROUP

/STATISTICS DESCRIPTIVES

/CINTERVAL 95

/MISSING LISTWISE

/NOTOTAL.

GLM
sp1 sp2 sp3 sp4 BY audit
/WSFACTOR = sound 4 Polynomial
/METHOD = SSTYPE(3)
/PRINT = ETASQ OPOWER HOMOGENEITY
/CRITERIA = ALPHA(.05)
/WSDESIGN = sound
/DESIGN = audit

Output

Assumption testing

Descriptives

size of auditorium Statistic Std. Error
sp1 small Mean 4.8000 1.42829
95% Confidence Lower Bound .8344
Interval for Mean Upper Bound 8.7656
5% Trimmed Mean 4.7778
Median 4.0000
Variance 10.200
Std. Deviation 3.19374
Minimum 1.00
Maximum 9.00
Range 8.00
Interquartile Range 6.00
Skewness .301 913
Kurtosis -1.344 2.000
(continued)

CHAPTER 13 o Mixed/split plot design (SPANOVA)E

KaRaNLIK



Descriptives (continued)

size of auditorium Statistic Std. Error
large Mean 6.8000 1.39284
95% Confidence Lower Bound 2.9329
Interval for Mean Upper Bound 10.6671
5% Trimmed Mean 6.8333
Median 6.0000
Variance 9.700
Std. Deviation 3.11448
Minimum 3.00
Maximum 10.00
Range 7.00
Interquartile Range 6.00
Skewness 060 913
Kurtosis -2.299 2.000
sp2 small Mean 8.0000 1.84391
95% Confidence Lower Bound 2.8805
Interval for Mean Upper Bound 13.1195
5% Trimmed Mean 8.0000
Median 8.0000
Variance 17.000
Std. Deviation 412311
Minimum 3.00
Maximum 13.00
Range 10.00
Interquartile Range 8.00
Skewness .000 913
Kurtosis -1.893 2.000
large Mean 9.4000 1.86011
95% Confidence Lower Bound 4.2355
Interval for Mean Upper Bound 14.5645
5% Trimmed Mean 9.3333
Median 9.0000
Variance 17.300
Std. Deviation 4.15933
Minimum 5.00
Maximum 15.00
Range 10.00
Interquartile Range 8.00
Skewness 397 913
Kurtosis -1.578 2.000
sp3 small Mean 10.2000 1.52971
95% Confidence Lower Bound 5.9529
Interval for Mean Upper Bound 14.4471
5% Trimmed Mean 10.2778
Median 11.0000
Variance 11.700
Std. Deviation 3.42053
Minimum 5.00
Maximum 14.00
Range 9.00
Interquartile Range 6.00
Skewness -.845 913
Kurtosis 699 2.000
large Mean 13.2000 1.56205
95% Confidence Lower Bound 8.8631
Interval for Mean Upper Bound 17.5369
5% Trimmed Mean 13.1667
Median 13.0000
Variance 12.200
Std. Deviation 3.49285
Minimum 9.00
Maximum 18.00
Range 9.00
Interquartile Range 6.50
Skewness .310 913
Kurtosis -.644 2.000
(continued)
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Descriptives (continued)

size of auditorium Statistic Std. Error
sp4 small Mean 8.0000 1.51658
95% Confidence Lower Bound 3.7893
Interval for Mean Upper Bound 12.2107
5% Trimmed Mean 8.0000
Median 7.0000
Variance 11.500
Std. Deviation 3.39116
Minimum 4.00
Maximum 12.00
Range 8.00
Interquartile Range 6.50
Skewness 192 913
Kurtosis -2.234 2.000
large Mean 10.4000 1.72047
95% Confidence Lower Bound 5.6232
Interval for Mean Upper Bound 15.1768
5% Trimmed Mean 10.3333
Median 9.0000
Variance 14.800
Std. Deviation 3.84708
Minimum 7.00
Maximum 15.00
Range 8.00
Interquartile Range 7.50
Skewness 458 913
Kurtosis -2.939 2.000
Normality

Skewness and kurtosis statistics indicate that data are relatively normally distributed
across groups.

Box’s Test of Equality of Covariance Matrices®

Box’s M
F

df1

df2

Sig.

9.339
.401

10
305.976
.946

Tests the null hypothesis that the observed covariance

matrices of the dependent variables are equal across groups.
a. Design: Intercept+audit
Within-Subjects Design: sound

Measure: MEASURE_1

Mauchly’s Test of Sphericity®

Epsilon?
Mauchly’s Approx. Greenhouse Huynh- Lower-
Within Subjects Effect w Chi-Square df Sig. -Geisser Feldt bound
sound .498 4.680 5 460 .683 1.000 .333

Tests the null hypothesis that the error covariance matrix of the orthonormalised transformed dependent variables is
proportional to an identity matrix.
a. May be used to adjust the degrees of freedom for the averaged tests of significance. Corrected tests are displayed in the

Tests of Within-Subjects Effects table.

b. Design: Intercept+audit

Within Subjects Design: sound
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Measure: MEASURE_1

Tests of Within-Subjects Effects

Type Ht
Sum of Mean Partial Eta | Noncent. | Observed
Source Squares df Square F Sig. Squared | Parameter | Power®
sound Sphericity Assumed 175.700 3| 58.567 | 65.682 | .000 .891 197.047 1.000
Greenhouse-Geisser | 175.700 2.049 | 85.755 | 65.682 | .000 .891 134.573 1.000
Huynh-Feldt 175.700 3.000 | 58.567 | 65.682 | .000 .891 197.047 1.000
Lower-bound 175.700 1.000 | 175.700 | 65.682 | .000 .891 65.682 1.000
sound * audit Sphericity Assumed 3.400 3 1.133 | 1.271 ] .307 137 3.813 .296
Greenhouse-Geisser 3.400 2.049 1.659 | 1.271 | .308 137 2.604 .239
Huynh-Feldt 3.400 3.000 1.133 | 1.271 | .307 137 3.813 .296
Lower-bound 3.400 1.000 3.400 | 1.271 | 292 137 1.271 169
Error(sound) Sphericity Assumed 21.400 24 .892
Greenhouse-Geisser 21.400 | 16.391 1.306
Huynh-Feldt 21.400 | 24.000 .892
Lower-bound 21.400 8.000 2.675
a. Computed using alpha = .05
Levene’s Test of Equality of Error Variances?
F df1 df2 Sig.
sp1 .000 1 8 1.000
sp2 .004 1 8 .951
sp3 .005 1 8 .948
sp4 377 1 8 .556
Tests the null hypothesis that the error variance of the dependent
variable is equal across groups.
a. Design: Intercept+audit
Within Subjects Design: sound
Tests of Between-Subjects Effects
Measure: MEASURE__1
Transformed Variable: Average
Type lll Sum Mean Partial Eta Noncent. Observed
Source of Squares df Square F Sig. Squared Parameter Power?
Intercept 3132.900 1 3132.900 63.259 .000 .888 63.259 1.000
audit 48.400 1 48.400 .977 352 109 977 41
Error 396.200 8 49.525

a. Computed using alpha = .05

In evaluating the necessary assumptions it is found that Box’s M statistic is not signifi-
cant (p > .001) and so the assumption of homogeneity of variance—covariance matrices
is not violated. Mauchly’s statistic is also not significant (p > .05) and so the sphericity
assumption has not been violated; and the Levene’s test indicates homogeneity of
variances.

The results of the SPANOVA indicate that there is a main effect for sound proofing and
that the quality of sound ratings differ with the choice of sound-proofing material,
F(3,24) = 65.682, p < .05. However, no main effect is obtained for auditorium size.

The interaction is also not significant, meaning that the effect of choice of sound-
proofing material does not depend on auditorium size.

Post-hoc tests could now be performed to determine where the differences in sound
proofing lie.
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One-way analysis of covariance
(ANCOVA)

Analysis of covariance (ANCOVA) provides an elegant means of reducing systematic
bias, as well as within-groups error, in the analysis. To determine whether the indepen-
dent variable is indeed having an effect, the influence of an extraneous variable
(covariate) on the dependent variable is statistically controlled during the analysis.
That is, you attempt to reduce error variance due to individual differences. ANCOVA
requires that different participants perform in each condition, and because of this is
suitable for only between or independent groups designs.

tion testing

There are six assumptions that you need to address before conducting an ANCOVA:

1

Independence — the individual’s scores on both the dependent variable and the
covariate should be independent of those scores for all the other participants.

Normality — the dependent variable should have a normal distribution for par-
ticipants with the same score on the covariate and in the same group. You want
to obtain normality at each score on the covariate. If the scores for the covariate
alone are normally distributed, then ANCOVA is robust to this assumption.

Linearity — a linear relationship should exist between the dependent variable
and the covariate for each group. This can be verified by inspecting scatterplots
for each group.

Homogeneity of regression slopes — the relationship of the dependent vari-
able to the covariate in each group should be the same.

Independence of covariate and treatments — when you remove the pro-
portion of shared variability between the dependent variable and the covariate
you must be careful that you do not also remove some of the effect of the inde-
pendent variable. You can avoid this, to some extent, by measuring the covariate
before the beginning of the experiment and also by randomly allocating partici-
pants to the different levels of the independent variable.

Reliability of the covariate — the instrument used to measure the covariate
should be reliable.

Assumptions 1, 5 and 6 relate to experimental design, while assumption 2 has been
explored in chapter 3. To test assumptions 3 and 4, the procedures outlined in the
research example can be used.
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Working example

A sales manager wished to determine whether women or men were more successful
salespeople. She recorded the sales made by 22 sales representatives over a 12-month
period. However, she was aware that years of selling experience would also contribute
to the representatives’ success and she thought it would be fairer to make the
comparison while taking into account this added factor. Thus, the dependent variable
is sales in $1000s per year, the independent variable is gender (coded as 1 = male and
2 =female) and the covariate is years of experience in selling.

The data file can be found in Work14.sav on the website that accompanies this title and
is shown in the following figure.

475PS8 Gata Editor

ender |

%)

[ TE N I NI WA T SR NSRS S UGN N
¥
S

To test for linearity

Assumptions of linearity need to be assessed for each level or group of the indepen-
dent variable separately. The Split File... option can be used to select specific groups
from the data file.

1 Select the Data menu and click on Split File... or click on the Split File tool to
open the Split File dialogue box.

2 Select the Organize output by groups radio button, then select the group vari-
able (i.e. gender) and click on the button to move the variable into the Groups
Based on: box.

p!

®)'ears of salling experie: ° fnalyze all cases, do not create groups K
@ salesin 51000 perann € Compare groups

¢ Organize output by groups
Groups Based on: Reset

Cancel
Help

¥ Sort the file by grouping vanables
¢ File is already sorted

Current Status: Analysis by groups is off.
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3 Click on OK.
4 Select the Graphs menu.

5 Click on Scatter... to open the Scatterplot dialogue box. Notice that the Simple
scatterplot option is outlined by default.

Define

wy Matrix Cancel l
- ‘:" 20 Help ’

6 Click on the Define command pushbutton to open the Simple Scatterplot sub-
dialogue box.

7 Select the first variable (i.e. sales) and click on the ] button to move the variable
into the Y Axis: box.

8 Select the second variable (i.e. years) and click on the ®] button to move the
variable into the X Axis: box.

9 Click on OK.

4 gender jgender] — Y Axis: oK
B l @ sales in $1000 per annt

Paste

X A Reset

Cancel
Set Markers by: Help

Label Cases by:

Eliele

~ Template
I Use chart specfications from:

Titles... l Options“.i

SORT CASES BY gender .

SPLIT FILE
SEPARATE BY gender .

GRAPH
/SCATTERPLOT(BIVAR)=years WITH sales
/MISSING=LISTWISE .

CHAPTER 14 ¢ One-way analysis of covariance (ANCOVA) RRY

KaRaNLIK



gender, male

118 ~4
o) o)
116
£
3
c
&
=
NETTE o o
o
a
8 o
=}
-
»
c 112 - o]
w
°
” o
w
110 -4 [o] ¢}
o]
103 -4
T T T T T T
E) 54 8 10 12 14

years of selling experience

gendsy: fernale

120
o
118 -
o
g
3
£ 1104 o o
~
T
[
o
S 1144 o
(=]
-
B
£
g1z o o o
K-
"
o

110 o
1084 ©

I H t H i I 1

4 5 8 10 12 14 16

years of selling experience

Both of these scatterplots indicate a linear relationship between the dependent variable
(sales) and the covariate (years) for each group (male and female). In addition, it
appears that the slope of the regression line is similar across groups. Therefore, you
can confidently proceed with an analysis of covariance. Remember to turn the Split
File... option off before conducting the ANCOVA. You do this by selecting the Data
menu, clicking on Split File... to open the Split File dialogue box and selecting the
Analyse all cases, do not create groups radio button. Click on OK. The split file
option is now oft and you’re ready to continue.

WSPSS: Analysis without Anguish

KaRaNLIK




[S=

To conduct an analysis of covariance

Select the Analyze menu.

Click on General Linear Model and then Univariate... to open the Univariate
dialogue box.

Select the dependent variable (i.e. sales) and click on the ] button to move the
variable into the Dependent Variable: box.

Select the independent variable (i.e. gender), and click on the [¥] button to move
the variable into the Fixed Factor(s): box.

Select the covariate (i.e. years) and click on the ] button to move the variable
into the Covariate(s): box.

. Dependent Variable: Model... ;
13&} sales in $1200 per ann
) Contrasts... !
Fixed Factoris:
@ gender [gendar] Plots... i

Random Factor{s):
i) Save... ;
Options... i

Covariate{sy:

WLS Weight:

QK 4 Paste i Resetg Cancel] Help l

Click on the Options... command pushbutton to open the Univariate: Options
sub-dialogue box.

In the Display box click on the Descriptive statistics, Estimates of effect size,
Observed power and Homogeneity tests check boxes.

Option

-Estimated Marginal Means
Factorfs) and Factor Interactions:

Display Means for:

OVERALL
gender

Display
¥ Descriptive statistics

¥ Estimates of effect size
¥ Observed power

[ Parameter estimates

[ Contrast coefficient matrix

v Homogenetty tests

™ Spread vs. level plot

[ FResidual plot

[~ Lackof ft

[~ Geners! estimable function

Signficance level: ]35 Corfidence intervals are 95%

Conﬁnuei Cancel l Help l
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8 Click on Continue and then OK.

UNIANOVA
salesBY genderWITH years
/METHOD = SSTYPE(3)
/INTERCEPT = INCLUDE
/PRINT = DESCRIPTIVE ETASQ OPOWER HOMOGENEITY
/CRITERIA = ALPHA(.05)
/DESIGN = years gender .

Descriptive Statistics

Dependent Variable: sales in $1000 per annum

gender Mean Std. Deviation N

male 112.55 2.734 11
female 113.36 3.325 11
Total 112.95 3.000 22

Levene’s Test of Equality of Error Variances?
Dependent Variable: sales in $1000 per annum
F df1 df2 Sig.
.022 1 20 .884

Tests the null hypothesis that the error variance of the
dependent variable is equal across groups.
a. Design: Intercept+years+gender

Levene’s test is not significant (p > .5), indicating that the homogeneity of variance
assumption has not been violated.

Tests of Between-Subjects Effects

Dependent Variable: sales in $1000 per annum

Type Il Sum Mean Partial Eta Noncent. Observed
Source of Squares df Square F Sig. Squared Parameter Power?
Corrected Model 106.353° 2 53.176 12.232 .000 563 24.463 .088
Intercept 31745.528 1 31745.528 7302.092 .000 997 7302.092 1.000
years 102.671 1 102.671 23.616 .000 .554 23.616 .996
gender 116 1 116 .027 .872 : .001 .027 .053
Error 82.602 19 4.347
Total 280881.000 22
Corrected Total 188.955 21

a. Computed using alpha = .05
b. R squared = .560 (adjusted R squared = .517)

The output indicates no main effect (p > .05) for gender; but a significant relationship
exists between sales and years of experience, F(1,19) = 23.616, p < .05. So it can be
said that when you statistically control for years of experience, gender has no influence
on the amount of sales made per year. The sales manager’s hunch that sales success is
related to years of selling experience is also confirmed.

If you had obtained a significant F-ratio for gender, and if you had more than two
levels of the independent variable, then you would have had to tease out the source of
the significance. Planned and post-hoc comparisons could be used to achieve this.
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Practice example

Ninety-six male and female second-year psychology students participated in a peer-
tutoring program designed to reduce computer anxiety. Of these students, 47 volun-
teered to act as peer tutors in first-year research methods computing workshops, while
49 preferred not to be tutors. Computer anxiety for all potential tutors was measured
before the beginning of the course and then on completion. Given the data in
Pracl4.sav, your tasks are to:

1 Determine whether the reduction in computer anxiety is the same for males and
females.
2 Determine whether the reduction in computer anxiety is the same for those who

acted as tutors and those who did not.

Solutions

Syntax

EXAMINE

VARIABLES=anxiety1 anxiety2 BY gender tutors
/PLOT BOXPLOT

/COMPARE GROUP

/STATISTICS DESCRIPTIVES

/CINTERVAL 95

/MISSING LISTWISE

/NOTOTAL.

SORT CASES BY gender tutors .

SPLIT FILE

SEPARATE BY gender tutors .

GRAPH

/SCATTERPLOT(BIVAR)=anxiety2 WITH anxiety1
/MISSING=LISTWISE .

SPLIT FILE

OFF.

UNIANOVA

anxiety2 BY gender WITH anxiety1

/METHOD = SSTYPE(3)

/INTERCEPT = INCLUDE

/PRINT = DESCRIPTIVE ETASQ OPOWER HOMOGENEITY
/CRITERIA = ALPHA(.05)

/DESIGN = anxiety1 gender .

UNIANOVA

anxiety2 BY tutors WITH anxiety1

/METHOD = SSTYPE(3)

/INTERCEPT = INCLUDE

/PRINT = DESCRIPTIVE ETASQ OPOWER HOMOGENEITY
/CRITERIA = ALPHA(.05)

/DESIGN = anxiety1 tutors .
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Output

Assumption testing

Normality
Descriptives
GENDER Statistic Std. Error
ANXIETYA1 female Mean 47.49 2.019
95% Confidence Lower Bound 43.41
Interval for Mean Upper Bound 51.56
5% Trimmed Mean 47.37
Median 45.00
Variance 175.256
Std. Deviation 13.24
Minimum 17
Maximum 76
Range 59
Interquartile Range 16.00
Skewness 375 .361
Kurtosis .169 .709
male Mean 36.47 1.643
95% Confidence Lower Bound 33.14
Interval for Mean Upper Bound 39.80
5% Trimmed Mean 36.58
Median 35.50
Variance 102.634
Std. Deviation 10.13
Minimum 18
Maximum 53
Range 35
Interquartile Range 16.25
Skewness -.124 383
Kurtosis -.906 750
ANXIETY2 female Mean 41.70 1.769
95% Confidence Lower Bound 38.13
Interval for Mean Upper Bound 45.27
5% Trimmed Mean 41.29
Median 41.00
Variance 134.549
Std. Deviation 11.60
Minimum 20
Maximum 73
Range 53
Interquartile Range 19.00
Skewness 466 .361
Kurtosis -.015 .709
male Mean 33.53 1.943
95% Confidence Lower Bound 29.59
Interval for Mean Upper Bound 37.46
5% Trimmed Mean 32.88
Median 30.50
Variance 143.499
Std. Deviation 11.98
Minimum 17
Maximum 64
Range 47
Interquartile Range 18.75
Skewness .860 .383
Kurtosis -.164 750
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Descriptives

willing to act Statistic Std. Error
as tutor
ANXIETY1 yes Mean 39.33 2.258

95% Confidence Lower Bound 34.76

Interval for Mean Upper Bound 43.89

5% Trimmed Mean 38.72

Median 38.50

Variance 204.020

Std. Deviation 14.28

Minimum 17

Maximum 74

Range 57

Interquartile Range 20.75

Skewness .438 374

Kurtosis -.168 733
no Mean 45.24 1.735

95% Confidence Lower Bound 41.74

Interval for Mean Upper Bound 48.75

5% Trimmed Mean 44.39

Median 44

Variance 123.489

Std. Deviation 11.11

Minimum 28

Maximum 76

Range 48

Interquartile Range 13.50

Skewness 1.094 .369

Kurtosis 1.264 724

ANXIETY2 yes Mean 35.90 2.010

95% Confidence Lower Bound 31.83

interval for Mean Upper Bound 39.97

5% Trimmed Mean 35.28

Median 34.50

Variance 161.682

Std. Deviation 12.72

Minimum 17

Maximum 73

Range 56

Interquartile Range 21.00

Skewness .659 .374

Kurtosis 241 733
no Mean 39.78 1.864

95% Confidence Lower Bound 36.01

Interval for Mean Upper Bound 43.55

5% Trimmed Mean 39.26

Median 39.00

Variance 142.426

Std. Deviation 11.93

Minimum 24

Maximum 65

Range 41

Interquartile Range 20.50

Skewness 469 .369

Kurtosis -.902 724

Skewness and kurtosis statistics indicate that the distributions of anxietyl and anxiety2
are relatively normal across both gender and tutor groups.
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The scatterplots indicate a reasonable level of linearity between the dependent variable
(anxiety2) and the covariate (anxietyl) for both pairs of groups. In relation to the
homogeneity of regression slopes assumption, it appears that the slopes of each plot
are also similar across groups.
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Levene’s Test of Equality of Error Variances?
Dependent Variable: anxiety?2
F df1 df2 Sig.
1.412 1 79 .238

Tests the null hypothesis that the error variance of the
dependent variable is equal across groups.
a. Design: Intercept+anxiety1+gender

Levene’s test shows that the assumption of homogeneity of variance has not been violated.

Tests of Between-Subjects Effects
Dependent Variable: anxiety2

Type Il Sum Mean Partial Eta Noncent. Observed
Source of Squares df Square F Sig. Squared Parameter Power?
Corrected Model 5250.664° 2 2625.332 29.018 .000 427 58.036 1.000
Intercept 958.990 1 958.990 10.600 .002 120 10.600 .895
anxiety1 3903.702 1 3903.702 43.148 .000 .356 43.148 1.000
gender 45.390 1 45.390 .502 .481 .006 .502 .108
Error 7056.842 | 78 90.472
Total 128437.000 | 81
Corrected Total 12307.506 80

a. Computed using alpha = .05
b. R squared = .427 (adjusted R squared = .412)

The main effect for the ANCOVA is not significant and therefore, we can conclude that
when pretest anxiety is statistically controlled, no differences exist between males and

females. That is, the reduction in computer anxiety is the same for men and women —
F(1,78) = .502, p > .05.

Once again in relation to the next research question, the assumptions have not been
violated.

Levene’s Test of Equality of Error Variances®
Dependent Variable: anxiety2
F dft df2 Sig.
.788 1 79 377

Tests the null hypothesis that the error variance of the
dependent variable is equal across groups.
a. Design: Intercept+anxiety1+tutors

Tests of Between-Subjects Effects
Dependent Variable: anxiety2

Type Il Sum Mean Partial Eta Noncent. Observed
Source of Squares df Square F Sig. Squared Parameter Power?
Corrected Model 5206.303° 2 2603.151 28.593 .000 423 57.186 1.000
Intercept 917.842 1 917.842 10.082 .002 14 10.082 .880
anxiety1 4901.421 1 4901.421 53.837 .000 .408 53.837 1.000
tutors 1.029 1 1.029 011 916 .000 011 .051
Error 7101.203 78 91.041
Total 128437.000 | 81
Corrected Total 12307.506 80

a. Computed using alpha = .05
b. R squared = .423 (adjusted R squared = .408)

Again, this ANCOVA reveals no significant main effect. That is, the reduction in com-
puter anxiety is the same for those who acted as tutors and those who did not.
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Reliability analysis

There are a number of different reliability coefficients. One of the most commonly used
is Cronbach’s alpha, which is based on the average correlation of items within a test if
the items are standardised. If the items are not standardised, it is based on the average
covariance among the items. Because Cronbach’s alpha can be interpreted as a corre-
lation coefficient, it ranges in value from O to 1. SPSS output also provides a standardised
itemn alpha that is the value that would be obtained if all the items were standardised.
Items usually possess comparable variances so there is little difference between these
two alphas.

In addition to Cronbach’s alpha, SPSS allows us to compute several other reliability
models:

* Split-half reliability
* Guttman

* Parallel

e Strictly parallel.

However, discussion in this chapter is limited to Cronbach’s alpha.

Working example

One-hundred-and-five members of the community completed a ten-item attitudes-to-
help-seeking instrument. You wish to determine the internal consistency of this scale
using Cronbach’s alpha. Item 5 was negatively worded and was recoded before analysis.

The data file can be found in Work15.sav on the website that accompanies this title and
is shown in the following figure.
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To conduct a reliability analysis

1 Select the Analyze menu.

2 Click on Scale and then Reliability Analysis... to open the Reliability Analysis
dialogue box.

3 Select the variables you require (i.e. As/ to hs/0) and click on the [*] button to
move the variables into the Items: box.

4 Ensure that Alpha is displayed in the Model: dropdown list.

Model: ] Hpha - I
[T Listitem labels Statistics... [

5 Click on the Statistics... command pushbutton to open the Reliability Analysis:
Statistics sub-dialogue box.

m SPSS: Analysis without Anguish
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6 In the Descriptives for box, select the Scale and Scale if item deleted check
boxes.

7 In the Inter-Item box, select the Correlations check box.

Reliability Analysis: Statistics
Descrip!ives Qe r WAty - -
I~ ttem ¥ Comelations C I y
¥ Scale g ™ Covarances -—fffi——‘[
WV Scalz f tem deleted § Help l
- Summan&s s s s o f AAhJOﬁJ;‘\ Tab[e JET—
[~ Means ‘ & None
[~ Varances o Flest
[~ Covadances " Friedman chisquare
[~ Comelations i ™ Cochran chi-square
™ Hotelling’s T-square I™ Tukey's test of addtivity
T Intraclass comelation coefficient

8 Click on Continue and OK.

RELIABILITY
/VARIABLES=hs1 hs2 hs3 hs4 hs5 hs6 hs7 hs8 hs3 hs10
/FORMAT=NOLABELS
/SCALE(ALPHA)=ALL/MODEL=ALPHA
/STATISTICS=SCALE CORR
/SUMMARY=TOTAL .

Reliability Statistics

Cronbach’s
Alpha Based on
Cronbach’s Standardised
Alpha ltems N of items
.768 792 10
Inter-Item Correlation matrix

hs1 hs2 hs3 hs4 hs5 hs6 hs7 hs8 hs9 hs10
hs1 1.000 297 552 454 542 .355 179 .380 .538 .148
hs2 297 1.000 449 .087 .376 .225 101 .013 107 199
hs3 552 449 1.000 297 541 377 287 418 .445 .238
hs4 454 .087 297 1.000 274 242 197 .323 271 .027
hs5 542 376 541 274 1.000 314 .288 .266 442 313
hs6 .355 225 377 242 314 1.000 170 157 .331 143
hs7 179 101 .287 197 .288 170 1.000 .063 .200 -.057
hs8 .390 .013 418 .323 .266 157 .063 1.000 .385 278
hs9 .538 107 445 271 442 .331 .200 .385 1.000 167
hs10 .148 199 .238 .027 313 143 -.057 278 167 1.000

The covariance matrix is calculated and used in the analysis.
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Practice

Item-Total Statistics

Cronbach’s

Scale Mean if Scale Variance if Correct ltem- Squared Multiple Alpha if item

ltem Deleted Item Deleted Total Correlation Correlation Deleted
hs1 17.94 21.862 .648 528 720
hs2 17.39 23.048 .345 301 764
hs3 18.19 22.348 .693 .533 719
hs4 17.72 22.836 .379 .259 758
hs5 17.75 21.977 .646 464 721
hs6 17.86 23.220 425 .209 749
hs7 17.39 25.029 .246 .158 772
hs8 18.45 24.692 415 .339 752
hs9 18.15 24.265 .526 .389 743
hs10 17.44 23.710 .253 .193 781

When you examine the characteristics of a scale you want to look at the individual items,
the overall scale, and the relationship between the individual items and the overall scale.

You could have obtained means and standard deviations for each item by selecting the
Item check box in the Descriptives for box. However, to minimise the output, this
option was not chosen.

In relation to the Item—total Statistics you have a number of important columns:

* Scale Mean if Item Deleted — this column tells us the average score for the scale
if the item were excluded from the scale.

¢ Scale Variance if Item Deleted — this column tells us the scale variance if the item
were eliminated.

» Corrected Item-Total Correlation — this column gives the Pearson correlation
coefficient between the score on the individual item and the sum of the scores on the
remaining items.

* Squared Multiple Correlation — this column gives the result of a multiple
regression equation with the item of interest as the dependent variable and all of the
other items as independent variables.

* Cronbach’s Alpha if Item Deleted — this column gives the alpha coefficient that
would result if the item were removed from the scale.

An examination of the items comprising the attitudes to help-seeking scale indicates
that items 7 and 10 have the lowest corrected item—total correlations. The Cronbach’s
alpha for the overall scale is equal to .768. If these two items were removed from the
scale, the Alpha if Item Deleted column shows that overall reliability would increase
slightly. When you remove these items and recalculate the reliability coefficient, Cron-
bach’s alpha is raised to .7845. Therefore, deletion of these items may be considered
appropriate.

example

A researcher wished to determine the reliability of four independent personality scales
— namely, hope, optimism, locus of control and self-esteem. The hope and optimism
scales consisted of eight items each, the locus of control scale consisted of nine items
and the self-esteem scale consisted of ten items. A five-point Likert scale response
format was used for each of these scales. Items 1, 3, 4 and 7 of the optimism scale and
items 3, 5, 8, 9 and 10 of the self-esteem scale were negatively worded. Three hundred
and sixty-three people responded to each of the four scales, but not all scales were
fully completed. Given the data in Pracl5.sav, your tasks are to:

1 Determine the Cronbach’s alpha coefficient for each scale.

2 Make recommendations about the inclusion or exclusion of items.
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Solutions
Syntax

RELIABILITY
/VARIABLES=hope1 hope2 hope3 hope4 hope5 hope6 hope7 hope8
/FORMAT=NOLABELS
/SCALE(ALPHA)=ALL/MODEL=ALPHA
/STATISTICS=SCALE
/SUMMARY=TOTAL .

RELIABILITY
/VARIABLES=loc1 loc2 loc3 loc4 loc5 loc6 loc7 loc8 loc9
/FORMAT=NOLABELS
/SCALE(ALPHA)=ALL/MODEL=ALPHA
/STATISTICS=SCALE
/SUMMARY=TOTAL .

RECODE
optt opt3 opt4 opt7 se3 se5 se8 sed sell

EXECUTE .

RELIABILITY
/VARIABLES=se1 se2 se3 se4 se5 seb se7 se8 se9 sel10
/FORMAT=NOLABELS
/SCALE(ALPHA)=ALL/MODEL=ALPHA
/STATISTICS=SCALE
/SUMMARY=TOTAL .

RELIABILITY
/VARIABLES=0pt1 opt2 opt3 opt4 opt5 opt6 opt7 opt8
/FORMAT=NOLABELS
/SCALE(ALPHA)=ALL/MODEL=ALPHA
/STATISTICS=SCALE
/SUMMARY=TOTAL .

(1=5) (2=4) (4=2) (5=1)

Output
Hope
Reliability Statistics
Cronbach’s
Alpha Based on
Cronbach’s Standardised
Alpha ltems N of items
749 751 8

The Cronbach’s alpha coefficient for the hope scale is .75.

Item-Total Statistics

Cronbach'’s

Scale Mean if Scale Variance if Correct ltem- Squared Multiple Alpha if ltem

ltem Deleted item Deleted Total Correlation Correlation Deleted
hope1 25.51 13.315 499 .333 712
hope2 25.25 13.549 .429 274 726
hope3 25.30 13.474 493 .264 714
hope4 25.56 13.929 445 .225 723
hope5 25.55 13.168 527 .342 707
hope6 25.36 14.258 .303 142 751
hope7 25.45 13.997 .397 215 732
hope8 25.61 13.627 475 311 717

Inspection of the Alpha if Item Deleted column reveals that deletion of item 6 would
increase reliability marginally.
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Locus of Control

Reliability Statistics

Cronbach’s
Alpha Based on
Cronbach’s Standardised
Alpha ltems N of items
718 716 9

The reliability coefficient for the locus of control scale is .718.

Item-Total Statistics

Cronbach’s

Scale Mean if | Scale Variance if Correct ltem- Squared Multiple Alpha if ltem

Item Deleted ltem Deleted Total Correlation Correlation Deleted
loc1 21.07 21.967 .267 165 714
loc2 21.11 20.668 .301 A71 713
loc3 21.49 19.013 543 .339 .664
loc4 21.32 19.513 512 .397 .671
locs 21.12 19.563 514 .320 671
loc6 20.35 19.836 489 321 676
loc7 21.97 21.993 217 .097 .725
loc8 20.83 19.718 .488 374 .676
loc9 21.84 22.526 .213 077 722

If item 7 were deleted, and the reliability analysis re-run, then the

would increase fractionally to .725.

alpha coefficient

Having removed this item you would then reassess the new output to determine
whether any further items, such as item 9, should also be removed.

Self-Esteem
Reliability Statistics
Cronbach’s
Alpha Based on
Cronbach’s Standardised
Alpha ltems N of items
.872 .881 10

The Cronbach’s alpha coefficient for the self-esteem scale is .872.

Item-Total Statistics

Cronbach’s

Scale Mean if Scale Variance if Correct ltem- Squared Multiple Alpha if ltem

ltem Deieted ltem Deleted Total Correlation Correlation Deleted
sel 32.57 37.380 .687 590 .854
se2 32.58 39.362 5655 .460 .864
se3 32.39 36.036 717 .540 .851
sed 32.76 39.461 475 .298 .868
se5 32.63 36.892 574 .363 .861
seb 32.96 35.858 762 622 .848
se7 33.11 36.006 676 .556 .853
se8 33.58 36.464 515 .365 .867
se9 33.44 35.224 .562 .381 .864
sel0 33.30 35.481 .535 .387 .867

An examination of the item-total statistics indicates that no removal of items would
enhance this reliability measure. This is to be expected for such a well-established scale.

SPSS: Analysis without Anguish

KaRaNLIK



Optimism

Reliability Statistics

Cronbach’s
Alpha Based on
Cronbach’s Standardised
Alpha ltems N of items
777 777 8

The Cronbach’s alpha coefficient for the optimism scale is .777.

ltem-Total Statistics

Cronbach’s

Scale Mean if Scale Variance if Correct ltem- Squared Multiple Alpha if ltem

item Deleted ltem Deleted Total Correlation Correlation Deleted
opt1 25.09 19.434 .350 .140 776
opt2 24.31 18.382 513 .345 747
opt3 24.67 18.395 572 .386 738
opt4 24.55 18.124 518 319 746
opt5 24.35 18.266 .581 399 736
opté 24.31 18.942 .508 315 .749
opt7 24.53 20.937 .263 137 785
opt8 24.47 18.199 .542 .342 742

An examination of the item-total statistics indicates that the removal of item 7 would
increase the alpha coefficient only marginally to .785.
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16

Factor analysis

Factor analysis is a data reduction technique used to reduce a large number of vari-
ables to a smaller set of underlying factors that summarise the essential information
contained in the variables. More frequently, factor analysis is used as an exploratory
technique when the researcher wishes to summarise the structure of a set of variables.
However, for testing a theory about the structure of a particular domain, confirmatory
factor analysis is appropriate.

When the researcher’s goal is to construct a reliable test, factor analysis is an
additional means of determining whether items are tapping into the same construct.

The Factor menu in SPSS allows seven methods of factor extraction:
* Principal components (PC)

* Unweighted least squares

* Generalised least squares

¢ Maximum likelihood

 Principal axis factoring (PAF)

* Alpha factoring

* Image factoring.

The most frequently used of these methods are PC and PAF; and there is much debate
in the literature over which method is the most appropriate. This chapter demonstrates

only PAF.

A number of steps comprise a factor analytic procedure:

1 Computation of the correlation matrix — to determine the appropriateness of
the factor analytic model.

2 Factor extraction — to determine the number of factors necessary to represent
the data.

3 Rotation — to make the factor structure more interpretable. Rotation may be

orthogonal (factors are uncorrelated with one another) or oblique (factors are
correlated). The choice of rotation is both empirically and theoretically driven.
The criteria for making this selection can be found in any good multivariate
statistics text.

Assumption testing

There are a number of assumptions and practical considerations underlying the appli-
cation of PAF and PC.

1 Sample size — a minimum of five subjects per variable is required for factor
analysis. A sample of 100 subjects is acceptable, but sample sizes of 200+ are
preferable.
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Normality — factor analysis is robust to assumptions of normality. However, if
variables are normally distributed, then the solution is enhanced.

Linearity — because factor analysis is based on correlation, linearity is impor-
tant. If linearity is not present, the solution may be degraded.

Outliers among cases — factor analysis is sensitive to outlying cases. These
cases need to be identified and either removed from the data set or brought into
the distribution by transformation or recode options.

Multicollinearity and singularity — this assumption is not relevant for PC.
However, in the case of PAF, singularity and multicollinearity can be identified
if any of the squared multiple correlations are near or equal to 1. If this is the
case, the inclusion of the offending variables needs to be reconsidered.

Factorability of the correlation matrix — a correlation matrix that is appro-
priate for factor analysis will have several sizeable correlations. Inspect the matrix
for correlations in excess of .3 and, if none are found, reconsider the use of PAF.
The anti-image correlation matrix is used to assess the sampling adequacy of each
variable. The measures of sampling adequacy are displayed on the diagonal of
the anti-image correlation matrix. Variables with a measure of sampling accuracy
that falls below the acceptable level of .5 should be excluded from the analysis.
Bartlett’s test of sphericity and the Kaiser-Meyer-Olkin measure of sampling
adequacy are both tests that can be used to determine the factorability of the
matrix as a whole. If Bartlett’s test of sphericity is large and significant, and if
the Kaiser-Meyer-Olkin measure is greater than .6, then factorability is assumed.

Outliers among variables — a variable with a low squared multiple correlation
with all other variables, and low correlations with all important factors, is an out-
lier among the variables. These outliers may need to be deleted from the analysis.

Working example

Three hundred and eighty-eight participants responded to a survey regarding organ
donation. They completed a 16-item scale that was designed to measure attitudes

toward organ donation. The researcher wished to determine the underlying factor
structure of this scale and decided to conduct a PAF analysis.

A sample size of 388 for a 16-item scale more than meets the desired cases-to-
variables ratio for PAF. Furthermore, you are assuming that assumptions of normality
and linearity have been satisfied before analysis. No outlying cases were detected. The
remainder of the assumptions will be examined as they occur in the output.

The data file can be found in Workl6.sav on your data disk and is shown in the
following figure.
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B  To conduct a principal axis factor analysis

1 Select the Analyze menu.

2 Click on Data Reduction and then on Factor... to open the Factor Analysis
dialogue box.

3 Select the variables you require (i.e. art to attl6) and click on the [ button to
move the variables into the Variables: box.

Variables:
B attl A . ’
®ati2 aste }
(#> att3 Reset ;
A atte

B atté Help t
@D a7

AR

Selection Vanable:

Descriptives... Extraction... I Rotation... ! Scores... Options...

4  Click on the Descriptives... command pushbutton to open the Factor Analysis:
Descriptives sub-dialogue box.

5 In the Statistics box, ensure that the Initial solution check box has been
selected.

6 In the Correlation Matrix box, select the Coefficients, KMO and Bartlett’s
test of sphericity and Anti-image check boxes.

i St aﬁsﬂcs ,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, ‘
™ Univariate descriptives
¥ Initial sofution

Continue

Cancel

Help

dill

~Comelation Matrix

¥ Coefficients ™ inverse
[™ Signficancelevels I Reproduced
I~ Deteminant ¥ Antiimage

¥ KMO and Bartlett’s test of sphericity

Click on Continue.

Click on the Extraction... command pushbutton to open the Factor Analysis:
Extraction sub-dialogue box.

9  From the Method: drop-down menu, select Principal axis factoring.
10 Ensure the Correlation matrix radio button is selected in the Analyze box.

11 In the Extract box, ensure that the Eigenvalues over: radio button has been
selected and that [ is displayed in the box.
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12

In the Display box, ensure that the Unrotated factor solution and Scree plot
check boxes are selected.

Method:  |F Continue |
'"'fhnat)'ze 1 Display | Cancel ‘
{% Comelation matrix ¥ Unrotated factor solution

Help

;

" Cavarniance matrix

, ¥ Scree plot

-Extract

¥ Eigenvalues over: ]1
" Number of factors: l

Maximum Kerations for Convergence: 25

13 Click on Continue.

14  Click on the Reotation... command pushbutton to open the Factor Analysis:
Rotation sub-dialogue box.

15 In the Method box, select the Varimax radio button.

16

In the Display box, ensure that the Rotated solution check box has been
selected.

acto

alysis: Rota

+~ Method o | Continue
 Mone T Quartimax ; o
% Varimax ¢ Equamax

1™ Direct Oblimin " Promax

i

T T

-Display
¥ Rotated solution | Loading plotis)

tdaximum Kerations for Convergence: 28
g

Click on the Options... command pushbutton to open the Factor Analysis:

17  Click on Continue.
18

Options sub-dialogue box.
19

In the Coefficient Display Format box, select the Sorted by size and
Suppress absolute values less than: check boxes. With the latter check box
you are then prompted to enter the appropriate value you require, which is
usually .3. You will also notice that in the previous sub-dialogue box you have
the option of replacing missing values with the mean of each of the items. This
procedure is useful when you have an incomplete data set. By default, missing
cases are deleted listwise, meaning that the whole case is excluded from the
analysis.
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(i

Factor Ana!ysws. '(H)pttons

~ Missing Values Continue |
& Exclude cases listwise e

| _Cerd |
; Cancel
T Exclude cases painvise §

" Replace with mean Help

- Coefficient Display Format
[V Sorted by size
¥ Suppress abselute values less than: ;'3

20 Click on Continue and then OK.

You will be aware that there are many more options available within factor analysis.
However, only the basic commands required will be addressed in this chapter. For
example, a number of other rotation options were given in the Rotation sub-dialogue
box. These included Equamax, Quartimax, Direct Oblimin and Promax. Similarly,
the option to save factor loadings as variables is available in the Scores sub-dialogue
box.

FACTOR
/VARIABLES att1 att2 att3 att4 att5 atté att7 att8 att9 att10 att11 att12
att13 att14 att15 att16/MISSING LISTWISE /ANALYSIS att1 att2 att3 att4
atts att6 att7 att8 att9 att10 att11 att12 att13 att14 att15 att16
/PRINT INITIAL CORRELATION KMO AIC EXTRACTION ROTATION
/FORMAT SORT BLANK(.3)
/PLOT EIGEN
/CRITERIA MINEIGEN(1) ITERATE(25)
/EXTRACTION PAF
/CRITERIA ITERATE(25)
/ROTATION VARIMAX
/METHOD=CORRELATION .

An examination of the correlation matrix (see page 159) indicates that a considerable
number of correlations exceed .3 and so the matrix is suitable for factoring.

KMO and Bartlett’s Test

Kaiser-Meyer-Olkin Measure of Sampling Adequacy. 914
Bartlett’s Test of Sphericity Approx. Chi-Square 2491.010
df 120
Sig. .000

You can see that the Bartlett test of sphericity is significant and that the Kaiser-Meyer-
Olkin measure of sampling adequacy is far greater than .6.

Measures of sampling adequacy are printed on the diagonal. Inspection of the anti-
image correlation matrix reveals that all our measures of sampling adequacy are well
above the acceptable level of .5.
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The table below displays the communality of the items and you will notice that ATTS
has the lowest communality.

Communalities

Initial Extraction
att1 .601 617
att2 634 .606
att3 .353 526
att4 .481 514
atts 430 .645
atté .395 .360
att7 .281 278
att8 .183 164
att9 518 .598
att10 .353 .308
att11 .509 576
att12 .289 274
att13 .263 .320
att14 499 .550
att15 .368 .356
att16 .638 682

Extraction Method: Principal Axis Factoring

Total Variance Explained

Initial Eigenvalues Extraction Sums of Squared Loadings | Rotation Sums of Squared Loadings
Factor | Total |% of Variance| Cumulative % | Total |% of Variance| Cumulative % | Total |% of Variance| Cumulative %
1 6.452 40.324 40.324 5.95 37.243 37.243 | 3.346 20.915 20.915
2 1.340 8.373 48.697 9 5.206 42.449 | 2.150 13.438 34.353
3 1.062 6.639 55.336 .833 3.637 46.086 | 1.877 11.733 46.086
4 .951 5.942 61.278 .582
5 .841 5.2563 66.531
6 .756 4.727 71.257
7 .656 4.101 75.359
8 .643 4.017 79.376
9 577 3.608 82.985
10 .528 3.298 86.283
11 499 3.118 89.401
12 .421 2.633 92.033
13 .389 2.431 94.464
14 .348 2.176 96.640
15 .302 1.889 98.529
16 235 1.471 100.000

Extraction Method: Principal Axis Factoring.

The table above displays the total variance explained at three stages. At the initial
stage, it shows the factors and their associated eigenvalues, the percentage of variance
explained and the cumulative percentages. In reference to the eigenvalues, you would
expect three factors to be extracted because they have eigenvalues greater than 1. If
three factors were extracted, then 46 per cent of the variance would be explained.

The following scree plot graphically displays the eigenvalues for each factor and sug-
gests that there is one predominant factor.
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The factor matrix is a matrix of loadings or correlations between the variables and
factors. Pure variables have loadings of .3 or greater on only one factor. Complex vari-
ables may have high loadings on more than one factor, and they make interpretation of
the output difficult. Rotation may therefore be necessary.

Factor Matrix®

Factor

1 2 3
att16 797
att2 778
att1 725 -.301
att14 .702
att9 .696 -.324
att4 688
att11 643 -.333
att15 .581
att6 .569 .
atts .562 -.401 410
att10 526
att12 522
att7 519
att3 487 441 .308
att13 412 345
att8 352

Extraction Method: Principal Axis Factoring.
a. Three factors extracted. 18 iterations required.
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Rotated Factor Matrix?

Factor
1 2 3

att9 732

att16 710 .359

att1 567 525
att2 555 .391 .382
att10 498

atté 464 .366

att15 .462 344

att7 424

att8 .370

att12 .361

att3 709

att13 545

att14 470 544

att4 403 527

atts 770
att11 341 .655

Extraction Method: Principal Axis Factoring.
Rotation Method: Varimax with Kaiser Normalisation.
a. Rotation converged in six iterations.

Varimax rotation, where the factor axes are kept at right angles to each other, is most
frequently chosen. Ordinarily, rotation reduces the number of complex variables and
improves interpretation. However, in the example, the rotated solution still includes
several complex variables. Factor 1 comprises ten items with factor loadings ranging
from .36 to .73. Factor 2 comprises four items with factor loadings ranging from .53 to
.71. Factor 3 comprises two items with loadings of .65 and .77. Some items have dual
or triple loadings greater than .3 on more than one factor. These items must be
interpreted with caution because simple structure is not apparent.

Factor Transformation Matrix

Factor 1 2 3

1 717 515 470
2 - 113 751 -.650
3 -.688 412 597

Extraction Method: Principal Axis Factoring.
Rotation Method: Varimax with Kaiser Normalisation.

It is not surprising that this ambiguous structure has been obtained from varimax/
orthogonal rotation. Items 1-16 were designed to measure a single construct and
therefore it is expected that the factors extracted would be highly correlated. In this
instance an oblique rotation (direct oblimin) would have been a more appropriate
choice.

FACTOR
/VARIABLES att1 att2 att3 att4 att5 att6 att7 att8 att9 att10 att11 att12
att13 att14 att15 att16/MISSING LISTWISE /ANALYSIS att1 att2 att3 att4
atts atté att7 att8 att9 att10 att11 att12 att13 att14 att15 att16
/PRINT INITIAL CORRELATION KMO AIC EXTRACTION ROTATION
/FORMAT SORT BLANK(.3)
/PLOT EIGEN
/CRITERIA MINEIGEN(1) ITERATE(25)
/EXTRACTION PAF
/CRITERIA ITERATE(25) DELTA(Q)
/ROTATION OBLIMIN
/METHOD=CORRELATION.
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Pattern Matrix®

Factor
1 2 3

att9 .837

att16 767

att10 552

att1 511 410
att2 .506

atté 494

att15 A77

att14 445 409

att7 419

att8 409

att12 318

att3 724

att13 .535

att4 .329 .408

atts .836
att11 .640

Extraction Method: Principal Axis Factoring.
Rotation Method: Oblimin with Kaiser Normalisation.
a. Rotation converged in nine iterations.

Structure Matrix

Factor
1 2 3

att16 .818 .483 468
attg 767 .418
att2 734 .506 .581
att1 707 .681
att14 648 624 392
att4 607 .606 455
att15 571 424 .333
att6 564 441

att10 .554 .307
att7 515 .388
att12 487 .339 403
att8 .388

att3 .336 722

att13 313 .563

atts 420 .800
att11 .551 745

Extraction Method: Principal Axis Factoring.
Rotation Method: Oblimin with Kaiser Normalisation.

Factor Correlation Matrix

Factor 1 2 3

1 1.000 473 579
2 473 1.000 .289
3 579 .289 1.000

Extraction Method: Principal Axis Factoring.
Rotation Method: Oblimin with Kaiser Normalisation.

The oblique rotation provides a far more interpretable solution than that of the varimax
rotation. Two matrices are produced: a pattern matrix and a structure matrix. The dif-
ference between high and low loadings is more apparent in the pattern matrix, so this
matrix is interpreted. The loadings in the pattern matrix represent the unique relationship
between the factor and the variable. As illustrated in the output, the pattern matrix has
fewer complex variables and simpler structure. The factor correlation matrix indicates
the relationship between factors. All factors appear moderately related.
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The final step in factor analysis involves determining how many factors to interpret
and then assigning a label to these factors. The number of factors to be interpreted
largely depends on the underlying purpose of the analysis. In the present study, the
purpose was to confirm the factor structure of a scale. In other instances, factor
analysis may be used to summarise the data set.

From the output you can see that a single factor solution may be more appropriate in
this analysis. You will remember from examining the Total Variances explained table
(earlier in the output) that factor 1 had an eigenvalue of 5.96, whereas factors 2 and 3
had eigenvalues below 1.000 (.833 and .582 respectively).

The scree plot also confirmed the dominance of a single factor represented by 11 items.

Examination of the items indicates that these items represent a conceptually distinct
aspect of attitudes to organ donation that can be labelled ‘altruistic issues’. A final step
would be to determine Cronbach’s alpha coefficient of internal consistency to ensure
that the items comprising factor 1 produce a reliable scale. Reliability and factor
analysis are complimentary procedures in scale construction and definition.

Practice example

% You will be familiar with this data set because it was used in Chapter 15 to work
through Reliability Analysis.

A researcher wished to determine the factor structure of four independent personality
scales — namely, hope, optimism, locus of control and self-esteem. The hope and opti-
mism scales consisted of eight items each, the locus of control scale consisted of nine
items and the self-esteem scale consisted of ten items. A five-point Likert scale response
format was used for each of these scales. Items 1, 3, 4 and 7 of the optimism scale and
items 3, 5, 8, 9 and 10 of the self-esteem scale were negatively worded. Three hundred
and sixty-three people responded to each of the four scales, but not all scales were com-
pleted fully. Given the data in Prac16.sav, your tasks are to:

1 Determine the factor structure of each of the four scales independently.
2 Make recommendations regarding the inclusion and exclusion of items from each
scale.
Solutions

Given the size of the output, please note that the syntax and output below has been dis-
played for the hope scale only.

Syntax

00 00000000000000000000000000000000000000000000000000000000r0000000000000000000000000000000000000000¢

DESCRIPTIVES
VARIABLES=hope1 hope2 hope3 hoped hope5 hopet hope7 hope8
/STATISTICS=MEAN STDDEV KURTOSIS SKEWNESS .
FACTOR
/VARIABLES hope1 hope2 hope3 hope4 hope5 hope6 hope7 hope8 /MISSING LISTWISE
ANALYSIS hope1 hope2 hope3 hope4 hope5 hopeb
hope7 hope8
/PRINT INITIAL CORRELATION KMO AIC EXTRACTION ROTATION
/FORMAT SORT BLANK(.3)
/PLOT EIGEN
/CRITERIA MINEIGEN(1) ITERATE(25)
/EXTRACTION PAF
/CRITERIA ITERATE(25)
/ROTATION VARIMAX
/METHOD=CORRELATION .
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Output

Assumption testing
The 363 subjects are well within the required sample size for each scale.

Descriptive Statistics

N Mean Std. Skewness Kurtosis

Statistic Statistic Statistic Statistic | Std. Error | Statistic | Std. Error
hope1 363 3.56 .869 -.454 128 .049 255
hope2 363 3.83 .907 -.766 128 322 255
hope3d 362 3.78 .845 -.621 128 .484 .256
hope4 362 3.51 .806 -.428 128 -.281 256
hope5 362 3.53 875 -472 128 .183 .256
hope6 362 3.72 .928 -.694 128 .188 .256
hope7 360 3.63 .847 -.741 129 736 .256
hope8 362 3.47 .839 -.696 .128 278 .256
Valid N (listwise) 360

An examination of the skewness and kurtosis statistics indicates that all items on the
hope scale are reasonably normally distributed. You will note that several items have
missing cases. Due to the number of boxplots required to identify outliers among
cases, this output has been excluded. However, the testing of this assumption should
not ordinarily be omitted.

The output for the hope scale is given below. In the Factor Analysis: Options dia-
logue box, we selected the Replace with Mean radio button because we noted earlier
that there were missing cases. This function replaces all missing data with the mean
for that variable and thus increases the sample size for analysis.

Correlation Matrix

hope1 hope2 hope3d hoped hope5 hope6 hope7 hope8

Correlation hope1 1.000 474 .381 .393 271 162 194 251
hope2 474 1.000 .361 295 226 134 184 .182

hope3 .381 .361 1.000 307 .276 175 .304 .298

hope4 .393 .295 .307 1.000 .306 178 .185 252

hope5 271 .226 .276 .306 1.000 .363 .318 467

hope6 162 134 175 178 .363 1.000 .146 .184

hope7 194 184 .304 185 318 146 1.000 404

hope8 .251 .182 .298 252 467 184 .404 1.000

KMO and Bartlett’s Test

Kaiser-Meyer-Olkin Measure of Sampling Adequacy. 798
Bartlett's Test of Sphericity Approx. Chi-Square 542.236
df 28
Sig. .000

The Bartlett test of sphericity is significant and the Kaiser-Meyer-Olkin measure of
sampling adequacy is greater than .6. Therefore, it is appropriate to proceed with factor
analysis. Measures of sampling adequacy are printed on the diagonal in the correlation
matrix overleaf. Because all these values are above the acceptable level of .5, there is
further evidence of the factorability of the items.
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Anti-image Matrices

hope1 hope2 hope3 hope4 hope5 hope6 hope7 hope8
Anti-lImage Covariance hope1 .667 -.238 -118 -.164 -.033 -.020 -.001 -.043
hope2 -.238 726 -.133 -.063 -.033 -.009 -.028 .015
hope3 -.118 -.133 .736 -.084 -.026 -.040 -121 -.071
hope4 -.164 -.063 -.084 775 -.093 -.036 -.008 -.043
hope5 -.033 -.033 -.026 -.093 .658 -213 -.080 -.220
hope6 -.020 -.009 -.040 -.036 -.213 .858 -.011 .007
hope7 -.001 -.028 -121 -.008 -.080 -.011 .785 -197
hope8 -.043 .015 -.071 -.043 -.220 .007 -.197 .689
Anti-lmage Correlation hope1 7802 -.342 -.169 -.228 -.049 -.026 -.002 -.064
hope2 -.342 7822 -.182 -.084 -.047 -.012 -.038 .021
hope3 -.169 -.182 .853% - 111 -.037 -.051 -.160 -.100
hope4 -.228 -.084 =111 .8562 -.130 -.044 -.010 -.060
hope5 -.049 -.047 -.037 -.130 7702 -.283 -112 -.327
hope6 -.026 -.012 -.051 -.044 -.283 7742 -.013 .009
hope7 -.002 -.038 -.160 -.010 - 112 -.013 8132 -.267
hope8 -.064 -.021 -.100 -.060 -.327 -.009 -.267 7728
a. Measures of Sampling Adequacy(MSA)
Communalities
Initial Extraction
hope1 .333 .542
hope?2 274 412
hope3 .264 .334
hope4 225 282
hope5 .342 .502
hope6 142 .143
hope7 .215 .264
hope8 311 .451

Extraction Method: Principal Axis Factoring.

Total Variance Explained

Initial Eigenvalues Extraction Sums of Squared Loadings | Rotation Sums of Squared Loadings
Factor | Total |% of Variance| Cumulative % | Total |% of Variance| Cumulative % | Total |% of Variance| Cumulative %
1 2.949 36.867 36.867 2.345 29.314 29.314 1.472 18.399 18.399
2 1.160 14.501 51.369 .585 7.313 36.627 1.458 18.229 36.627
3 929 11.608 62.977
4 .735 9.183 72.159
5 .647 8.082 80.241
6 597 7.462 87.704
7 513 6.412 94.115
8 471 5.885 100.000

Extraction Method: Principal Axis Factoring.

Examination of the initial statistics reveals that two factors will be extracted. The final
statistics outline that these two factors account for 37 per cent of the variance. It does
appear that factor | is predominant with an eigenvalue of 2.34. The scree plot (not dis-
played) also suggests that a one-factor solution is most appropriate.
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Factor 1 comprises items 5, 8, 7 and 6, while factor 2 is made up of items 1, 2, 3 and
4. Item 3 is a complex variable with dual loadings on both factors. The inclusion of
this item is at the discretion of the analyst.

Factor Matrix?®

Factor
1 2
hope1 .630 -.381
hope5 .626 .332
hope8 .582 .336
hope3 .568
hope2 536 -.352
hope4 517
hope7 468
hope6 .349

Extraction Method: Principal Axis Factoring.
a. Two factors extracted. 11 iterations required.

Rotated Factor Matrix®

Factor
1 2
hope5 678
hope8 .650
hope7 .482
hope6 .349
hope1 714
hope2 .628
hope3 .326 478
hope4 449

Extraction Method: Principal Axis Factoring.
Rotation Method: Varimax with Kaiser Normalisation.

a. Rotation converged in six iterations.

The factor transformation matrix indicates a relatively high correlation between factors
| and 2, and again suggests that an oblique rotation may have been more appropriate.

Factor Transformation Matrix

Factor 1 2
1 710 704
2 704 -710

Extraction Method: Principal Axis Factoring.
Rotation Method: Varimax with Kaiser Normalisation.

Given that you did so well on this practice example, now repeat the procedure for each
of the other scales — optimism, locus of control and self-esteem. Before you do,
remember that items 1, 3, 4 and 7 of the optimism scale and items 3, 5, 8, 9 and 10 of
the self-esteem scale were negatively worded and will require recoding.
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Multiple regression

Multiple regression is an extension of bivariate correlation. The result of regression is
an equation that represents the best prediction of a dependent variable from several
independent variables. Regression analysis is used when independent variables are cor-
related with one another and with the dependent variable. Independent variables can be
either continuous or categorical. However, in the latter case these variables must be
coded as dummy variables. In contrast, the dependent variable must be measured on a
continuous scale. If the dependent variable is not continuous, then discriminant func-
tion analysis is appropriate.

There are three major regression models — namely, standard or simultaneous
regression, hierarchical regression and stepwise regression. These models differ in two
ways: first, in the treatment of overlapping variability due to correlation of the inde-
pendent variables, and second, in terms of the order of entry of the independent vari-
ables into the equation.

In the standard or simultaneous model, all independent variables enter the regression
equation at once because you want to examine the relationship between the whole set
of predictors and the dependent variable. In hierarchical multiple regression, you deter-
mine the order of entry of the independent variables based on theoretical knowledge.

In stepwise regression, the number of independent variables entered and the order of
entry are determined by statistical criteria generated by the stepwise procedure.
Method of entry can be forward, backward or a combination of both. Forward selec-
tion involves the entry of predictors one at a time. The order of entry and whether the
predictor is eventually accepted are decided on the basis of whether the F-test exceeds
a certain critical value (FIN) and whether a critical alpha level (PIN) is met. Backward
selection starts with all the variables in the equation and gradually deletes poor per-
formers on the basis of whether the partial F-value is less than a critical value (FOUT).
The default criterion (POUT) must also be met. Stepwise selection is a combination of
the forward and backward procedures. It allows for the later removal of variables that
were previously entered.

The choice of technique largely depends on the researcher’s goals.
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Assumption testing

A number of assumptions underpin the use of regression:

%

Workin

e

1

Ratio of cases to independent variables — the number of cases needed depends
on the type of regression model to be used. For standard or hierarchical
regression you should ideally have twenty times more cases than predictors,
whereas even more cases are required for stepwise regression.

The minimum requirement is to have at least five times more cases than inde-
pendent variables.

Outliers — extreme cases have considerable impact on the regression solution
and should be deleted or modified to reduce their influence. Univariate outliers
can be detected during data screening as described in chapter 3. Multivariate
outliers can be detected using statistical methods such as Mahalanobis distance
(see chapter 18) and graphical methods such as residual scatterplots.

The decision to remove outliers from the data set must be made with care
because their deletion often results in the generation of further outlying cases.

Multicollinearity and singularity — multicollinearity refers to high corre-
lations among the independent variables, whereas singularity occurs when per-
fect correlations among independent variables exist. These problems affect
how you interpret any relationships between the predictors (IVs) and the
dependent variable, and they can be detected by examining the correlation
matrix, squared multiple correlations and tolerances. Most computer programs
have default values for multicollinearity and will not admit variables that are a
problem.

Normality, linearity, homoscedasticity and independence of residuals — an
examination of residual scatterplots allows us to test the above assumptions. It
is assumed that the differences between the obtained and predicted dependent
variable scores are normally distributed. Furthermore, it is assumed that the
residuals have a linear relationship with the predicted dependent variable scores,
and that the variance of the residuals is the same for all predicted scores. Mild
deviations from linearity are not serious. Moderate to extreme deviations may
lead to a serious underestimation of a relationship.

Assumption 1 relates to research design. Assumptions 2, 3 and 4 are assessed through
regression analysis.

g example

A marketing manager of a large supermarket chain wanted to determine the effect of
shelf space and price on the sales of pet food. A random sample of 15 equal-sized
shops was selected, and the sales, shelf space in square metres and price per kilogram
were recorded.

To demonstrate the application of the three regression models you will use the same
data set to ask three questions:

1

What contribution do both shelf space and price make to the prediction of sales
of pet food?

Which is the best predictor of sales of pet food?

Previous research has suggested that shelf space is the salient predictor of sales
of pet food. Is this hypothesis correct?

The data file can be found in Work17.sav on the website that accompanies this title and
is shown in the following figure.
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1 To conduct a standard {simultaneous) regression analysis

Select the Analyze menu.

2 Click on Regression and then on Linear... to open the Linear Regression
dialogue box.

3 Select the dependent variable (i.e. sales of pet food) and click on the ] button to
move the variable into the Dependent: box.

4  Select the independent variables (i.e. space and price) and click on the P button
to move the variables into the Independent(s): box.

5 In the Method: drop-down list, ensure that Enter is selected.

' Linear Regression”

> price _ Dependent:

@ space | @ sales of pet food [eales " 1
aste
~ Block 1 of
Criiens Nest Reset
Independentis): Cancel 1
#prce Help
#® space ~—-J

Method:

Selection Vanable:

B
Case Labels:
WLS Weight:
Statis(ics“.l Plats... i Save... Cptions...
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Click on the Statistics... command pushbutton to open the Linear Regression:
Statistics sub-dialogue box and ensure the Estimates and Model fit check
boxes are selected. In the Residuals box, select the Casewise diagnostics check
box. Ensure the QOutliers outside radio button has been selected. The default
value of three standard deviations is most frequently used.

Linear egression: Statistics

™ Collinsarity diagnostics

~ Residuals
[~ Dubin‘atson
[V Casewise disgnostics
& QOutliers outside: {3’“ standard deviations

" All cases

- Regression Coefficients - v tlodel fi
V Estiimates i I R squared change Cal y
[ Confidence intervals | Descriptivas —J
™ Covarance matrix ™ Part and partial comelations Help I

Click on Continue.

Click on the Plots... command pushbutton to open the Linear Regression:
Plots sub-dialogue box.

9 Select *ZRESID and click on the ] button to move the item into the Y: box.
10 Select *ZPRED and click on the [®] button to move the item into the X: box.
11  In the Standardized Residual Plots box, sclect the Normal probability plot

check box.

%E.inear Regression: Plots
FEET Secatter 1of 1
“ZPRED : MNext c |
“ZRESID ance! i
“DRESID Hel
“ADJPRED elp !
“SRESID
“SDRESID

i~ Standardized Residual Plots T Produce all partial plots

e Histogram
V¥ Momal probability plot

12 Click on Continue.

13

14

Click on the Save... command pushbutton to open the Linear Regression: Save
sub-dialogue box.

In the Distances box, select the Mahalanobis check box.
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- Save to New File
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Continue |
Cancel

Help
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Click on Continue and then OK.

REGRESSION
/MISSING LISTWISE

/NOORIGIN
/DEPENDENT sales

/SAVE MAHAL .

/STATISTICS COEFF OUTS R ANOVA
/CRITERIA=PIN(.05) POUT{(.10)

/METHOD=ENTER space price
/SCATTERPLOT=(*ZRESID ,*ZPRED )
/RESIDUALS NORM(ZRESID)
/CASEWISE PLOT(ZRESID) OUTLIERS(3)

Variables Entered/Removed®

Variables

Model Entered

Variables

Removed Method

1 space, price?

Enter

a. All requested variables entered.
b. Dependent Variable: sales of pet food

Model Summary®

Adjusted R Std. Error of
Model R R Square Square the Estimate
1 .9222 .850 .825 6.05904

a. Predictors: (Constant), space, price
b. Dependent Variable: sales of pet food
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Both independent variables together explain 85 per cent of the variance (R Square) in
sales of pet food, which is highly significant as indicated by the F-value of 34.081
below.

ANOVAP
Model Sum of Squares df Mean Square F Sig.
1 Regression 2502.390 2 1251.195 34.081 .000?
Residual 440.543 12 36.712
Total 2942.933 14

a. Predictors: (Constant), space, price
b. Dependent Variable: sales of pet food

An examination of the T-values indicates that price contributes to the prediction of
sales.

Coefficients?

Unstandardised Standardised
Coefficients Coefficients
Model B Std. Error Beta t Sig.
1 (Constant) 2.029 5.126 .396 699
price 10.500 3.262 916 3.219 .007
space .057 2.613 .006 .022 .983

a. Dependent Variable: sales of pet food

Because no univariate outliers were found, casewise plots were not necessary. If they
had been produced, then these plots would have identified outlying cases with standard
deviations greater than three.

From the scatterplot of residuals against predicted values, you can see that there is no
clear relationship between the residuals and the predicted values, consistent with the
assumption of linearity.

Normal P-P Plot of Regression Standardized Residual

Dependent Variable: sales of pet food
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Scatterplot

Dependent Variable: sales of pet food

Regression Standardized Residual

1 i i T
-1 0 1 2

Regression Standardized Predicted Value

The normal plot of regression standardised residuals for the dependent variable also
indicates a relatively normal distribution.

If you go back to your data file, you will also notice that SPSS has added another new
variable MAH_1 to your data file.

L ]
Fle Edit view Data Transform &nalyze Graphs Utlites vandow Help
SRS B | =k 8l E
17 nies 1 -
 ssles | price | space | maH 1 | s | o] 35 w v Caa 1
1 15 00 3. 100
2 1506 ’ 100
3 2100. 100
S o ey e
5| 3000 T200: 44722
5 3500 200 14322
7 40,00 2000 35021
3] asde 3000 00228
9 300 307 320982
10 : 3460 53626
11 400 78074
12 400! 430611
13 300 547333
= et de S
1 ) 130323

34

v :
 «1v1\Data View {Variable View /

) Chapler, 17 v . ARl SR

4]

3PS5 Processor is ready

yntex: <525, [ Cutpuil - SP5.., f (G Crapter 17 - ...

TP Qe B EMRQ s

An examination of the Mahalanobis distance values indicates that there are no multi-
variate outliers among the independent variables; that is, no values are greater than or
equal to the critical chi-square value of 13.8 at an alpha level of .001.
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Therefore, in answer to research question 1, you can say that price significantly pre-
dicts sales of pet food — F(2,12) = 34.081, p < .05. However, the shelf space allocated
is not a significant predictor.

To conduct o stepwise regression analysis

Select the Analyze menu.

2 Click on Regression and then on Linear... to open the Linear Regression dia-
logue box.
3 Select the dependent variable (i.e. sales) and click on the ] button to move the

variable into the Dependent: box.

4 Select the independent variables (i.e. space and price) and click on the [ button
to move the variables into the Independent(s): box.

5 In the Method: drop-down list, ensure Stepwise is selected.

ear Regression

(@ pice Dependent:
@ space |4 sales of pat food fsales
N 1 P _ Paste '
#> Iahalanabis Distance ~Block 1¢f 1
: & ; Med 2 Reset !
Independentisy: Cancel !
@ price Lo Help l
/vb space

dethod:

Selection Wanable:

[
Case Labels:
|
VULS Weight:
|
Statisiics..,! Plots... % Save, . ; Options... !
6 Click on the Statistics... command pushbutton to open the Linear Regression:

Statistics sub-dialogue box and ensure the Estimates and Model fit check
boxes are selected.

7 Click on Continue and then OK.

REGRESSION

/MISSING LISTWISE

/STATISTICS COEFF OUTS R ANOVA
/CRITERIA=PIN(.05) POUT(.10)
/NOORIGIN

/DEPENDENT sales
/METHOD=STEPWISE price space
/SCATTERPLOT=(*ZRESID ,*ZPRED )
/RESIDUALS NORM(ZRESID)
J/CASEWISE PLOT(ZRESID) OUTLIERS(3)
/SAVE MAHAL .

CHAPTER 17 * Multiple regression

KaRaNLIK



Variables Entered/Removed?

Model

Variables
Entered

Variables
Removed

Method

price

Stepwise
(Criteria:
Probability-of-
F-to-enter
<=.050,
Probability-of-
F-to-remove
>=.100).

a. Dependent Variable: sales of pet food

Model Summary®

Adjusted R Std. Error of
Model R R Square Square the Estimate
1 9228 .850 .839 5.82145
a. Predictors: (Constant), price
b. Dependent Variable: sales of pet food
ANOVAP
Model Sum of Squares df Mean Square F Sig.
1 Regression 2502.373 1 2502.373 73.840 .000?
Residual 440.561 13 33.889
Total 2942.933 14
a. Predictors: (Constant), price
b. Dependent Variable: sales of pet food
Coefficients®
Unstandardised Standardised
Coefficients Coefficients
Model B Std. Error Beta t Sig.
1 (Constant) 1.977 4.373 452 .659
price 10.566 1.230 922 8.593 .000
a. Dependent Variable: sales of pet food
Excluded Variables®
Collinearity
Partial Statistics
Model Beta In t Sig. Correlation | Tolerance
1 space .006 .022 983 .006 154

a. Predictors in the Model: (Constant), price
b. Dependent Variable: sales of pet food

You will notice from the output that only the variable price has been entered into the
regression equation, and this variable explains 85 per cent of the variability in sales of
pet food, F(1,13) = 73.84, p < .05. The second independent variable, shelf space, failed
to meet the selection criteria, as indicated by the nonsignificant t-value (p > .05).

" To conduct a hierarchical regression analysis

Select the Analyze menu.

2 Click on Regression and then on Linear... to open the Linear Regression
dialogue box.

3 Select the dependent variable (i.e. sales) and click on the ®] button to move the
variable into the Dependent: box.

SPSS: Analysis without Anguish
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Tlinear Regression

Select the independent variable you have chosen to enter first (i.e. space) and
click on the ] button to move the variable into the Independent(s): box.

Click on Next.

Select the next independent variable you have chosen to enter (i.e. price) and
click on the ] button to move the variable into the Independent(s): box. You
will notice that the box above in your output reads Block 2 of 2.

< price

B space

< Mabalancbis Distance
G Mahatanobis Distance

Dependeant. oK

s

; @ sales of petfood isales

S—

Paste

~Block 2 of 2

Previous 1

independertisy Carneel

} ag‘)pme Help 3

£

Nes : Reset

i Ertar - I

Wethod:
Selection Variable:

Cagse Labels:

[

LS Viteight:

i

Statistics.ui Plets... [ Save... z Options.”l

Click on the Statistics command pushbutton to open the Linear Regression:
Statistics sub-dialogue box and ensure the Estimates, Model fit and R
squared change check boxes are selected.

Click on Continue and then OK.

REGRESSION
/MISSING LISTWISE
/STATISTICS COEFF QUTS R ANOVA CHANGE
/CRITERIA=PIN(.05) POUT(.10)
/NOORIGIN
/DEPENDENT sales
/METHOD=STEPWISE space/METHOD=ENTER price
/SCATTERPLOT=(*ZRESID ,*ZPRED )

/RESIDUALS NORM(ZRESID)
/CASEWISE PLOT(ZRESID) OUTLIERS(3)
/SAVE MAHAL .

Variables Entered/Removed®

Model

Variables
Entered

Variables
Removed

Method

2

space

price?

Stepwise
(Criteria:
Probability-of-
F-to-enter
<=.050,
Probability-of-
F-to-remove
>=.100).
Enter

a. All requested variables entered.
b. Dependent Variable: sales of pet food
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Model Summary®

Change Statistics

Adjusted R | Std. Errorof | R Square
Model R R Square Square the Estimate Change F Change df1 df2 Sig. F Change
1 .849° 721 .700 7.94653 721 33.604 1 13 .000
2 9220 .850 .825 6.05904 129 10.361 1 12 .007

a. Predictors: (Constant), space
b. Predictors: (Constant), space, price
c. Dependent Variable: sales of pet food

You will notice that shelf space on its own contributes 72 per cent of the variance in
sales of pet food and is a significant predictor. At the second step you will notice from
the R Square Change statistic and the Sig. F Change value that price makes a signifi-
cant unique contribution of 13 per cent to the variance of sales of pet food after shelf
space.

ANOVAS
Model Sum of Squares df Mean Square F Sig.
1 Regression 2122.017 1 2122.017 33.604 .000?
Residual 820.916 13 63.147
Total 2942.933 14
2 Regression 2502.390 2 1251.195 | 34.081 .000°
Residual 440.543 12 36.712
Total 2942933 14

a. Predictors: (Constant), space
b. Predictors: (Constant), space, price
c. Dependent Variable: Sales of pet food

Coefficients?

Unstandardised Standardised
Coefficients Coefficients
Model B Std. Error Beta t Sig.
1 (Constant) 14.405 4.446 3.240 .006
space 7.794 1.344 .849 5.797 .000
2 (Constant) 2.029 5.126 396 .699
space .057 2.613 .006 .022 .983
price 10.500 3.262 916 3.219 .007

a. Dependent Variable: sales of pet food

However, examination of the above table indicates that shelf space is no longer a sig-
nificant predictor when both independent variables are entered into the regression
equation. In other words, these variables must be significantly correlated such that
price subsumes shelf space.

Excluded Variables®

| Collinearity

Partial Statistics

Model Beta In t Sig. Correlation | Tolerance
1 price .916° 3.219 .007 .681 154

a. Predictors in the Model: (Constant), space
b. Dependent Variable: sales of pet food

Therefore, in answer to the third research question, you can say that shelf space on its
own is a salient predictor of sales of pet food, F(1,13) = 33.604, p < .05. However, in
combination with price, its effect is insignificant.
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Practice example

In a study concerning the relationship between the volume of wood provided by a
forest area and various characteristics of the area, an experimental forest containing
mixed soft-wood trees was divided into plots, of which 25 were selected at random.
Measurements were made on each of the plots at the beginning of the study: initial
wood volume, number of trees, average age of trees and average volume of trees. Five
years later at the end of the study, the final wood volume was measured. Given the data
in Prac17.sav, your tasks are to:

1 Assess the data for violation of assumptions.

2 Test the hypothesis indicated by previous forestry research that initial wood
volume is the best predictor of final wood volume, followed by the number of
trees in the plot.

Solutions

Syntax

REGRESSION

/MISSING LISTWISE

/STATISTICS COEFF OUTS R ANOVA
/CRITERIA=PIN{(.05) POUT(.10)
/NOORIGIN

/OEPENDENT finalvol

/METHOD=ENTER initvol /METHOD=ENTER notrees /METHOD=ENTER avage /METHOD=ENTER
volume

/SCATTERPLOT=(*ZRESID ,"ZPRED )
/RESIDUALS NORM(ZRESID)
/CASEWISE PLOT(ZRESID) OUTLIERS(3)
/SAVE MAHAL .

Output

Assumption testing

Having only 25 cases, there is barely the minimum requirement (which is at least five
times more cases than independent variables). However, the analysis can proceed des-
pite this limitation. The remainder of the assumptions can be tested through the
regression analysis that follows,

Variables Entered/Removed®

Variables
Model Variables Entered Removed Method
1 initial wood volume? . Enter
2 number of trees? . Enter
3 average age of trees? . Enter
4 average volume of trees?® . Enter

a. All requested variables entered.
b. Dependent Variable: final wood volume
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Model

Summary®

Change Statistics
Adjusted R | Std. Error of | R Square
Model R R Square Square the Estimate Change F Change dft df2 Sig. F Change
1 .9842 .968 .966 20.702 .968 692.839 1 23
2 .984° 969 .966 20.864 001 645 1 22
3 .986° 973 .969 19.817 .004 3.385 1 21
4 .987¢ .974 .969 19.989 .001 640 1 20

a. Predictors: (Constant), initial wood volume
b. Predictors: (Constant), initial wood volume, number of trees
c. Predictors: (Constant), initial wood volume, number of trees, average age of trees
d. Predictors: (Constant), initial wood volume, number of trees, average age of trees, average volume of

trees

e. Dependent Variable: final wood volume

The independent variable, initial volume, explains 96.8 per cent of the variance in final
wood volume and is highly significant, as indicated by the significant F-value. An
examination of the Model Summary table indicates that no other variable adds to the
predictive power of the equation.

ANOVA®
Model Sum of Squares df Mean Square F Sig.
1 Regression 296935.0 1 296934.970 | 692.839 0002
Residual 9857.270 23 428.577
Total 306792.2 24
2 Regression 297215.9 2 148607.963 | 341.402 .000°
Residual 9576.314 22 435.287
Total 306792.2 24
3 Regression 298545.3 3 99515.089 | 253.404 .000°
Residual 8246.974 21 392.713
Total 306792.2 24
4 Regression 298800.9 4 74700.219 | 186.952 .000¢
Residual 7991.365 20 399.568
Total 306792.2 24
a. Predictors: (Constant), initial wood volume
b. Predictors: (Constant), initial wood volume, number of trees
c¢. Predictors: (Constant), initial wood volume, number of trees, average age of trees
d. Predictors: (Constant), initial wood volume, number of trees, average age of trees, average volume of
trees
e. Dependent Variable: final wood volume

Coefficients?

Unstandardised Standardised
Coefficients Coefficients
Model B Std. Error Beta t Sig.

1 (Constant) 29.441 7.610 3.868 .001
initial wood volume .986 .037 .984 26.322 .000
2 (Constant) 23.994 10.236 2.344 .029
initial wood volume .951 057 949 16.580 .000
number of trees .357 445 .046 .803 430
3 (Constant) 44.817 14.921 3.004 .007
initial wood volume 1.048 .076 1.046 13.844 .000
number of trees 160 436 .021 .367 717
average age of trees -.520 .283 -103 -1.840 .080
4 (Constant) 27.535 26.332 1.046 .308
initial wood volume 946 149 944 6.365 .000
number of trees 725 .832 .093 872 .394
average age of trees -.504 .286 -.100 -1.763 .093
average volume of trees 3.000 3.751 071 .800 433

a. Dependent Variable: final wood volume

m SPSS: Analysis without Anguish
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The beta values in the Coefficients table at step 4 confirm that initial wood volume is
the best predictor of final wood volume. Having obtained this solution, it is necessary
to check that assumptions have not been violated that could modify the interpretation
of the output. No univariate outliers were found, so casewise plots were not necessary.

Normal P-P Plot of Regression Standardized Residual

Dependent Variable: final wood volume
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Regression Standardized Predicted Value

The normal plot of regression standardised residuals for the dependent variable, final
wood volume, indicates a relatively normal distribution. From the scatterplot of
residuals against predicted values it can be seen that there is no clear relationship con-
sistent with the assumption of linearity.
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The Mahalanobis distance values are displayed in the data file as a new variable. No
distance is greater than the critical value of chi-square at an alpha level of .001 (that is,
18.47), so there are no multivariate outliers. The critical value for chi-square is
obtained from a statistics text.

Having confirmed that no assumptions have been violated, it can be concluded that the
above interpretation is sound and that initial volume is the best predictor of final wood
volume, F (1,23) = 692.839, p < .05, as indicated by previous research.
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Multiple analysis of variance
(MANOVA)

The extension of univariate analysis of variance to the involvement of multiple
dependent variables is termed multivariate analysis of variance (MANOVA). The
hypotheses tested with MANOVA are similar to those tested with ANOVA except that
sets of means replace the individual means specified in ANOVA. In a one-way
MANOVA design, for example, the hypothesis tested is that the populations from
which the samples are selected have the same means for all dependent variables.

The MANOVA command also allows you to perform a stepdown analysis if you have
theoretical reasons for ordering your dependent variables. The ordering of these
dependent variables can be tested using prior dependent variables as covariates. The
choice between univariate and stepdown F may be difficult. When there is little corre-
lation among the dependent variables, univariate F is acceptable. However, when
dependent variables are highly correlated, stepdown F is preferable.

Bartlett’s test of sphericity may help you decide whether stepdown analysis is appro-
priate. If Bartlett’s test is significant at an alpha level of .05, this indicates that the
dependent variables are related and thus MANOVA with stepdown analysis should be
conducted. If Bartlett’s test is not significant, this indicates that the dependent variables
are unrelated and that univariate ANOVAs, with adjustment for familywise error,
would be more appropriate.

CHAPTER 18 ¢ Multiple analysis of variance (MANOVA)
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Assump

fion testing

A number of assumptions underpin the use of MANOVA:

1 Cell sizes — it is necessary to have more subjects in each cell than the number
of dependent variables. When cell size is greater than 30, assumptions of nor-
mality and equal variances are of little concern. If cell sizes are small and une-
qual, then assumption testing becomes more critical. Although equal cell size is
ideal, it is not essential. However, ratios of smallest to largest size greater than
1:1.5 may cause problems.

2 Univariate and multivariate normality — MANOVA is sensitive to violations
of univariate and multivariate normality. To test for univariate normality, the
techniques described in chapter 3 can be used for each group or level of the
independent variable using the Split File option. Multivariate outliers which
influence normality can be identified using Mahalanobis distance in the Regres-
sion sub-menu. Mahalanobis distance is evaluated as chi-square with degrees of
freedom equal to the number of dependent variables. The critical chi-square
levels can be found in any critical values of chi-square table. An alpha level of
.001 is recommended.

3 Linearity — linear relationships among all pairs of dependent variables must
be assumed. Within-cell scatterplots must be conducted to test this assumption.

4 Homogeneity of regression — this assumption is related to stepdown analysis
and must be tested if stepdown analysis is required. It is assumed that the
relationship between covariates and dependent variables in one group is the
same as the relationship in other groups.

5 Homogeneity of variance—covariance matrices — this assumption is similar
to the assumption of homogeneity of variance for individual dependent vari-
ables. In multivariate designs, this assumption is more complex. At the univar-
iate level, Cochrans C and Bartlett-Box F tests can be used. If these tests are not
significant (p > .05), then homogeneity of variance is assumed. Multivariate
homogeneity of the variance—covariance matrices is tested using Box’s M test,
which must also be nonsignificant (p > .001). This test is very sensitive so the
alpha level of .001 is recommended.

6 Multicollinearity and singularity — when correlations among dependent vari-
ables are high, problems of multicollinearity and singularity exist. When the
determinant of the within-cell correlation matrix is near zero (< .0001) or when
the log (determinant) is less than —9.21034, singularity or multicollinearity may
be present.

Working example

A social scientist wished to compare those respondents who had lodged an organ
donor card with those who had not. Three-hundred-and-eighty-eight new drivers com-
pleted a questionnaire that measured their attitudes towards organ donation, their feel-
ings about organ donation and their previous exposure to the issue. It was hypothesised
that individuals who agreed to be donors would have more positive attitudes towards
organ donation, more positive feelings towards organ donation and greater previous
exposure to the issue. Therefore, the independent variable was whether a donor card
had been signed, and the dependent variables were attitudes towards organ donation,
feelings towards organ donation and previous exposure to organ donation. Attitudes
and feelings were measured on traditional scales with a Likert scale response format.
Exposure was measured in terms of media exposure and personal experience. Concep-
tually and theoretically these dependent variables were believed to be related and thus
MANOVA was the analysis of choice.

o
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The data file can be found in Work18.sav on the website that accompanies this title and
is shown in the following figure.
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1 Cell sizes — equality of cell size is often regulated by the type of design
chosen. When using experimental designs, for example, the researcher is able to
assign a set number of subjects to each condition. However, in quasiexperi-
mental designs, equal n across cells is outside of the researcher’s control. In this
research example, cell sizes were approximately equal.

2 (a) Univariate normality — the data for each dependent measure by group
were screened using the Explore option described in chapter 3. Assump-
tions of univariate normality were not violated.

(b) Multivariate outliers — these were assessed using Mahalanobis distance in
o the Regression sub-menu. This is achieved by using the identification
number in the data file as the dependent variable, in a simultaneous

regression model, with all other variables as independent variables.

To detect multivariate outliers

. 1 Select the Analyze menu.
2 Click on Regression and then Linear... to open the Linear Regression dia-
logue box.
B 3 Select the dependent variable (i.e. id) and click on the ] button to move the

variable into the Dependent: box.

4 Select the independent variables (i.e. attitude, exposure, feelings) and click on
the ] button to move the variables into the Independent(s): box.

CHAPTER 18 ¢ Multiple analysis of variance (MANOVA) RES

KaRaNLIK



inear Regression

@ signed donor card idor
@ exposure to donation is

@ feelings towards organ

@ atttude towards 0980 - Block 1 of 1

Dependent:

[

OK

il

Paste

Method: l Erter v I

Fesst

Cancel

elife

Help

Selection Variable:

Case Labels:

WLS Weight:

]

Statistics.“‘ Plots... I Save... i Optionsu.;

5 Click on the Save... command pushbutton to open the Linear Regression: Save

sub-dialogue box.

6 In the Distances box, select the Mahalanobis check box.

Predicted Values ————
™ Unstandardized

™ Standardized

I~ Adjusted

[ 5.E. of mean predictions

DIFBNERS “rrerwisonmiminmr i
V' Mahalanobis
I Cook’s

™ Leverage values

Prediction Intervals
I~ Mean [ Individual
Corfidence interval:

“Residuals ,,,,,,,,,,,,,,,,,,,,,,,,,,,,,
[~ Unstandardized

[~ Standardized

[ Studentized

[ Deleted

| Studertized deleted

~influence Statistics ——-——-

[~ DiBetats}

[ Standardized DfBetals)
I Dt

[T Standardized DfFt

™ Covarance retio

Save ta New File

I~ Coefficient statistics:

-Export mode! irformation to XML file

!

Browse f

Cancel !
Help l

7 Click on Continue and then OK.
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REGRESSION
/MISSING LISTWISE
/STATISTICS COEFF OUTS R ANOVA
/CRITERIA=PIN(.05) POUT(.10)
/NOORIGIN
/DEPENDENT id
/METHOD=ENTER exposure attitude feelings
/SAVE MAHAL .

You will notice that these distances have been added to your data file.

File Edit Yiew Data Transform - snalyze Graphs. Utdites Window Help

s e R e e AL g
id . dorer o [ attitude | feelings | MARTT T v [ war var ar
1 T 1 2 75 38 62753 !
2 2 1 6 84 33 249957
3 3 1 6 87 35 43864
4 4 i SR 32 2T
5 3 1 6 113 FUL 152535
€ [ i 10 163 22 96074
7 7 1 60 113 17 1289937
i+ : : 2 s S
9| E] i 30 (R Y 185845
0] 10 1 3 143 25 186724
1" 1 i 1 48 43 385664
= e ; g B T dasm
13 13 1 & 87 29 1217
= o . : e Rl e
15 % q 10 2%
16 16 i 3 (3 3 27581 ;
17 17 1 20 EL 23 93768 ,
3 i 4 5 ot I |
19 19 1 5 69 2 112387
20 20 1 5 g1 40 153944
21 21 1 10 &2 43 606765
- > : g e 2O
23 23 i 23 45 20 154124
24 24 1 2 . 50 o
= % e " T
2% 26 i 12 6 23 58608
27 27 1 13 112 21 1.38701
23 28 1 [ 57 31 54504
= o i : & S T
) 1 et R
[T\ Oata view AVaraseview /00 T el |
§§Pss Progessor i ready H

184 ouwnts-Sei 18] cropter 18- | 03 SP5S verson. L 8 Ghapter 16w T

The critical value of chi-square, for three dependent variables, at an alpha level of .001
is 16.2. Using this value you have seven outlying cases, which is not unexpected in a
sample size of 388. Consequently, these outliers were retained in the data set. If a large
number of outlying cases were identified, then their inclusion would need to be con-
sidered carefully.

3 Linearity — linearity among dependent measures was confirmed using scatter-
plots among pairs of dependent variables across groups.

4 Homogeneity of regression — this assumption is tested using the general factorial
ANOVA model sub-menu, and it involves a fairly arduous process of modifying
syntax files. Because you have no theoretical grounds for ordering the dependent
variables, stepdown analysis will not be carried out in this example.

Assumptions 5 and 6 will be tested in the MANOVA analysis.

CHAPTER 18 ¢ Multiple analysis of variance (MANOVA) Rt

KaRaNLIK



To conduct a MANOVA

Select the Analyze menu.

Click on General Linear Model and then Multivariate... to open the Multi-
variate dialogue box.

Select the dependent variables (i.e. attitudes, feelings, exposure) and click on
the ] button to move the variables into the Dependent Variables: box.

Select the independent variable(s) (i.e. donor) and click on the ] button to
move the variable into the Fixed Factor(s): box.

Bid

@ Mahalanobis Distance

Dependent Vanables: Mode...
\f} attitude towards orgif_:j

@ feelings towards ord...

@ exposure to denatidy
s o P e

Contrasts...

’ Plots...
Fixed Factor(s):
s Post Hoc...

Save...

Qptions...

dididl;

Cavarigte(s):

N WLS Weight:
g}

QK 1 Paste 1 Rese‘l‘ Cancei‘ Help l

Click on the Model... command pushbutton to open the Multivariate: Model
sub-dialogue box.

In the Specify Model box, ensure the Full factorial radio button is selected and
Type I11 is selected from the Sum of squares: drop-down list. The full factorial
model contains all main effects, covariate main effects and all factor-by-factor
interactions, but does not contain covariate interactions. Type III is the default
and the most commonly used method of calculating sum of squares for balanced/
unbalanced models with no missing cells.

& Rl factonal

7~ Custom

st

ety Bodgh

T T s

Sum of squares:

' Include intercept in model

Conlinue l Cancel Help l

[Type -]
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Click on Continue.

8  Click on the Options... command pushbutton to open the Multivariate Options
sub-dialogue box.

9 In the Estimated Marginal Means box, under the heading Factor(s) and
Factor Interactions:, click on the independent variable (i.e. donor) and click
on the ] button to move the variable into the Display Means for: box.

10  In the Display box, select the Descriptive statistics and the Homogeneity tests
check boxes.

~ Estimated Marginal Means
Factor{s) and Factor Interactions: Display Means for:

{OVERALL;

donor

jdonice

[~ Compare main effects

~ Display

¥ Descriptive statistics I~ Transformation matsix

[~ Estimates of effect size [V Homogenetty lests

I~ Observed power I~ Spread vs. level plats

[~ Parameter estimates I~ Residual plots

I~ SSCP matrices I~ Lack of fit test

I~ Residual SSCP matrix I General estimable function
Significance level: 1.05 Corfidence intervals are S5%

]Continuel Cancel l Help l

11 Click on Continue and then OK.

GLM
attitude feelings exposure BY donor
/METHOD = SSTYPE(3)
/INTERCEPT = INCLUDE
/EMMEANS = TABLES(donor)
/PRINT = DESCRIPTIVE HOMOGENEITY
/CRITERIA = ALPHA(.05)
/DESIGN = donor .

Box's Test of Equality of Covariance Matrices®

Box's M 19.260
F 3.182
df1 6
df2 1018790
Sig. .004

Tests the null hypothesis that the observed covariance
matrices of the dependent variables are equal across groups.
a. Design: Intercept+donor

Box’s M tests the homogeneity of the variance—covariance matrices. You have homo-
geneity of variance because this test is not significant at an alpha level of .001.
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The univariate tests for homogeneity of variance for each of the dependent measures
indicate that homogeneity of variance has not been violated for exposure to organ
donation issues and feelings towards organ donation. However, for attitude towards
organ donation, the Levene’s test of equality of error variances is significant. If the uni-
variate F-test for this variable is also significant, then you must interpret this finding at
a more conservative alpha level.

Levene’s Test of Equality of Error Variances®

F df1 df2 Sig.
attitude towards organ donation 15.346 1 375 .000
feelings towards organ donation 1.284 1 375 .258
exposure to donation issues 2.936 1 375 .087

Tests the null hypothesis that the error variance of the dependent variable is equal across groups.
a. design: Intercept+donor

The multivariate tests of significance test whether there are significant group differ-
ences on a linear combination of the dependent variables. You will notice there are a
number of multivariate statistics available. Pillai’s Trace criterion is considered to have
acceptable power and to be the most robust statistic against violations of assumptions.
Having obtained a significant multivariate effect for donor — that is, a significance of
F < .05 — you can now interpret the univariate/between-subject effects given below.

Multivariate Tests®

Effect Value F Hypothesis df Error df Sig.

Intercept  Pillai’s Trace .935 1790.688% 3.000 373.000 .000
Wilks’ Lambda .065 1790.688% 3.000 373.000 .000
Hotelling’s Trace 14.402 1790.688° 3.000 373.000 .000
Roy’s Largest Root | 14.402 1790.688° 3.000 373.000 .000

donor Pillai’s Trace .033 4.255% 3.000 373.000 .006
Wilks' Lambda .967 4.255% 3.000 373.000 .006
Hotelling’s Trace .034 4.255% 3.000 373.000 .006
Roy’s Largest Root .034 4.255% 3.000 373.000 .006

a. Exact statistic
b. Design: Intercept+donor

An examination of the univariate F-tests for each dependent variable indicates which
individual dependent variables contribute to the significant multivariate effect. It is
advisable to evaluate these effects using a Bonferroni-type adjustment. Adjusting for
familywise or experimentwise error decreases the chance of type I error. The simple
formula that may be applied is: alpha / number of tests. In this example the adjusted
alpha is equal to .017 (0.05/3). Using this alpha level, you have a significant univariate
main effect for feelings towards organ donation (p < .017).
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Tests of Between-Subject Effects

Type Il Sum
Source Dependent Variable of Squares df Mean Square F Sig.
Corrected Model  attitude towards organ donation 12372.705% 1 12372.705 3.960 .047
feelings towards organ donation 922.187° 1 922.187 11.100 .001
exposure to donation issues 903.925° 1 903.925 3.830 .051
Intercept attitude towards organ donation 3105144.376 1 3105144.376 983.910 .000
feelings towards organ donation 331042.346 1 331042.346 3984.772 .000
exposure to donation issues 39489.506 1 39489.506 167.331 .000
donor attitude towards organ donation 12372.705 1 12372.705 3.960 .047
feelings towards organ donation 922.187 1 922.187 11.100 .001
exposure to donation issues 903.925 1 903.925 3.830 .051
Error attitude towards organ donation 1171563.820 | 375 3124.170
feelings towards organ donation 31153.824 | 375 83.077
exposure to donation issues 88498.590 | 375 235.996
Total attitude towards organ donation 4288063.000 | 377

363028.000 | 377
128924.000 | 377

feelings towards organ donation
exposure to donation issues

Corrected Total

1183936.525 | 376
32076.011 | 376
89402.515 | 376

attitude towards organ donation
feelings towards organ donation
exposure to donation issues

a. R Squared = .010 (Adjusted R Squared = .008)
b. R Squared = .029 (Adjusted R Squared = .026)
c. R Squared = .010 (Adjusted R Squared = .007)

Therefore, you can conclude that a person’s decision to act as a donor is significantly
influenced by their feelings towards organ donation, F(1,375) = 11.100, p < .017. No
significant main effects were found for the other dependent measures (exposure to or
attitude towards organ donation).

An examination of the estimated marginal means for feelings towards organ donation
and the variable donor indicates that those individuals who had signed a donor card
had more positive feelings towards organ donation than those individuals who had not
signed a donor card.

signed donor card

95% Confidence Interval
Dependent Variable signed donor card Mean Std. Error Lower Bound Upper Bound
attitude towards organ donation yes 85.026 4.066 77.032 93.021
no 96.484 4.077 88.468 104.500
feelings towards organ donation yes 28.069 663 26.765 29.372
no 31.197 .665 29.890 32.504
exposure to donation issues yes 11.783 1.117 9.586 13.980
no 8.686 1.120 6.483 10.889

When independent variables involve more than two levels, further analytic compari-
sons are needed to find out which levels are significantly different on the individual
dependent variable. These comparisons can be planned (when you have prior reason
for anticipating specific or planned differences) or post hoc (when you have no prior
reason for anticipating differences but wish to explore the data further).

More than one independent variable and the presence of an interaction effect compli-
cate the process of making comparisons and are beyond the scope of this chapter.
However, the new general linear model procedure does allow you to perform contrasts
using the Contrasts... and Post Hoc... command pushbuttons in the General Factorial
dialogue box.
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It is important to remember that MANOVA is an intricate analysis and is more
straightforward when there is only one independent variable and only a few dependent
variables. As the number of independent and dependent variables increase, the analysis
becomes more complex. When the dependent variables are measured on the same
scale, a special form of MANOVA (referred to as profile analysis) is more appropriate.

Practice example

Three hundred and sixty-four male and female subjects completed a personality inven-
tory comprising a self-esteem, optimism and hope scale. The researcher is aware that
these sub-scales are highly correlated. Given the data in Pracl8.sav, your tasks are to:

1 Check for violations of assumptions.

2 Determine whether gender differences exist across the combination of scales.

Solutions

Syntax

EXAMINE
VARIABLES=hope esteem optimism BY gender
/PLOT BOXPLOT STEMLEAF
/COMPARE GROUP
/STATISTICS DESCRIPTIVES EXTREME
/CINTERVAL 95
/MISSING LISTWISE
/NOTOTAL.

COMPUTE id = $casenum.

REGRESSION
/MISSING LISTWISE
/STATISTICS COEFF OUTS R ANOVA
/CRITERIA=PIN(.05) POUT(.10)
/NOORIGIN
/DEPENDENT id
/METHOD=ENTER esteem hope optimism
/SAVE MAHAL.

GRAPH
/SCATTERPLOT(BIVAR)=hope WITH esteem
/MISSING=LISTWISE.

GRAPH
/SCATTERPLOT(BIVAR)=hope WITH optimism
/MISSING=LISTWISE.

GRAPH
/SCATTERPLOT(BIVAR)=esteem WITH optimism
/MISSING=LISTWISE.

CORRELATIONS
/VARIABLES=esteem hope optimism
/PRINT=TWOTAIL NOS!G
/MISSING=PAIRWISE.

GLM
esteem hope optimism BY gender
/METHOD = SSTYPE(3)
/INTERCEPT = INCLUDE
/EMMEANS = TABLES(gender)
/PRINT = DESCRIPTIVE HOMOGENEITY
/CRITERIA = ALPHA(.05)
/DESIGN = gender.
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Output

The data for each dependent measure by group (gender) were screened using the

Explore option and by selecting the Qutliers check box.

An examination of the skewness and kurtosis statistics indicated that the distributions
across groups were relatively normal. You will notice that the Qutliers option provides
a list of cases that may be extreme in the upper and lower boundaries of the distri-
bution. Due to the size of the current sample a few outlying cases would be expected,
and because the skewness and kurtosis statistics are normal, there is no need to bring
outliers into the distribution.

Descriptives

gender Statistic Std. Error
hope female Mean 29.5598 .29039
95% Confidence Lower Bound 28.9868
Interval for Mean Upper Bound 30.1327
5% Trimmed Mean 29.5966
Median 30.0000
Variance 15.516
Std. Deviation 3.93898
Minimum 17.00
Maximum 39.00
Range 22.00
Interquartile Range 5.00
Skewness -.213 179
Kurtosis -.161 .356
male Mean 28.6444 32067
95% Confidence Lower Bound 28.0117
Interval for Mean Upper Bound 29.2772
5% Trimmed Mean 28.7593
Median 29.0000
Variance 18.510
Std. Deviation 4.30230
Minimum 14.00
Maximum 40.00
Range 26.00
Interquartile Range 6.00
Skewness -.450 .181
Kurtosis 397 .360
esteem female Mean 31.6467 .21580
95% Confidence Lower Bound 31.2210
Interval for Mean Upper Bound 32.0725
5% Trimmed Mean 31.6316
Median 32.0000
Variance 8.569
Std. Deviation 2.92720
Minimum 22.00
Maximum 39.00
Range 17.00
interquartile Range 3.00
Skewness -.028 179
Kurtosis .360 .356
(continued)
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Descriptives (continued)

gender Statistic Std. Error
male Mean 31.0500 .23888
95% Confidence Lower Bound 30.5786
Interva! for Mean Upper Bound 31.5214
5% Trimmed Mean 30.9753
Median 31.0000
Variance 10.271
Std. Deviation 3.20488
Minimum 24.00
Maximum 41.00
Range 17.00
Interquartile Range 4.00
Skewness .332 181
Kurtosis -.060 .360
optimism female Mean 25.4728 .19738
95% Confidence Lower Bound 25.0834
Interval for Mean Upper Bound 25.8623
5% Trimmed Mean 25.4698
Median 25.0000
Variance 7.169
Std. Deviation 2.67743
Minimum 18.00
Maximum 33.00
Range 15.00
Interquartile Range 3.00
Skewness .004 179
Kurtosis 273 .356
male Mean 25.3722 .24092
95% Confidence Lower Bound 24.8968
Interval for Mean Upper Bound 25.8476
5% Trimmed Mean 25.3704
Median 25.0000
Variance 10.447
Std. Deviation 3.23222
Minimum 17.00
Maximum 35.00
Range 18.00
Interquartile Range 4.75
Skewness -.028 .181
Kurtosis -.033 .360
Extreme Values
gender Case Number Value
hope female Highest 1 108 39.00
2 35 38.00
3 58 38.00
4 10 37.00
5 50 37.00°
Lowest 1 144 17.00
2 34 20.00
3 328 21.00
4 120 21.00
5 362 22.00°
male Highest 1 175 40.00
2 13 37.00
3 17 37.00
4 11 36.00
5 149 36.00°
(continued)
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Extreme Values (continued)

gender Case Number Value
]
Lowest 1 143 14.00
2 227 17.00
3 295 18.00
4 107 18.00
5 251 20.00¢
esteem female Highest 1 1 39.00
2 74 39.00
3 86 39.00
4 116 38.00
5 9 37.002
Lowest 1 280 22.00
2 328 23.00
3 316 26.00
4 2 26.00
5 320 27.00°
male Highest 1 93 41.00
2 141 39.00
3 233 39.00
4 355 39.00
5 249 38.00
Lowest 1 341 24.00
2 99 24.00
3 289 25.00
4 285 25.00
5 179 25.00
optimism female Highest 1 280 33.00
2 222 32.00
3 226 32.00
4 14 31.00
5 35 31.00°
Lowest 1 360 18.00
2 362 19.00
3 344 19.00
4 30 19.00
5 342 20.00¢
male Highest 1 29 35.00
2 51 32.00
3 69 32.00
4 71 32.00
5 119 32.008
Lowest 1 325 17.00
2 145 17.00
3 67 18.00
4 336 19.00
5 191 19.00"

jm i (o R B o B @ BN © B V]

. Only a partia! list of cases with the value 37.00 are shown in the table of upper extremes.

. Only a partial list of cases with the value 22.00 are shown in the table of lower extremes.

. Only a partial list of cases with the value 36.00 are shown in the table of upper extremes.

. Only a partial list of cases with the value 20.00 are shown in the table of lower extremes.
. Only a partial list of cases with the value 27.00 are shown in the table of lower extremes.

Only a partial list of cases with the value 31.00 are shown in the table of upper extremes.
. Only a partial list of cases with the vaiue 32.00 are shown in the table of upper extremes.

. Only a partial list of cases with the value 19.00 are shown in the table of lower extremes.
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Hope

hope Stem-and-Leaf Plot for
gender = female

Frequency Stem & Leaf

1.00 Extremes (=<17.0)

1.00 20. O

2.00 21. 00

2.00 22. 00

6.00 23 . 000000

5.00 24 . 00000

14.00 25 . 00000000000000
14.00 26 .  00000000000000
14.00 27 . 00000000000000
11.00 28 . 00000000000
15.00 29 . 000000000000000
18.00 30 . 000000000000000000
13.00 31 . 0000000000000
29.00 32 . 00000000000000000000000000000
12.00 33 . 000000000000
10.00 34 . 0000000000

6.00 35. 000000

5.00 36. 00000

3.00 37. 000

2.00 38. 00

1.00 39. 0

Stem width: 1.00

Each leaf: one case

hope Stem-and-Leaf Plot for
gender = male

Frequency Stem & Leaf

2.00 Extremes (=<17.0)

.00 1.

2.00 1. 88

8.00 2. 00011111

12.00 2. 222233333333

13.00 2. 4445555555555

29.00 2. 66666666666666777777777777777
34.00 2. 8888888888889999999999999999999999
34.00 3. 0000000000000000001111111111111111
25.00 3. 2222222222222233333333333

14.00 3. 44444444555555

6.00 3. 666677

.00 3.

1.00 4. 0

Stem width: 10.00

Each leaf: one case
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35,00 -

3050

]
[
2 2500
£
20,00 -~
0144
15 {35
Q143
10,00~
T T
femals malg
gender
Esteem
esteem Stem-and-Leaf Plot for
gender = female
Frequency Stem & Leaf
2.00 Extremes (=<23.0)
2.00 26. 00
11.00 27 . 00000000000
9.00 28 . 000000000
18.00 29 . 000000000000000000
19.00 30 . 0000000000000000000
29.00 31. 00000000000000000000000000000
25.00 32 . 0000000000000000000000000
26.00 33 . 00000000000000000000000000
12.00 34 . 000000000000
13.00 35. 0000000000000
8.00 36 . 00000000
6.00 37 . 000000
4.00 Extremes (>=38.0)
Stem width: 1.00
Each leaf: one case
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esteem Stem-and-Leaf Plot for
gender = male

Frequency Stem & Leaf
2.00 24 . 00
3.00 25. 000
4.00 26 . 0000
16.00 27 . 0000000000000000
16.00 28 . 0000000000000000
24.00 29 . 000000000000000000000000
16.00 30 . 0000000000000000
22.00 31 . 0000000000000000000000
14.00 32 . 00000000000000
23.00 33 . 00000000000000000000000
19.00 34 . 0000000000000000000
7.00 35. 0000000
3.00 36. 000
6.00 37 . 000000
1.00 38. 0
4.00 Extremes (>=39.0)
Stem width: 1.00
Each leaf: one case
Q93
40.00
086
0116
35.00—

E
Q
2
H

30.00~

25.00

20.00—

0328
0280

female

f T
male

gender
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Optimism

optimism Stem-and-Leaf Plot for
gender = female

Frequ

4.00
2.00
8.00
7.00
17.00
26.00
30.00
28.00
25.00
14.00
11.00
5.00
4.00
3.00

Stem
Each

ency Stem & Leaf
Extremes (=<19.0)
20. 00
21 . 00000000
22 . 0000000
23 . 00000000000000000
24 . 00000000000000000000000000
25 . 000000000000000000000000000000
26 .  0000000000000000000000000000
27 . 0000000000000000000000000
28 .  00000000000000
29 . 00000000000
30. 00000
31 . 0000
Extremes (>=32.0)
width: 1.00
leaf: one case

esteem Stem-and-Leaf Plot for
gender = male

Frequency Stem & Leaf

2.00 17.. 00

1.00 18. 0

3.00 19. 000

7.00 20 . 0000000

9.00 21 . 000000000

14.00 22 . 00000000000000

9.00 23 . 000000000

21.00 24 . 000000000000000000000
31.00 25 . 0000000000000000000000000000000
18.00 26 .  000000000000000000
19.00 27 . 0000000000000000000
15.00 28 .  000000000000000

14.00 29 . 00000000000000

9.00 30 . 000000000

1.00 31. 0

6.00 32. 000000

1.00 Extremes (>=35.0)

Stem width: 1.00

Each leaf: one case
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Multivariate outliers were tested for using the regression analysis option, requesting
Mahalanobis distance. To create a suitable dependent variable for this analysis, a vari-
able called id was created using the Compute command (see syntax file).

Given that there are three independent variables in this analysis, the critical chi-square
value at p < .001 was 16.2 — the same as in the working example. An examination of
the newly created variable in the data file reveals that there are no cases that exceed
this critical value and thus all cases will be retained for further analysis. Although the
sample is outlier free, remember that, as noted earlier in the chapter, it is not unusual
to have some outlying cases, particularly with large sample sizes.

4000 o
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o oo )
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o ©000000000C O
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©C 000000000
o 0000000000
S25.00~ o 0cooo000O o
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©o 00 00000 O
o o o o
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2000 ° o
o
o
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In testing the assumption of linearity it is obvious from the scatterplots and the corre-
lation matrix that our dependent variables are not significantly related. The only corre-
lation that is significant is that between esteem and optimism (p < .05). However, the
MANOVA analysis can proceed because there is a theoretical relationship between
these variables.
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Correlations

hope esteem optimism

hope Pearson Correlation 1 .013 -.017

Sig. (2-tailed) .808 754

N 364 364 364
esteem Pearson Correlation .013 1 -.116*

Sig. (2-tailed) .808 026

N 364 364 364
optimism  Pearson Correlation -.017 -.116* 1

Sig. (2-tailed) 754 .026

N 364 364 364

*. Correlation is significant at the 0.05 level (2-tailed).

The Box’s M test for homogeneity of variance—covariance matrices indicates that this
assumption has not been violated at an alpha level of .001.

Box’s Test of Equality of Covariance Matrices®

Box's M 12.859
F 2.124
df1 6
df2 948208.9
Sig. .047

Tests the null hypothesis that the observed covariance
matrices of the dependent variables are equal across groups.
a. Design: Intercept+gender

The Levene test of equality of error variances, for each of the dependent measures,
indicates that hope, esteem and optimism have not violated this assumption at an alpha
level of .01. However, at the .05 level, optimism does violate this assumption.

Levene’s Test of Equality of Error Variances®

F df1 df2 Sig.
hope .319 1 362 572
esteem 2.330 1 362 .128
optimism 5.605 1 362 .018

Tests the null hypothesis that the error variance of the dependent variable is equal across groups.
a. Design: Intercept+gender

Multivariate Tests®

Effect Value F Hypothesis df Error df Sig.

Intercept  Pillai’s Trace .996 30610.736° 3.000 360.000 .000
Wilks’ Lambda .004 30610.736% 3.000 360.000 .000
Hotelling’s Trace 255.089 30610.736 3.000 360.000 .000
Roy’s Largest Root | 255.089 30610.736% 3.000 360.000 .000

donor Pillai’'s Trace .022 2.7377 3.000 360.000 .043
Wilks’ Lambda 978 2.737° 3.000 360.000 .043
Hotelling’s Trace .023 27378 3.000 360.000 .043
Roy’s Largest Root .023 2.737° 3.000 360.000 .043

a. Exact statistic
b. Design: Intercept+gender

The multivariate tests of significance reveal that there are significant differences in the
dependent variables across gender.

Examination of our univariate/between-subjects tests for each dependent variable indi-
cates that hope is the only variable that differs significantly across gender when signifi-
cance is measured at an alpha level of .05, F(1,362) = 4.485, p < .05.
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Tests of Between-Subjects Effects

Type Il Sum of
Source Dependent Variable Squares df Mean Square F Sig.
Corrected Model  hope .76.2352 1 76.235 4.485 .035
esteem 32.401° 1 32.401 3.443 .064
optimism .921¢ 1 921 105 .746
Intercept hope 308246.388 1 308246.388 18136.305 .000
esteem 357666.983 1 357666.983 38007.369 .000
optimism 235226.514 1 235226.514 26761.156 .000
donor hope 76.235 1 76.235 4.485 .035
esteem 32.401 1 32.401 3.443 .064
optimism 921 1 .921 .105 746
Error hope 6152.587 362 16.996
esteem 3406.588 362 9.410
optimism 3181.925 362 8.790
Total hope 314619.000 364
- esteem 361224.000 364
optimism 238448.000 364
Corrected Total hope 6228.821 363
-~ esteem 3438.989 363
optimism 3182.846 363

a. R Squared = .012 (Adjusted R Squared = .010)
- b. R Squared = .009 (Adjusted R Squared = .007)
c¢. R Squared = .000 (Adjusted R Squared = .002)

- An examination of the means for the variable hope reveals that females have signifi-
cantly higher hope scores (mean of 29.56) than those of males (28.64).

gender
95% Confidence Interval
Dependent Variable gender Mean Std. Error Lower Bound Upper Bound
hope female 29.560 .304 28.962 30.157
male 28.644 .307 28.040 29.249
esteem female 31.647 226 31.202 32.091
male 30.151 229 30.600 31.500
optimism female 25.473 219 25.043 25.903
- male 25.372 221 24.938 25.807
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When you have serious violations of the distribution assumptions of parametric tests,
then there are alternative nonparametric techniques that can be used. These tests tend
to be less powerful than their parametric counterparts; however, some nonparametric
tests are appropriate for data measured on scales that are not interval or ratio.

SPSS has a wide selection of nonparametric techniques available, of which the
following will be discussed:

* Chi-square test for goodness of fit

» Chi-square test for independence or relatedness
» Mann-Whitney test (Wilcoxon rank sum)

* Wilcoxon signed-rank test

» Kruskal-Wallis test

* Friedman test

* Spearman’s rank order correlation.

Assumption testing for nonparametric techniques is not as critical as for parametric
methods. However, a number of generic assumptions apply:

1 Random sampling

2 Similar shape and variability across distributions

3 Independence — for between-subjects designs, independence (that is, subjects
appear in only one group and the groups are not related in any way) must be
ensured.

Chi-square ftests

There are two main types of chi-square test. The chi-square test for goodness of fit
applies to the analysis of a single categorical variable, and the chi-square test for inde-
pendence or relatedness applies to the analysis of the relationship between two categ-
orical variables.

Assumption testing

There are three assumptions you need to address before conducting chi-square tests.

1 Random sampling — observations should be randomly sampled from the
population of all possible observations.

2 Independence of observations — each observation should be generated by a
different subject and no subject is counted twice.

WSPSS: Analysis without Anguish
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3 Size of expected frequencies — when the number of cells is less than ten and
particularly when the total sample size is small, the lowest expected frequency
required for a chi-square test is five. However, the observed frequencies can be
any value, including zero.

Working example — chi-square test for goodness of fit

The following table outlines the attitudes of sixty people towards US military bases in
Australia. A chi-square test for goodness of fit will allow us to determine if differences
in frequency exist across response categories.

Attitude towards US military Frequency
bases in Australia of response
In favour 8
Against 20
Undecided 32

The data file can be found in Work19a.sav on the website that accompanies this title.

e Edit View Data Transform Analyze -Graphs Utiities Window Help

«_x

attitude frag a1
1.00 8.00
2.00 20 00
3.00 32.00

war var T a3y [T D - 2 A -

&
=
Y e
ot e S NS R ot e e R Ry ] §

Tl

ariable View

i o SPSS Yersion-L2.Cha.,

Initially, you have to tell the program that the data for frequency are in the form of
frequency counts not scores. Using the Weight Cases option, you can do this quickly
and easily and then you can perform the chi-square test.

} To conduct a chi-square test for goodness of fit

Select the Data menu.

b
1
2 Click on Weight Cases... to open the Weight Cases dialogue box.
3 Click on the Weight cases by radio button.

4

Select the variable you require (i.e. freq) and click on the [¥] button to move the
variable into the Frequency Variable: box.
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. Weight Cases

P aftitude towerds USmil |~ b ot weight cases OK

& Weight cases by
Frequency Variable:

Pasta

Reset

Cancel

Flifelels

Curmrent Status: Weight cases by freq Help

5 Click on OK. The message Weight On should appear on the status bar at the
bottom right of the application window.

Select the Analyze menu.

7 Click on Nonparametric Tests and then Chi-Square... to open the Chi-Square
Test dialogue box.
8 Select the variable you require (i.e. attitude) and click on the P button to move

the variable into the Test Variable List: box.

Bfreq _EEJ
Expected Range ~——  Expected Valles ———— _Hep |
% Get from data & All categories equal
™ Use specified range  Yalues: r__~
Lawees r——
per [
Options... I

9 Click on OK.

WEIGHT
BY freq .

NPAR TEST
/CHISQUARE=attitude
/EXPECTED=EQUAL
/MISSING ANALYSIS.

attitude towards US military bases

Observed N Expected N Residual
in favour 8 20.0 -12.0
against 20 20.0 .0
undecided 32 20.0 12.0
Total 60
SPSS: Analysis without Anguish
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Test Statistics

attitude towards US
military bases

Chi-Square? 14.400
df 2
Asymp. Sig. .001

a. 0 cells (.0%) have expected frequencies less than
five. The minimum expected cell frequency is 20.0.

You can see from the output that the chi-square value is significant (p < .05).

Thus it can be concluded that there are significant differences in the frequency of
attitudes towards military bases in Australia, and the results show that people are
largely undecided on this issue, X*(2, N= 60) = 14.4, p < .05.

It should be noted that the expected frequencies in the above example represent a
1/3:1/3:1/3 split. Sometimes the expected frequencies are not evenly balanced across
categories. Say the expected frequency for each category was 15, 15 and 30, for
example. SPSS allows you to specify expected values that may not be equivalent. This
technique will be demonstrated using already weighted cases.

To conduct a chi-square test for goodness of fit with unequal expected
frequencies
Select the Analyze menu.

2 Click on Nonparametric Tests and then Chi-Square... to open the Chi-Square
Test dialogue box.

3 Select the variable you require (i.e. attitfude) and click on the ] button to move
the variable into the Test Variable List: box.

In the Expected Values box, click the Values: radio button.
Type 15 in the box and click on Add.

Type another /5 in the box and click on Add.

Type 30 in the box and click on Add.

N A A

WPireq Test Varable List: oK
@ attitude towards LS mi "————j
Paste }
Resat l
Cancel ;
- Bxpected Range ~ Expected Values -~~~ Help I

% Get from data
™ lse specified range

Al categories equal

& Values: “

0l
X

Options...

|

8 Click on OK.
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NPAR TEST
/CHISQUARE=attitude
/EXPECTED=15 15 30
/MISSING ANALYSIS.

attitude towards US military bases

Observed N Expected N Residual
in favour 8 15.0 -7.0
against 20 15.0 5.0
undecided 32 30.0 2.0
Total 60

Test Statistics

attitude towards US
military bases

Chi-Square® 5.067
df 2
Asymp. Sig. .079

a. 0 cells (.0%) have expected frequencies less than
five. The minimum expected cell frequency is 15.0.

You will notice that with the different cell frequencies, the chi-square statistic is no
longer significant (p > .05).

Working example — chi-square test for relatedness or
independence

A magazine publisher wished to determine whether preference for certain publications
depended on geographic location of the reader. Of those preferring the Financial
Review, 32 were urban readers and 24 were from the country. Of those who chose
Newsweek, 28 were city readers while four were rural readers.

The data file can be found in Work19b.sav.
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Select the Analyze menu.

To conduct chi-square test for relatedness or independence

2 Click on Descriptive Statistics and then on Crosstabs... to open the Crosstabs

dialogue box.

3 Select a row variable (i.e. pref) and click on the ] button to move the variable

into the Row(s): box.

4 Select a column variable (i.e. location) and click on the [®] button to move the
variable into the Column(s): box.

Rowisk:
@ freq .

0K

Columnis):

@ prefererice for magazin

Paste
Reset

Cancel

Kl

Help

Layer 1of 1

i
i
i
i
i

™ Display clustered bar chars

I~ Suppress tables

Statisics... | Cafs..

1 Format.... [

5  Click on the Statistics... command pushbutton to open the Crosstabs: Statistics

sub-dialogue box.

6  Click on the Chi-square check box.

Continue

Cancel

aane

Help

¥ Chisquare [~ Comelations
- Nominal E~~Ofdinal
T~ Contingency coefficient i T~ Gamma
H
I~ Phiand Cramér's V 2 I~ Somers'd
™ Lambda T Kendall'staub
I™ Uneertainty coefficient T Kendalls tu<
- Nominal by Interval -~ T Kappa
=Y ™ Risk
™ MeNemar
™ Cochren's and Mantel-Haenszel statistics

Click on Continue.

Click on the Cells... command pushbutton to open the Crosstabs: Cell Display

sub-dialogue box.

9  In the Counts box, click on the Observed and Expected check boxes.

10 In the Percentages box, click on the Row, Column and Total check boxes.
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%(:vossfabs:'gcé’gw@%ptay

~COUPLS ~re
vV Observed
¥ Bxpected

~ Residuals

Continue: §
Cancel
Help

e

& Round cell counts

¢ Truncate cell courts

¥V Row ™ Unstandardized

V¥ Column [ I Standardized

v Total T Adjusted standardized
- Noninteger Y/eights

" Bound case weights

" Trncate case weights

" No adjustments

11 Click on Continue and then OK.

CROSSTABS

/TABLES=pref BY location
/FORMAT= AVALUE TABLES

/STATISTIC=CHISQ

/CELLS= COUNT EXPECTED ROW COLUMN TOTAL

fCOUNT ROUND CELL .

preference for magazine * location of reader Crosstabulation

location of reader
urban rural Total

preference for magazine  Financial Review  Count 32 24 56

Expected Count 38.2 17.8 56.0

% within preference for magazine 57.1% 42.9% 100.0%

% within location of reader 53.3% 85.7% 63.6%

% of Total 36.4% 27.3% 63.6%

Newsweek Count 28 4 32

Expected Count 21.8 10.2 32.0

% within preference for magazine 87.5% 12.5% 100.0%

% within location of reader 46.7% 14.3% 36.4%

% of Total 31.8% 4.5% 36.4%

Total Count 60 28 88

Expected Count 60.0 28.0 88.0

% within preference for magazine 68.2% 31.8% 100.0%

% within location of reader 100.0% 100.0% 100.0%

% of Total 68.2% 31.8% 100.0%

Chi-Square Tests
Asymp. Sig. Exact Sig. Exact Sig.
Value df (2-sided) (2-sided) (1-sided)

Pearson Chi-Square 8.650° 1 .003
Continuity Correction® 7.308 1 .007
Likelihood Ratio 9.487 1 .002

Fishers Exact Test .004 .003
Linear-by-Linear Association 8.552 1 .003

N of Valid Cases 88

a. Computed only for a 2x2 table
b. 9 cells (.0%) have expected count less than five. The minimum expected count is 10.18.
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To interpret the chi-square printout you need to look at the Pearson statistic, which is
short for Pearson’s chi-square. In this example, Pearson has a value of 8.650 with a
significance of .003. This significance value is well below the alpha level of .05 and is
thus significant.

You can also see in the notes below the Chi-square Tests table that the minimum
expected cell frequency is 10, which is > 5, and therefore you can be confident that
you have not violated one of the main assumptions of chi-square.

In examining the observed cell frequencies, it can be concluded that the rural readers
prefer to read the Financial Review while the urban readers do not show a marked
preference for either publication, X*(1, N= 88) = 8.65, p < .05.

Mann-Whitney U test (Wilcoxon rank sum W fest)

The Mann-Whitney U test tests the hypothesis that two independent samples come
from populations having the same distribution. This test is equivalent to the indepen-
dent groups t-test.

Working example

The productivity levels of factories A and B are to be compared. The monthly output,
in tonnes of produce, was recorded for 22 consecutive months. The data violate the
stringent assumptions of an independent groups t-test, so you have decided to perform
a Mann-Whitney test. The data file can be found in Work19c.sav.

Tl Warki9e L'5PS4 Data Editor =

Filz Edit Yiew Data Transform Analyze Graphs U vinder: Help
SRa 8l || =lb] 8 el pediel]
A factory i
S o | pieduce | e o e ] v A
1 1 1300 ]
2 2 1600 | ) ’
& o R
4 1 13.00:
5 2 100G
5 2 800
7 i 0
3| 2 1% 00
9 2 1700
10 1 1100
L I rt
12 2 1400
13 1 13.00
14 1 1300
15, 2 1200 -
16 1 17800
17 77 E :
g H 11066 i
13 2 1200 :
o : d
21 P 16.00°
22 1 17.00
G4
i
e | _»fJ
/5PSS Processor is ready ’

O creoen a0 biose. | 099955 Yerson 12 Cha ""‘?’@’%ﬁf‘”‘@%&‘ggﬁhq tL3RAM

®» To conduct a Mann-Whitney U test

Select the Analyze menu.

2 Click on Nonparametric Tests and then on 2 Independent Samples... to open
the Two-Independent-Samples Tests dialogue box.
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3 Select the dependent variable (i.e. produce) and click on the [ button to move
the variable into the Test Variable List: box.

4 Select the independent variable (i.e. factory) and click on the B button to move
the variable into the Grouping Variable: box.

Test Vanable List: oK I
@tonnes of produce par
Paste 1
Resat i
’ Grouping Variable: Cancel l
.| Haciom Help
~Test Type %

¥ Mann-Whitney 1 I™ Kolmogorov-Smimov Z e

[™ Moses edreme reactions [ Wald-Wolfowitz uns

Options... l

5 Click on the Define Groups... command pushbutton to open the Two Inde-
pendent Samples: Define Groups... sub-dialogue box.

6 In the Group 1: box, enter the first value for the independent variable (sex)
(i.e. 1), then tab. Enter the second value for the independent variable (i.e. 2) in
the Group 2: box.

Click on Continue.
Ensure the Mann-Whitney U check box has been selected.
Click on OK.

NPAR TESTS
/M-W= produce BY factory(1 2)
/MISSING ANALYSIS.

Ranks
factory N Mean Rank | Sum of Ranks
tonnes of produce per month A 11 12.77 140.50
B 11 10.23 112.50
Total 22

Test Statistics®

tonnes of produce

per month
Mann-Whitney U 46.500
Wilcoxon W 112.500
V4 -.927
Asymp. Sig. (2-tailed) .354
Exact Sig. [2*(1-tailed Sig.)] .365%

a. Not corrected for ties.
b. Grouping Variable: factory
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To interpret the output from the Mann-Whitney U test you need to consider the
Z-score and two-tailed P-value, which have been corrected for ties.

The output indicates that the result, with correction for ties and Z-score conversion,
was not significant, z = -.927, p > .05, and therefore no significant differences in prod-
uctivity exist between factories A and B.

Wilcoxon signed-rank test

The Wilcoxon signed-rank test, also referred to as the Wilcoxon T-test, is used when
you would use a repeated measures or paired t-test — that is, when the same partici-
pants perform under each level of the independent variable.

Working example

A factory manager wished to compare productivity in his factory for the first and
second halves of the year. He observed the productivity from 22 work stations and
recorded their output in tonnes. The data violate the stringent assumptions of a paired
t-test, so he decided to perform a Wilcoxon signed-rank test. The data file can be found
in Work19d.sav.

File Edit view Data Transform Znalyze Graphs Utlhies Window Help

=] s Tl BlEE ©lef
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1 em 1200
12 9.00 14.00
13 600 15 00
[ 700 1306
15 1e00T T 20 et
16 8000 17 00
17 500 1500 ;
= B
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= so0 e
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i) Chapter 29 Mareso... ] 1 5055 verson 12.0ha,,, . o AABEQ 1w

zf% To conduct @ Wilcoxon signed-rank test

1 Select the Analyze menu.

2 Click on Nonparametric Tests and then on 2 Related Samples... to open the
Two-Related-Samples Tests dialogue box.

3 Select the variables you require (i.e. outputl and output2) and click on the ]
button to move the variables into the Test Pair(s) List: box.

4 Ensure that the Wilcoxon check box has been selected.
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B outputl oK l
@ output2
Paste l
Reset
Canee!
Help l
et Selactions e o Test Type
Variable 1: WV Wicoxon |~ Sign T McNemar
Variable 2.
QOptions... l

5 Click on the Options... command pushbutton to open the Two-Related-
Samples: Options sub-dialogue box.

6 Ensure that the Descriptives check box has been selected.

- Statistics

V Descriptive |~ Quartites
Cancel i

- Missing Walugs = Help i

& Exclude cases test-bytest

" Exclude cases listwise

7 Click on Continue and then OK.

NPAR TEST
/WILCOXON=output! WITH output2 (PAIRED)
/STATISTICS DESCRIPTIVES
IMISSING ANALYSIS.

Ranks
N Mean Rank | Sum of Ranks
output? - output1  Negative Ranks 0? .00 .00
Positive Ranks 22b 11.50 253.00
Ties 0°
Total 22

a. output2 < outputi
b. output2 > outputi
¢. output2 = output1

Test Statistics®

output2 - outputi

z -4.1132
Asymp. Sig. (2-tailed) .000

a. Based on negative ranks.
b. Wilcoxon Signed-Rank Test

REY SPSS: Analysis without Anguish

KaRaNLIK



To interpret the Wilcoxon signed-rank test you need to examine the Z-score value and
the two-tailed P-value.

Descriptive Statistics

N Mean Std. Deviation Minimum Maximum
output1 22 8.5000 3.33452 4.00 16.00
output2 22 13.8636 2.74808 8.00 19.00

The output indicates that there is a significant difference in factory output for the first
and second halves of the year, z = -4.113, p < .05, with higher productivity in the
second part of the year.

Kruskal-Wallis test

The Kruskal-Wallis test is equivalent to the one-way between-groups ANOVA and
therefore allows possible differences between two or more groups to be examined.

Working example

A personnel manager of a large insurance company wished to evaluate the effective-
ness of three different sales training programs that had been designed for new
employees. Seventy-five new graduates were randomly assigned to one of the pro-
grams, and then their annual sales figures (in $1000s) were compared 12 months later.
The data violate the stringent assumptions of a one-way ANOVA, so the manager
decided to perform a Kruskal-Wallis test. The data file can be found in Work19e.sav.
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To conduct a Kruskal-Wallis test

Select the Analyze menu.

Click on Nonparametric Tests and then on K Independent Samples... to open
the Tests for Several Independent Samples box.

Select the dependent variable (i.e. sales) and click on the ] button to move the
variable into the Test Variable List: box.

Select the independent variable (i.e. fraining) and click on the ] button to move
the variable into the Grouping Variable: box.

erat independent >amples

-~ Test Type
¥ Keuskal-Walis H

Test Variable List: oK
@ sales in 1000 [sales]

Paste

Reset
Cancel

Help

ble il g

™ Median

Options...

5 Click on the Define Range... command pushbutton to open the Several Inde-
pendent Samples: Define Range sub-dialogue box.

6 Enter the first value for the independent variable (training) (i.e. T) in the Minimum:
box, then tab. Enter the greatest value for the independent variable (i.e. 3) in the
Maximum: box.

7 Click on Continue.

Ensure the Kruskal-Wallis H check box has been selected.
Click on OK.
Ranks
training method N Mean Rank
sales in $1000 A 25 31.38
B 25 38.98
c 25 43.64
Total 25
NPAR TESTS
/K-W=sales BY training(1 3)
/MISSING ANALYSIS.
Test Statistics®?
sales in $1000

Chi-Square 4.032

df 2

Asymp. Sig. 133

a. Kruskal-Wallis Test
b. Grouping Variable: training method
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To interpret the output from the Kruskal-Wallis test you need to look at the chi-square
value, degree of freedom (df) and significance, which has been corrected for ties.

These values indicate that sales do not significantly differ across the three training
programs, X*(2, N= 75) = 4.032, p > .05.

Friedman test

The Friedman test is used to compare two or more related samples, and is equivalent to
the repeated measures or within-subjects ANOVA.

Working example

Reaction times for eight subjects were measured under a placebo condition, a drug X
condition and a drug Y condition. It was hypothesised that reaction times would differ
significantly across drug conditions. The data violate the stringent assumptions of a
repeated measures ANOVA, so it was decided that a Friedman test should be per-
formed. The data file can be found in Work19f.sav.
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To conduct a Friedman test

Select the Analyze menu.

Click on Nonparametric Tests and then on K Related Samples... to open the
Tests for Several Related Samples box.

3 Select the variables you require (i.e. drugx, drugy and placebo) and click on the
] button to move the variables into the Test Variable List: box.

4 Ensure the Friedman check box has been selected.
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ity

Test ‘v‘aﬁabigg: oK

Paste

Reset

Cancel

Help

- Test Type
V Friedman | Kendsli's'% [~ Cochrans Q

Statistics...

b llelsle

5 Click on OK.

NPAR TESTS
/FRIEDMAN = placebo drugx drugy
/MISSING LISTWISE.

Ranks
Mean Rank
placebo 1.38
drugx 1.63
drugy 3.00

Test Statistics?

N 8
Chi-Square 12.250
df 3
Asymp. Sig. .002

a. Friedman Test

The results of the Friedman test indicate that significant differences do exist in reaction
time across drug conditions, X*(2, N= 8) = 12.25, p < .05, and that drug Y appears to
slow reaction time considerably.

Spearman’s rank order correlation

% A nonparametric alternative to the parametric bivariate correlation (Pearson’s r) is
Spearman’s rho.

Working example

To examine the relationship between sales performance and employee income, data were
collected from 20 sales representatives. The data violate the stringent assumptions of a
Pearson’s 1, so it was decided a Spearman’s rho should be performed. The data file can
be found in Work19g.sav.
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To conduct a Spearman’s rank order correlation

Select the Analyze menu.

2 Click on Descriptive Statistics and then on Crosstabs... to open the Crosstabs
dialogue box.

3 Select the first variable (i.e. sales) and click on the [*] button to move the variable
into the Row(s): box.

4 Select the second variable (i.e. income) and click on the P] button to move the
variable into the Column(s): box.

5 Click on the Statistics... command pushbutton to open the Crosstabs: Statistics
sub-dialogue box.

6 Select the Correlations check box.

[~ Chisquare ¥ Comelations

= NOMUR@] sz P T L.
™ Contingency coefficient EI"‘ Gamma f ,..Ca_r_'EQl.j
I~ Phi and Gramérs V 1T Somers'd |t
I™ Lambda T Kendal'staub
™ Uncedainty coefficient gr Kendall's tauc
~ Nominal by Imteryal «ey ™ Kappa
I~ B [ Risk
™ McNemar

I~ Cochran’s and Mantel-Haensze! statistics

e 1t i l

7 Click on Continue and then OK.
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CROSSTABS
[TABLES=sales BY income
/FORMAT= AVALUE TABLES
/STATISTIC=CORR
JCELLS= COUNT
/COUNT ROUND CELL .

Symmetric Measures

Asymp. Approx.
Value Std. Error® | Approx. TP Sig.
Interval by Interval Pearson’s R 767 .083 5.728 .000°
Ordinal by Ordinal Spearman Correlation .757 110 5.554 .000°¢
N of Valid Cases 25

a. Not assuming the null hypothesis.
b. Using the asymptotic standard error assuming the null hypothesis.
c. Based on normal approximation.

You can see from the output that Spearman’s rank order correlation is significant,

r(25) = .757, p < .05, and so you can conclude that higher sales are associated with
higher incomes.

Spearman’s rho can also be obtained through the Correlate-Bivariate option in the
Analyze menu.

Practice examples

You will remember that nonparametric tests, or distribution-free tests, do not rely on
parameter estimation or assumptions about parameters or the shape of distributions.
Assuming that these assumptions cannot be met, perform the appropriate nonparametric
test for each of the practice examples below.

Practice example 1

A coffee company is about to launch a range of specialty coffee bags and would like to
know if some varieties are likely to sell better than others. Four of their new varieties
are placed on a supermarket shelf for one week. The number of boxes sold for each
variety are: 20 Mocha Kenya; 40 Colombian; 30 Lebanese; and ten Swiss. Given the
data in Prac19a.sav, your task is to:

1 Determine whether the distribution of sales suggests that some varieties of
coffee bags are more popular than others.

Practice example 2

A researcher was interested in determining whether drinking preference was gender
related. Given the data in Prac19b.sav, your task is to:

1 Determine whether drinking preference is gender related — that is, whether
most men prefer to drink beer rather than wine.
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Practice example 3

A psychologist is interested in the relationship between personality types and religious
affiliation. Fifteen Baptist and 15 Anglican churchgoers were randomly selected from
their respective communities and asked to complete a personality questionnaire
measuring introversion—extroversion on a scale from 0 to 100 — the higher the score
on the scale, the more extroverted the individual. Given the data in Prac19c.sav, your
task is to:

1 Determine whether personality types differ significantly across the two religions.

Practice example 4

A human factors specialist working for an airline company wishes to examine the
effect of temperature on performance. The performances of a random sample of 15
pilots were recorded following participation in an air simulation task, in cockpits of
differing temperatures (20 degrees Celsius and 35 degrees Celsius). Given the data in
Prac19d.sav, your task is to:

1 Determine whether temperature influences pilot performance.

Practice example 5

A physical education teacher observes that a large number of sporting injuries result
from ball sports such as football, basketball and rugby. Over the period of one month,
he records the number of injuries sustained by 45 boys actively involved in one of the
three sports. Given the data in Pracl9e.sav, your task is to:

1 Determine whether the number of injuries sustained differs according to the
type of sport played.

Practice example 6

A veterinarian wishing to start a new dog-breeding business wants to determine which
of four breeds of small dog is more companionable: the silky terrier, the Jack Russell,
the Bichon Frise or the pug. He randomly samples 20 people who regularly attend his
clinic and asks them to complete a perceived companionability scale — the higher the
score, the more companionable the breed of dog. Given the data in Prac19f.sav, your
task is to:

1 Determine whether certain breeds of small dog are more companionable than
others.

Practice example 7

A truck manufacturer notices that a truck’s fuel consumption depends on the load it is
carrying. He keeps a log of diesel consumption and load for 20 trucks over a six-month
period. Given the data in Prac19g.sav, your tasks are to:

1 Plot the relationship between the two variables.

2 Determine whether there is a relationship between load and diesel consumption.
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Solutions

222

Practice example 1 — chi-square test for goodness of fit

Syntax

WEIGHT
BY freq .

NPAR TEST
/CHISQUARE=coffee
[EXPECTED=EQUAL
/MISSING ANALYSIS.

Output

type of coffee bag

Observed N Expected N Residual
Mocha Kenyan 20 25.0 -5.0
Columbian 40 25.0 15.0
Lebanese 30 25.0 5.0
Swiss 10 25.0 -15.0
Total 100

Test Statistics

type of coffee bag

Chi-Square?® 20.000
df 3
Asymp. Sig. .000

a. 0 cells (.0%) have expected frequencies
less than five. The minimum expected
cell frequency is 25.0.

The chi-square test for goodness of fit is significant, X*(3, N= 100) = 20.0, p < .05, and
suggests that the brands are not equally popular. Inspection of the observed cases
reveals that the Colombian coffee bags are the most popular and the Swiss coffee bags
least popular.

Practice example 2 — chi-square test for relatedness or
independence

Syntax

WEIGHT
BY freq .

CROSSTABS
/TABLES=drink BY gender
/FORMAT= AVALUE TABLES
/STATISTIC=CHISQ
/CELLS= COUNT EXPECTED
/COUNT ROUND CELL .
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Qutput

drinking preference * gender Crosstabulation

gender
male female Total
drinking preference wine Count 16 21 37
Expected Count 20.0 17.0 37.0
beer Count 31 19 50
Expected Count 27.0 23.0 50.0
Total Count 47 40 87
Expected Count 47.0 40.0 87.0
Chi-Square Tests
Asymp. Sig. | Exact Sig. Exact Sig.
Value df (2-sided) (2-sided) (1-sided)
Pearson Chi-Square 3.012° 1 .083
Continuity Correction® 2.304 1 129
Likelihood Ratio 3.022 1 .082
Fisher's Exact Test 127 .064
Linear-by-Linear Association 2.977 1 .084
N of Valid Cases 87

a. Computed only for a 2x2 table

b. 0 cells (.0%) have expected count less than five. The minimum expected count is 17.01.

A review of the output indicates that the Pearson’s statistic is not significant (p > .05).

The results indicate that drinking preference is not gender related, X*(1, N= 87) =
3.012, p > .05, and men do not prefer to drink beer rather than wine.

Practice example 3 — Mann-Whitney U test (Wilcoxon

rank sum W test)

Syntax

NPAR TESTS

/MISSING ANALYSIS.

/M-W= iescore BY religion(1 2)

Qutput
Ranks
religious affiliation N Mean Rank | Sum of Ranks
introversion-extraversion score  Baptist 15 10.00 150.00
Anglican 15 21.00 315.00
Total 30
Test Statistics®
introversion-
extraversion score
Mann-Whitney U 30.000
Wilcoxon W 150.000
V4 -3.425
Asymp. Sig. (2-tailed) .001
Exact Sig. [2*(1-tailed Sig.)] .0002
a. Not corrected for ties.
b. Grouping Variable: religious affiliation
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In interpreting the Z-score and two-tailed P-value, which has been corrected for ties, it
is found that there is a significant result.

Therefore, it can be concluded that there is a relationship between religious affiliation
and personality type, z = -3.425, p < .05, with Anglicans considered to be more extro-
verted than Baptists.

Practice example 4 — Wilcoxon signed-rank test

Syntax

NPAR TEST
/WILCOXON=cockpit1 WITH cockpit2 (PAIRED)
/MISSING ANALYSIS.

QOutput
Ranks
N Mean Rank | Sum of Ranks
performance at 35 degrees C - Negative Ranks 0® .00 .00
performance at 20 degrees C  Positive Ranks 10° 5.50 55.00
Ties 0°
Total 10

a. performance at 35 degrees C < performance at 20 degrees C
b. performance at 35 degrees C > performance at 20 degrees C
¢. performance at 35 degrees C = performance at 20 degrees C

Test Statistics®

performance at
35 degrees C -
performance at
20 degrees C

z -2.8362
Asymp. Sig. (2-tailed) .005

a. Based on negative ranks.
b. Wilcoxon Signed-Rank Test

Descriptive Statistics

N Mean Std. Deviation | Minimum Maximum
performance at 20 degrees C 10 9.9000 1.91195 7.00 13.00
performance at 35 degrees C 10 11.9000 1.96921 9.00 15.00

An examination of the Z-score value and two-tailed P-value indicates that the test is
significant.

Therefore it can be concluded that temperature does influence pilot performance,
z =-2.836, p < .05, with better performance exhibited by pilots in the warmer cockpit.

Practice example 5 — Kruskal-Wallis test

Syntax

NPAR TESTS
/K-W=injuries BY sport(1 3)
/MISSING ANALYSIS.
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Output

Ranks
type of sport N Mean Rank
number of injuries  football 15 13.23
rugby 15 34.23
basketball 15 21.63
Total 45

Test Statistics®?

number of injuries

Chi-Square 19.593
df 2
Asymp. Sig. .000

a. Kruskal-Wallis Test
b. Grouping Variable: type of sport

Examination of the chi-square value, which has been corrected for ties, indicates that
the test is significant.

Therefore it can be concluded that the number of injuries sustained varies across the
nature of the sport, X%2, N = 45) = 19.593, p < .05, with rugby players’ suffering
more injuries (Mean = 34.23) than are received by either basketball (Mean = 21.53) or
football players (Mean = 13.23).

Practice example 6 — Friedman test

Syntax

NPAR TESTS
/FRIEDMAN = breed1 breed2 breed3 breed4
/MISSING LISTWISE.

Output
Ranks
Mean Rank
silky terrier 3.28
Jack Russell 1.43
Bichon Frise 3.48
Pug 1.83

Test Statistics? -

N 20
Chi-Square 38.528
df 3
Asymp. Sig. .000

a. Friedman Test

The results of the Friedman test indicate that there are significant differences in
companionability across different breeds of dog, X*(3, N= 20) = 38.528, p < .05.
Bichon Frise were seen to be the most companionable breed, followed by silky terriers
and pugs. Jack Russells were perceived to be the least companionable.
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Practice example 7 — Spearman’s rank order correlation

Syntax

GRAPH
/SCATTERPLOT(BIVAR)= load WITH diesel
/MISSING=LISTWISE .
CROSSTABS
/TABLES=load BY diesel
/FORMAT= AVALUE TABLES
/STATISTIC=CORR
/CELLS= COUNT EXPECTED
/COUNT ROUND CELL .

Qutput

The following scatterplot indicates a curvilinear relationship between the amount of
diesel consumption and truck load.
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An examination of Spearman’s correlation coefficient indicates that this relationship is
not significant.

Symmetric Measures

Asymp. Approx.
Value Std. Error® | Approx. T° Sig.
Interval by Interval Pearson’s R .331 222 1.488 .154°¢
Ordinal by Ordinal Spearman Correlation 232 277 1.011 .326°
N of Valid Cases 20

a. Not assuming the null hypothesis.
b. Using the asymptotic standard error assuming the null hypothesis.
c. Based on normal approximation.

Therefore, our analysis suggests that there is no relationship between truck load and
diesel consumption, r (20) = .232, p > .05.
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Mulhple response and multiple
dichotomy analysis

Multiple response and multiple dichotomy analysis are commonly used in the analysis
of questionnaire or survey data.

Mulhple response analysis

Multiple response analysis is commonly used for the analysis of open-ended questions.
For example, a questionnaire item may be:

Q: ‘What do you think are the important things that need to be considered when
— developing higher density housing in your neighbourhood?’

You must do two things on receiving all your questionnaires back from the field,
before analysing the information. These are:

1 Look at the responses to the open-ended question and determine the maximum
number of responses to the question. In this example, are people giving one,
_ two, three or more responses to the question?

2 Make sure you have some understanding of the range of possible responses. Will
the number of different responses be less than 100, in which case you can code
all responses from 01 to 99? If there appears to be more than 100 different
responses, then you may have to use a three-digit code and code from 001 to 999.

Let’s assume that in the example above you have decided that there is a maximum of
four responses given to the question and that there are fewer than 100 different
responses. Therefore, it is possible to use a two-digit code for these data. The next step

— is to code all your questionnaires. This coding system is defined using the Value
Labels option. However, it is more efficient to use the Template option, given that
there is likely to be multiple variables. Possible codes, for the above example, could
include:

01 — Privacy of residents

02 — Sewerage

03 — Noise from traffic

04 — Access to public transport.

In acknowledging a maximum of four possible responses to this open-ended question,
that four variables will be coded is accepted. Within SPSS these variables could be
defined as openl, open2, open3 and open4.
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Working example

Three-hundred-and-sixty-four farmers were asked to identify the selection criteria they
used when choosing rams for their breeding program. The maximum number of
responses obtained from an individual was four, and 14 possible criteria were identi-
fied. If an individual identified only two criteria, then a code of 88 would be used for
variables 3 and 4. The data from the first four participants may look as follows:

Participant 1 01040288 (This participant has given three responses.)
Participant 2 05888888 (This participant has given one response.)
Participant 3 06011107 (This participant has given four responses.)
Participant 4 88888888 (This participant did not respond to the question.).

You wish to obtain a frequency analysis of the multiple responses of your entire sample
for the question outlined on page 227. This data file can be found in Work20a.sav on
the website that accompanies this title and is shown in the following figure.
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I5PSS Processor is ready :

s

?;} To conduct o multiple response analysis

1 Select the Analyze menu.

2 Click on Multiple Response and then on Define Sets... to open the Define
Multiple Response Sets dialogue box.

3 Select the four variables you require (i.e. crit! to crit4) and click on the P
button to move the variables into the Variables in Set: box.

In the Variables Are Coded As box, click on the Categories radio button.

In the Range: box, type the lowest code (i.e. /), press tab and then type the
highest code (i.e. /4).

6  In the Name: box, type a suitable variable name (i.e. criteria) and in the Label:
box type a description of this variable (i.e. Selection Criteria).
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- Set Defintion

Variables in Set:
P erit] Help }

P cit2
o

P crté Mutt Response Sets:

~Vatables Are Coded As -
" Dichotomies Touriedvalus l_
{5 Categories . -Range: ﬁ_ throughﬁT

P

N

i i
i

Nams: ]cn‘len‘a

Label: ]selection critefia

7  Click on the Add command pushbutton; you will notice that a new variable has

been created (i.e. $criteria) in the Multiple Response Sets: box.

Set Definition
Variables in Set: Close l
Wit
Denit2 __lHeIp
@ crit3
(#) chit
Mukt Response Sets:
Sentera
i~ Vanables Are Coded As-w—————wwm

% Dichotomies Counted vatus: ll-_

" Calegories  Figrge: r_ W*m‘*r_

Name: i
Label: i
8  Click on Close.
9  Select the Analyze menu.
10  Click on Multiple Response and Frequencies... to open the Multiple
Response Frequencies dialogue box.
11 Select the variable (i.e. $criteria) and click on the ] button to move the variable

into the Table(s) for: box.

Muh Response Sels: Tablels) for: oK

[’jﬂ selection criteria [Scrite
Paste

3 Reset

Cancel

elEfelels

P

Missing Values
I Exclude cases listwise within dichotomies
™ Bxclude cases listwise within categories
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12 Click on OK.

MULT RESPONSE
GROUPS=8criteria 'selection criteria' (critt crit2 crit3 crit4 (1,14))
/FREQUENCIES=$criteria .

criterli seliecticrn criteria

G
"
Q
L3
0
3]

Fect of Pcr of

Category lapel Cede Count Respcenses Cases
Fileece style i 33 4,3 2.0
Fibre diameter z 25 12,0 30.2
Sreasy fieece weight 3 €3 13,0 30.¢
Ciean fleece welight 4 1EC 23.3 65.2
Live welight 5 22 6.2 7.4
Reprcoducticn records & T8 2.2 27.5
Disease resistance 7 5 2.9 5.4
Frame size = &7 6.2 i7.9
Constitation 2 &2 5.4 15.2
Skin charactersitics e 78 0.2 22,6
S3tarle sctrength zi ) 1.8 5.2
Feet x2 57 4,2 13.4
Hocks, laws L3 28 3.4 ©.4
tlgcl nandie 24 4 .5 1.4

Total responses 772 09,0 278.7

82 miasing cases; 276 wallid cases

thbreviared Extended
Hame Mame

The frequency table of the multiple response set indicates that clean fleece weight is
the most frequently used selection criterion.

Percentage of responses refers to the proportion of a given response in relation to the
count; for example, 33 people cited fleece style as a selection criterion, and this is
33/772 per cent of the total responses (4.3%).

Percentage of cases refers to the proportion of a given response in relation to the
number of valid cases; for example, 79 people cited skin characteristics as a selection
criterion and this is 79/276 per cent of the valid cases (28.6%).

Multiple dichotomy analysis

Multiple dichotomy analysis is very similar to the multiple response analysis. The
following questionnaire item, for example, could be analysed using a multiple
dichotomy analysis.
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“Would you object to any of the following developments being built next to your property?’
— Single house
— Group housing — duplex
— Group housing — villa units (four units or fewer)
— Group housing — villa units (five or more units)
— Group housing — townhouses (four townhouses or fewer)
— Group housing — townhouses (five or more)
- Flats or home units (three storeys or fewer)
— Flats or home units (four storeys or more)

In this example each item would be given a variable label and a code. The codes nor-
mally used in these cases are 1 if the item is ticked and 0 if it is not ticked. If the person
failed to place a tick alongside at least one item, then the missing value code of 9 might
be assigned to all items. The data from the first four participants may look as follows:

Participant 1 00001111 (This participant did not tick the first four items.)
Participant 2 10000000 (This participant ticked only the first item.)
Participant 3 01111011 (This participant ticked variably across items.)
Participant 4 11111111 (This participant ticked all eight items.).

Working example

A sample of 388 home owners were asked to indicate which native trees were growing
in their gardens. They were given five species to select from. Determine the species
most frequently chosen by home owners. The data file can be found in Work20b.sav
and is shown in the following figure.
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ot . S e
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To conduct a multiple dichotomy analysis

Select the Analyze menu.

2 Click on Multiple Response and Define Sets... to open the Define Multiple
Response Sets dialogue box.

3 Select the five variables (i.e. banksia, bottle, gum, wattle, wax) and click on the
] button to move the variables into the Variables in Set: box.

4 In the Variables Are Coded As box, ensure the Dichotomies radio button is
selected.

5 In the Counted value: box, type the value that you have assigned to those items
that were ticked by respondents (i.e. 1).

6 In the Name: box, type a suitable variable name (i.e. trees) and in the Label:
box, type a description of this variable (i.e. native trees growing).

Varigbles in Set:

@ bottle s Help
®gum !
@ wattle =
— - | banksia L Mult Response Sets:

@ Geraldton wax [warr

23

¢

Nvariab'es Are Coded As __;...,,,...,.N.,.M,,,.,,..,,,,v./,,,,,,,.
1% Dichotomies Counted value: r

" Categories ~ Hazvige: r" !*raf::rug;’?';r"

Name: {trees

Label: }nalive trees growing

7  Click on the Add command pushbutton. You will notice that a new variable has
been created (i.e. $rrees) in the Mult Response Sets: box.

r~Set Definition

Variables in Sat: Close
@ bottle

(#) gum Help
B wattle

@ banksia
@ Geraldton wax [wax] Muk Respanse Sets:
Hress

lr’\/an'a!:d’&c Are Coded Ag iy
H

& Dichotomies Counted vaiue: r-‘ i
;

l " Categories 7 r" tfrzfczug‘r'rr"

i

Mame: [
Label; |

Click on Close.
Select the Analyze menu.

10  Click on Multiple Response and Frequencies... to open the Multiple Response
Frequencies dialogue box.

11 Select the variable (i.e. $trees) and click on the ] button to move the variable
into the Table(s) for: box.
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Mult Response Sets: Tablels) for: 0K !

[inative trees growing [$
Paste ‘
Lo |

- Missing Values
7 Exclude cases listwise within dichotomies
I Exclude cases listwise within categones

12 Click on OK.

MULT RESPONSE
GROUPS=$trees ‘native trees growing’ (bottie gum wattle banksia wax (1))
/FREQUENCIES=$trees .

Group Strees native trees growing

(Value tagbulated = 1)
Fct of FPet of
Dicrotomy label Narme Count Responses Cases
kcrtle 281 92.7 85.3
gum 2L 3.6 3.7
wattle 3 .32 .3
banksia 3 ] .0
Geraldton wax Wax 7 2.3 2.8
Total xresponses 303 100.0 102.7

83 misaing casez; 285 valid cases

Inspection of the frequency table for the multiple dichotomous set indicates that bottle
brushes are the most frequently chosen native species of tree in the garden.

Having defined multiple response or multiple dichotomous sets, it is possible to also
perform crosstabs analysis, by means of which response sets or categorical variables
can be presented in tabular form.

Practice examples

Practice example 1

A counselling psychologist was interested in determining why people marry. The
maximum number of reasons given by any one person was three. These reasons were
coded as follows:

01 Love 05 Security

02 Company 06 To have children
03 Money 07 Familiarity

04 Sex
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Given the data in Prac20a.sav, your tasks are to:
1 Determine the most frequently quoted reason for marriage.

2 Determine the most frequently quoted reason for marriage given by men.

Practice example 2

A random sample of drivers was asked to indicate factors that influenced their decision
when purchasing a used car. The following criteria were specified:

01 Year of manufacture
02 Mileage

03 State of the interior
04 State of the chassis

05 State of the duco

06 Other

Given the data in Prac20b.sav, your task is to:

1 Determine the most influential criterion on vehicle purchase.

Solutions

Practice example 1

Syntax

MULT RESPONSE
GROUPS=$reasons ‘Reasons for marriage’ (reason1 reason2 reason3 (1,7))
/FREQUENCIES=$%reasons .
MULT RESPONSE
GROUPS=$reasons ‘Reasons for marriage’ (reason1 reason2 reason3 (1,7))
NARIABLES=gender(1 2)
/TABLES=$reasons BY gender
/CELLS=ROW COLUMN TOTAL
/BASE=CASES .

s

[0 ST
L3

GO O
(oI S e TR BE b B e

=3 Oy T afs
[ S

(39
W
(0]
O«

ToTal responses 43 200,50 215,05

Z miszsine cases: 20 walid czses

An examination of the frequency table for the multiple dichotomous set indicates that
love and money are the most frequently quoted reasons for marriage. When an analysis
by gender is undertaken, men most frequently quote money as the main reason for
marriage.

YREY  SPSS: Analysis without Anguish

KaRaNLIK



* * * CROSSTAB

Sreasons (group) Reasons for marriage by gender

Page 1 of 2

gender
Count 6 female male
Row pct & Row
Col pct & Total
Tab pct & 1 S 2 &
Sreasons A A T T A 0 T T 1R T 3
1 e 6 o 3 S 9
love ® 66.7 & 33.3 & 45.0
& 60.0 & 30.0 &
& 30.0 & 15.0 s
N A A A I A I A A A A 3
2 & 4 & 4 & 8
company & 50.0 & 50.0 & 40.0
® 40.0 & 40.0 &
& 20.0 & 20.0 &
A I e A A I A A A A e
3 e 4 E 5 o 9
money & 44.4 & 55.6 & 45.0
& 40.0 e 50.0 &
® 20.0 & 25.0 &
SLLUBLUOUTULLOLBLLLTY
4 & 2 & 1 & 3
sex & 66.7 & 33.3 ¢ 15.0
¢ 20.0 & 10.0 e
& 10.0 ¢ 5.0 ¢
T I A A A A I T T T T A 3
5 & 4 & 4 & 8
security & 50.0 & 50.0 & 40.0
® 40.0 & 40.0 &
& 20.0 & 20.0 &
0 A A A A A I A A A A e
6 & 1 & 1 & 2
have children & 50.0 ¢ 50.0 e 10.0
& 10.0 & 10.0 &
& 5.0 & 5.0 s
BLULULULUBUBLUBUUBUBULLLYD

Column
Total

ULATION * * *

10 10 20
50.0 50.0 100.0

Percentages and totals based on respondents

* * * CROSSTAB

Sreasons (group) Reasons for marriage by gender

Page 2 of 2

gender
Count & female male
Row pct ¢ Row
Col pct & Total
Tab pct & 1 & 2 s
Sreasons I e A A
7 e 1 & 3 & 4
familiarity & 25.0 & 75.0 & 20.0
& 10.0 & 30.0 &
& 5.0 e 15.0 &
B A A e A A I A I A A e
Column 10 10 20
Total 50.0 50.0 100.0

ULATION * * *

Percentages and totals based on respondents

20 valid cases; 0 missing cases
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Practice example 2

0000000000000000000000000000000000000000000000000000000000000000000000000000RRR00C R ROt RRRRRRCETRRS

Syntax

MULT RESPONSE
GROUPS=$carpick 'criteria for purchasing a car' (year mileage interior chassis duco other (1))
/FREQUENCIES=$carpick .

Output

Group Scarpick oriteria for purchasing & car
(Value tabulated =

Fct of Fet of

Dicheoteomy Lakel Hame Cocunt Responses Cases
year cf manufacture 3 80.0
0 50.0

srace of the intericr 7 35.40
srate of chassis 7 35.0
atate of duco = 40,0
4 0.0

Total responses 4z 240.0

A ~

2 missing cases; 20 valid ca3es

Inspection of the frequency table for the multiple dichotomous set indicates that the
year of manufacture is the most important consideration when buying a car, with 60%
of the sample selecting this criterion.
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Workin

Multidimensional scaling

Multidimensional Scaling (MDS) starts with a data set of ‘proximities’, which indicate
the degree of ‘similarity’ or ‘dissimilarity’ among elements in a defined set. The prox-
imity measures may be either ‘direct’ or ‘derived’ measures of proximity. If the
measures are direct, then respondents have usually provided a direct estimate of the
degree of (dis)similarity between any pair of elements, either through a rating or
classification task. Derived proximities, on the other hand, usually consist of some
measure of association (e.g. correlation) among elements within a set.

The objective of MDS is to take the proximities data and represent the elements in
multidimensional space, such that the distances among the elements in the space accu-
rately represent the original proximity measures. This chapter provides a basis over-
view of the concept of MDS. SPSS also provides several alternative data analysis
options that can be further developed and explored after a basic knowledge of MDS
has been developed.

g example

As part of a study into tourist perceptions of Australia, you are interested in under-
standing how tourists from other countries comprehend travel distances among some
of the major cities in Australia.

You provide a group of three visiting tourists with the names of eight Australian cities
they are likely to visit. You indicate to the group that the distance between Sydney and
Perth is 100 units and that they are to make judgements about what they think are the
distances between all the remaining pairs of towns relative to the distance between
Sydney and Perth.

The judgements made by all three tourists are averaged. The data file can be found in
Work21.sav on the website that accompanies this title. The data file represents the
average of all the three judgements and is shown as a lower triangular matrix.
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Fle. Edit - View  Data “Transform Analvze Graphs - Utiiles  Window - Help
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8] 160.00 100.00 90.00 120.00 70.00 50.00 55.00 1.00 .
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\Data View £ Variable View vj
{5PS5 Proces g

Select the Analyze menu.

2 Click on Scale and Multidimensional Scaling... (PROXSCAL) to open the
Multidimensional Scaling: Data Format dialogue box.

To conduct a MDS analysis

3 In the Data Format box, select The Data are Proximities radio button.

4 In the Number of Sources box, make sure that the One matrix source radio
button is also selected.

5 In the One Source box, select The proximities are in a matrix across
columns option.

~Data Format

{? 3

" Create prosimities from data

Multidimensional Scaling: Data Format

-Number of Sources

% Dhe matrix source

" Multiple matrix sources

~ One Source ’

The prosimities are in‘a malrix across columns,

The proximities are in & gingle column,

~ Multiple Sources- '

The prowimitics are stacked in g single collme

The provirmibes ae instacked matices acioss columrs,

Thie prodimities arein colunng, ane sources percolumn,

6  Click on the Define command pushbutton to open the Multidimensional
Scaling dialogue box.

7  Select the nine variables representing each of the towns and click on the &
button to move the variables into the Proximities: box.
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Multidimensional Scaling (Proximities in Matrices Across Colu... f_)_‘_(_]

Proximities:
4 Perth
@ Adelaide

® Melboume ’ Reset l

@ Hobart
@ Sydney
Weights:

L]

Gouces;

Model... Hgstrictions.,.l Options... i Plots. .. l Output...

8  Click on the Model... command pushbutton to open the Multidimensional
Scaling: Model sub-dialogue box.

9 In the Shape: box, select the Lower-triangular matrix radio button.
10  In the Proximities: box, select the Dissimilarities radio button.

11 In the Proximity Transformations: box, make sure that the Ordinal radio
button is selected.

12 In the Dimensions: box ensure that you have entered 2 for the Minimum
Dimensions and 2 for the Maximum Dimensions.

Multidimensional Scaling: Model IXI

— Prosimity Transformationis ————-—-—-
& Jddentity " Ratio )
€ weighted Evclidesn T interyal

N ' . ) |
O Gerersized Euclidesn & Drdinal ..____}i?_?.._._]
T Rediced rank [T Untie tied observations
" Spiine
Fark: h
B Demes ]z.

~ Shape Interior krats, i1

' Lower-triangular matrix

€ Uppertriangular matrix

€ Full matrix
~Proximities ~ Dimensions
% Dissimilarities Minirmum: l2
€ Sinilarities M agirnum: 12 '
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13
14

15

Click on Continue to return to the Multidimensional Scaling dialogue box.

Click on the Plots command pushbutton to open the Multidimensional
Scaling: Plots sub-dialogue box.

In the Plots: box, ensure that the Common Space and Transformed prox-
imities vs. distances check boxes are both selected. The All sources radio

button should also be selected in the Source Plots: box.

Multidimensional Scaling: Plots

[ Piﬁ{»a

[T Shess
¥ Common space
[ Individual spaces

¥ Indreidual space weights

¥ Transtormed proximities v¢. distances

T Transtormed indeperndent vanabies

¥ Wariable ard dimession conalations

Continue

Cancel I

Help

— Source Plots
* All sources Sources
" Select sources Sidd
Soares numpen l Channe
Hemove

Click on Continue once again to return to the Multidimensional Scaling dia-

Click on the Options command pushbutton to open the Multidimensional
Scaling: Options: sub-dialogue box.

In the Initial Configuration: box, ensure that the Simplex radio button is

16

logue box.
17
18

selected.
19

In the Iteration Criteria: box, ensure that the Stress convergence: is .0001,
Minimum stress: is .000] and the Maximum iterations: is 700.
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Multidimensional Scaling: Options

~ [nitial Conhguratlnnww ~ |teration Criteria
Stress convergence: ’.0001
Cancel '
« Torgersnn

Minimum stress: l.DUU‘I

" Single random start Help
™ Multiple random starts M aximum iterations: i‘IDD

Mombeer of stérts: !Z I™ Use relaxed updates
€ Custom

e Custor Donfiguration

Read variaties S

Eyaiable: Selected:

20  Again, click on Continue to return to the Multidimensional Scaling dialogue
box.

21  Click on the Output command pushbutton to open the Multidimensional
Scaling: Output: sub-dialogue box.

22  In the Display: box, ensure that you select the Common space coordinates,
Iteration history and Multiple stress measures check boxes.

Multidimensional Scaling: Output

~—Display Continue
v {Common space coordinates I~ Stigss for rardom starts

Cancel
I~ irdividual spece conrdinates ¥ lteration history

I individual space iweights ¥ Muftiple stress measures Help ‘

I Distances ™ Stress decompasition
I Transformed progimities W Traraformed indeperdent esrisbles
I Input data [T Yarable and dimension conelations

~Save to New File

™ Comman space coordinates
[T Irdividual epace weights
I Distances

I Transformed prosimities

[ Transtomed independent variables
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23 Click on Continue and then OK.

PROXSCAL
VARIABLES=Perth Adelaide Melbourne Hobart Sydney Brisbane Darwin Cairns Broome
/SHAPE=LOWER
/INITIAL=SIMPLEX
TRANSFORMATION=ORDINAL (KEEPTIES)
/PROXIMITIES=DISSIMILARITIES
/ACCELERATION=NONE
/CRITERIA=DIMENSIONS(2,2) MAXITER(100) DIFFSTRESS{(.0001) MINSTRESS(.0001)
/PRINT=COMMON HISTORY STRESS
/PLOT=COMMON RESIDUALS (ALL) .

MDS analysis has the potential to produce considerable output. The analysis that has
been described is for a simple MDS solution in a two-dimensional space. Once an
understanding is developed of the output of this simple solution, commands may be
changed to produce more extended output, including increasing the dimensional space
to three or more dimensions.

It is important before any inspection of the analyses to confirm that the data have been
entered and analysed correctly. The case-processing summary shown below indicates
there were nine cases (towns), one source or matrix was analysed and, when excluding
the diagonal, this matrix consisted of 36 proximity measures.

Case-Processing Summary

Cases 9
Sources 1
Objects 9
Proximities  Total Proximities 36
Missing Proximities 0
Active Proximities? 36

a. Active proximities include all nonmissing proximities.
b. Sum of all strictly lower-triangular proximities.

The iteration history with the Normalised Raw Stress values is shown below. The Raw
Stress values are an indication of how well the original proximities are represented by
the distances in the final multidimensional solution. From a starting configuration,
Proxscal iteratively moves the data points so that there is continuous improvement in
the fit between the original proximities and distances in the final solution. After 10 iter-

ations the iteration history stopped as the stress convergence of .0001 had been
reached.

lteration History

Iteration | Normalised Raw Stress | Improvement
0 8.18077
1 .01011 17067
2 .00716 .00295
3 .00606 .00110
4 .00551 .00054
5 .00516 .00035
6 .00491 .00025
7 .00472 .00019
8 .00458 .00014
9 .00447 .00011
10 .00438 ®.00009

a. Stress of initial configuration: simplex start.
b. The iteration process has stopped because improvement
has become less than the convergence criterion.
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There are several stress measures and measures of fit that indicate how well the original
proximities are represented as distances in a multidimensional space. The most
commonly used measure of fit is Stress-I or ‘Kruskal’s Stress’. It is this value that needs
to be minimised, as a lower stress value indicates a better fit between the original
proximities and the derived distances. As a rule of thumb, when Kruskal’s Stress is less
than 0.10 the fit is considered excellent and anything over 0.10 is becoming less accept-
able. While an attempt is made to minimise stress values, measures of the ‘Dispersion
Accounted For’ and Tucker’s Coefficient of Congruence when high (greater than 0.90),
indicate a reasonably good fit of the original proximities to the derived distances. In the
working example, Kruskal’s Stress I and Tucker’s Coefficient of Congruence indicate
there is a good fit between the original proximity measures and derived distances.

Stress and Fit Measures

Normalised Raw Stress .00438
Stress-| 206620
Stress-|| 418386
S-Stress 01127
Dispersion Accounted For 99562
Tucker's Coefficient of Congruence .99781

PROXSCAL minimises Normalised Raw Stress.
a. Optimal scaling factor = 1.004.
b. Optimal scaling factor = .997.

The coordinates of each of the nine data points (towns) for a two-dimensional solution
are illustrated in the Final Coordinates output below. These are the coordinates that
SPSS uses to plot the common space.

Final Coordinates

Dimension
1 2
Perth .019 -.803
Adelaide -.416 -.269
Melbourne -.624 011
Hobart -.766 153
Sydney -.206 .325
Brisbane 163 413
Darwin .640 .040
Cairns 527 616
Broome .666 -.485

Although stress and other goodness of fit measures may be used to provide an indi-
cation of how well the final configuration fits the original proximities data, one of the
most important criteria is the interpretability of the final solution. The common space,
illustrated in the chart, is certainly interpretable. If the space is rotated anticlockwise
90 degrees and then flipped, the nine towns approximate a map of Australia. In other
words the MDS analysis has taken the original proximity data and represented these
proximities as distances, in such a way that the towns now approximate the locations
that would be found on a map of Australia.
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Further evidence of the reasonably high level of fit between the original proximities and
derived distances is also shown in the Shepard Diagram below, which plots the original,
but transformed proximities, against the derived distances. As the fit improves, this

relationship should increasingly approximate a straight line relationship with minimal
dispersion.
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Practice example

In the previous working example three tourists judged the distances among nine towns
in Australia. Their judgements were averaged and their average scores were used to
develop a single matrix of proximities representing their judgements of the distances
among towns.

In the practice example the three tourists are asked to use a five-point scale to make a
judgement of the similarity among the nine towns. A score of 1 would indicate the pair
of towns were very similar and a score of 5 would indicate they were very dissimilar.
They are instructed they can base their judgement on any criteria they like.

In this example solutions will be derived in not only two dimensions but two-to-five
dimensions. The data for the practice example are shown in Prac21.sav.

In undertaking the analysis, in the Multidimensional Scaling: Plots: sub-dialogue
box, make sure that you have entered 2 for the Minimum dimensions and 2 for the
Maximum dimensions. Run the analysis using the same configuration as you did
before and record the value of Stress L.

Repeat the process for three through to five dimensions and record the Stress I values
for each dimensional solution.

Syntax

PROXSCAL
VARIABLES=Perth Adelaide Melbourne Hobart Sydney Brisbane Darwin Cairns Broome
/SHAPE=LOWER
/INITIAL=SIMPLEX
TRANSFORMATION=ORDINAL (KEEPTIES)
PROXIMITIES=DISSIMILARITIES
/ACCELERATION=NONE
/CRITERIA=DIMENSIONS(3,3) MAXITER(100).

QOutput

Two dimensions

Stress and Fit Measures

Normalised Raw Stress .02404
Stress-| 415504
Stress-l| 244666
S-Stress P 07219
Dispersion Accounted For .97596
Tucker’s Coefficient of Congruence .98791

PROXSCAL minimises Normalised Raw Stress.

a. Optimal scaling factor = 1.025.
b. Optimal scaling factor = .977.

Three Dimensions

Stress and Fit Measures

Normalised Raw Stress .00460
Stress-| 206782
Stress-lI 226209
S-Stress ® 01602
Dispersion Accounted For .99540
Tucker’s Coefficient of Congruence .99770

PROXSCAL minimises Normalised Raw Stress.

a. Optimal scaling factor = 1.005.
b. Optimal scaling factor = .995.
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Four Dimensions

Stress and Fit Measures

Normalised Raw Stress .00332
Stress-| 205760
Stress-Il 226067
S-Stress 01101
Dispersion Accounted For .99668
Tucker's Coefficient of Congruence .99834

PROXSCAL minimises Normalised Raw Stress.
a. Optimal scaling factor = 1.003.
b. Optimal scaling factor = .996.

When you have run the analyses, plot the values as a ‘scree plot’ yourself with each
dimension on the X axis and the Stress I value on the Y axis.

You should have a plot similar to the following, which has an ‘elbow’ at the three-
dimensional solution. This indicates that there is significant improvement in the fit
between the two- and three-dimensional solution, but much less improvement between
a three- and four-dimensional solution and between a four- and five-dimensional
solution.

Stress
0.18

0.16

0.14 \

0.12 \
ol N\ |
0.08 \

0.06- \'\
0.04 ; \

0.02

T T T T
2 3 4 5
Dimensions

Start by looking at the plot for the three-dimensional solution. The final coordinates of
each of the data points (towns) on the three dimensions are shown in the Final Coordi-
nates output. It is a good idea to draw a cube and use the coordinates to plot the
location of each of the data points (towns) on the three axes of the cube.

Final Coordinates

Dimension
1 2 3
Perth .060 .526 .361
Adelaide 333 476 -.086
Melbourne 531 -437 -.013
Hobart 470 -.286 -.542
Sydney 409 .007 .328
Brisbane -.279 -.434 461
Darwin -.642 -.016 -.345
Cairns -.571 -.361 .036
Broome -.312 .526 -.200

SPSS:
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Although not as visually accurate as plotting the data points in a cube, you can look at
the coordinates of each of the towns on each of the three dimensions. For example on
dimension one Darwin, Cairns, Broome and Brisbane are at one end of the dimension,
while Melbourne, Hobart, Sydney and Adelaide are at the other.

Now the question can be asked what is it that distinguishes the towns on this dimen-
sion. Is climate a useful label for dimension one, with one pole of this dimension being
tropical/subtropical and the other pole being towns with temperate climates?

What labels would you apply to dimensions two and three? Is there a dimension that
distinguishes towns on the basis of air quality, isolation, rainfall or the composition of
the population?

This is where art meets science in the interpretation of MDS solutions!
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Workmg wﬂh output

This chapter provides an overview of how to work with output within the SPSS program.

Edmng output in the SPSS Viewer

The SPSS Viewer or Output Navigator Window, as it has been referred to in previous
versions, provides a table of contents of all your output in a session. You can use this
outline to navigate through your output and control the output display. Most actions
undertaken in this pane have a corresponding effect on the contents pane. The outline
pane is useful if you want to browse your results, to show or hide particular tables and
charts, to change the display or ordering of results by moving particular items, or to
move between the outline pane and other applications.

To start working with some output we first need to access some data. When the SPSS
program is installed it comes with particular data sets. For the purpose of this chapter
we will use one of the data sets available within the program.

‘%% To access the data and obtain some output

1 Double-click on the SPSS program icon to begin your SPSS session.

2 The program will open to the SPSS for Windows dialogue box which will give
you a number of choices, such as Run the tutorial, Type in data, etc. Ensure
the Open an existing data source radio button is selected.

3 You will notice a number of different files are listed. Click on the filename AML
Survival, then click on OK.

Click on the Analyze menu.

5 Click on Descriptive Statistics and then on Frequencies to open the Frequen-
cies: dialogue box.

6 Select the variable you require (i.e. Chemotherapy) and click on the [ button to
move the variable into the Variable(s): box.
7 Click on OK.

You should now be in the SPSS Viewer and the output of the procedure just run should
be displayed.
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The output results can now be browsed by expanding, collapsing, hiding and showing
particular aspects of the output.

' M To collapse and expand outline items

1 Click on the small yellow box to the left of the outline item you want to collapse
(i.e. the small yellow box next to the Frequencies item). You will notice that a
small red arrow has appeared to the left of Frequencies, and that all sub-items
beneath this output have been highlighted.

2 Select the View menu and click on Collapse. You will notice that the output in
the contents pane has been collapsed and is no longer displayed.

3 To expand the item, repeat the above procedure, but this time click on Expand
not Collapse. The output is again displayed.
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It is also possible to expand and collapse outline items without using the menu system.
This is as simple as clicking the small box to the left of the outline item you wish to
expand or collapse. Alternatively, you can use the Collapse button (—) and Expand
button (+) on the toolbar. '

 To hide and show outline items

1 Click on the outline sub-item titled Statistics within the Frequencies item. Again,
you will notice that a small red arrow has appeared next to the Statistics sub-item
and that this arrow is also highlighting the corresponding statistics table in the
contents pane. You will also notice that the symbol (a book) next to the Statistics
sub-item is open, indicating that the corresponding table is present in the contents
pane. However, you will see that the book for the Notes sub-item is closed.

2 Select the View menu and click on Hide. You will notice that the corresponding
output in the contents pane has disappeared and is no longer displayed.

35
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3 To show or display the output again, repeat the above procedure but click on
Show not Hide. The output is once again displayed.

Now it’s your turn: show or display the output corresponding to Notes in the contents
pane using the above procedure.

As was the case with collapsing and expanding output, it is possible to hide and show
output without using the menu system. This is done by double-clicking your mouse on
the book icon that corresponds to each outline item. Remember, if the book icon is open,
then the output is displayed; if the book is closed, then the output has been temporarily
hidden from view. Alternatively, show and hide buttons are available on the toolbar.

It is also possible to change the level of an outline item in the outline pane — that is,
to promote or demote an item.

@ To change the level of an outline item

1 Click on the outline sub-item titled Chemotherapy within the Frequencies item.
Again, you will notice that a small red arrow has appeared next to this sub-item
and that this arrow is also highlighting the corresponding table in the contents
pane. You will also notice that the book icon is open.
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2 Select the Edit menu and click on Qutline and then Promote. You will notice
that the Frequencies table for Chemotherapy has now been promoted to an item
of its own.

; ¥ ;
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3 To demote the item, repeat the above procedure but click on Demote not Promote.

Items can also be promoted and demoted by using the left arrow < and right arrow =
keys on the SPSS Viewer toolbar.

» To move outline items in the SPSS Viewer

Click an item in the outline or contents pane to select it (i.e. fitle).
Use the mouse to click and drag the item to the bottom of the sub-item listing.

Release the mouse button just above where you want to place the moved item.
You will notice that the title has also moved in the contents pane.
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Items can also be cut, pasted or deleted in this manner using the Edit menu. To delete
the Notes sub-item, select it and then press the delete button.

™ To change the size and font of ifems in the outline

Select the View menu and select Outline Size.

2 Click on Medium. You will notice that the font size in the outline pane has
increased in size.
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3 Select the View menu again and select Outline Font.

Select Arial Narrow from the list of fonts and click on OK.

You will notice that the font style has now changed.
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Because the font style and size has been changed it is now necessary to increase the
size of the outline pane to be able to fully read the text in the outline pane. Using your
mouse, position the cursor on the vertical bar separating the outline pane from the
contents pane. Click on this bar and, holding the left mouse button down, move the bar
to the right until the text in the outline pane is fully displayed, then release.

,>» To add a new title or text item to the outline contents pone

You may wish to add new titles or text items to your output that are not connected to
particular tables or charts.

1 Click on the table, chart or object in the contents pane that will precede the title
or text (e.g. Statistics). This means that the new title will be inserted beneath the
Statistics table in the contents pane.

2 Select the Insert menu and click on New Title.
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3 Double-click on the new object/box that has been created in the contents pane.

4 Enter the text you want at this location (i.e. Respondents undergoing treatment).
You will notice that a new Title sub-item has been listed in the outline pane.

T
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5 Now with two titles, use the delete key to delete the old title Frequencies and
the Statistics table.

CHAPTER 22 o Working with output PEN

KaRaNLIK



Fde Edt Vew Data Transform inserr Format Anslyze Graphs Ugides v Feip

2RISR | B | Bile| 2| & ]

elsfsl-] ol slmia
———:@ uvpul
E ;“:Z‘:s Respondents undergoing treatment g
Titis
L&B Chzmotherapy Chemotherapy

Cumuizlive

Fraquens, Pgeent “ahd Parcent Parcent

alid Mo 1z 8Lz g2z €22
Yes 1 378 a7 g 1ene
Tatal 23 1909 A D

315pSS processoc is re:

Mgé &l Creote 3. aroset ;.- L 0] Chapter 21 - a0t .. ¢l s s, .

New text and new headings can also be added in this manner using the Insert menu.

Mod:fymg and improving charts for presentation

Now let us consider some chart outputs. After creating a chart, you may wish to
modify it, either to provide more information about the data or to enhance the chart for
presentation. This section will largely deal with enhancing charts for presentation.

Although the charts generated by SPSS contain the requested information in a logical
format, you may find that some changes are required for presentational purposes to
enhance the charts you have created. Such changes may include inserting titles and sub-
titles; adding a 3-D effect to a bar chart; changing the intercluster spacing between bars
on a bar chart; removing axis titles; altering the orientation of labels; enlarging scale
axes; and adding annotations such as average scores and other descriptive statistics.

As outlined earlier in the Preface, SPSS version 12.0 has a number of improved
charting features including:

» Better default chart appearance

» Support for long text strings and automatic text wrapping
* Control of default scale ranges using chart templates

» 3-D effects for pie and bar charts

» Improved choice of colour patterns.

Many of these functions can be achieved using the Chart Editor menu bar, which
replaces the main menu bar when a Chart window is active. Remember you can tell
when a window is active by looking for the red exclamation mark ! at the bottom of
the window in which you are operating. The Chart Editor menu bar contains ten
menu items, including File, Edit, View, Gallery, Chart, Series, Format, Statistics,
Graph and Help.

Let’s first generate some output with which to work. You will remember that when
working through the section of this chapter on ‘Editing output in the SPSS Viewer’,
you accessed a data file already available within the program. If you haven’t still got
this file open, access it again.

L3 SPSS: Analysis without Anguish
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To access the data and obtain a chart output

If you are not currently in the SPSS program, double-click on the SPSS program
icon to begin your SPSS session.

Ensure the Open an existing data source radio button is highlighted.

You will notice a number of different files are listed. Click on More files and on
OK. This will bring up more files in the program folder. Click on the filename
AML Survival and then click on OK.

Select the Graphs menu and click on Bar.

Click on Clustered. Also ensure the Summaries for groups of cases radio
button has been checked in the Data in chart are box.

Click on Define.

Select the variable which you require (i.e. Chemotherapy) and click on the »]
button to move the variable into the Category Axis: box.

Select the variable by which you wish to define the above variable (i.e. status)
and click on the ] button to move the variable into the Define clusters by: box.

In the Bars Represent box, ensure that the % of cases radio button has been checked.

Click on the Options pushbutton and uncheck the Display groups defined by
missing values check box by clicking on this check box with your mouse.

Click on Continue and then OK.

You should now be in the SPSS Viewer, where a bar graph of your results is displayed.
Let’s now open the Chart Editor to modify the chart and improve its presentation. This
is achieved by double-clicking on the chart in the Viewer window to open the Chart
Editor window. Also highlight the bars in the bar graph by clicking on the bar with
your left mouse button. Now you’re ready to modify the bar chart.

Tai Chart Edit

File Edit Yiew Chart Help

Percent

Status
B8 Censored
& Relapsed

No Yes

Chemotherapy

H:375, W-275 points
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7 To create a 3-D effect
1 Click on the Show Properties Window tool located on the toolbar to open the
Properties dialogue box.

2 Click on Depth and Angle tab and then click on the 3-D radio button in the
Effect box. You will notice that the bars in the chart have now changed.

3 Click on Apply and on Close.

File Edit VYiew Chat Help

SEEEYY
Status

# Censored
Relapsed

No Yes

Chemotherapy

i To modify and add chart atiributes

Modifying and adding chart attributes is easy in the Chart Editor window. By double-
clicking on any aspect of the chart, you can open the relevant Properties dialogue box
to alter chart size, text, axis labels, number format, scale, fill, borders and so on. Take
a few minutes to experiment with the chart currently in the editor. Always remember
when modifying chart attributes to click on Apply to change the particular attribute
and then to click on Close to close the dialogue box.

Select the Chart menu to open a range of further options such as Add Chart Element
(annotations, text boxes), Hide Legend and Transpose Chart. These functions are
also available on the toolbar. Once again have a go at using these functions yourself on
the chart in the Chart Editor.

SPSS: Analysis without Anguish
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File Edit View ' Chart Help

[e] )} ChangeDataElement Type »
{8 pata 1D Mode 2
 Add Chart Element “»  |&= annotation
g, e 1@ Text Box
B2 Hide Legend b
I{H_’ b o i P
g rohet
E. Transpose Chart

§ Censored
1 Relapsed

Axis Reference Line
o

xis Reference Line

2
Y

Percent

o Yes
Chemotherapy

Another very useful tool within the chart editor is the Data ID Mode. If you click on
this tool on the toolbar, and then click on a bar on the chart, the tool will attach the
data value for that particular bar. Do the same for the other bars of the chart. To turn
this function off, click on the Data ID Mode tool again.

File Edt View Chart Help

Status
M Censored
Relapsed

No Yes
Chemotherapy
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Now create a title for the chart by inserting a text box above the chart. Just click on the
Insert a text box tool and a box will appear in the chart window; type in a chart title
and place the title above the bar graph.

Chart Editor
File Edit view Chart Help

Status
8 Censored
B Relapsed

!
! Patient Status z
-

No Yes
Chemotherapy

It really is very simple to make your charts look fabulous.

Now create a pie chart to modify.

%

To create a pie chart

1 Select the Graphs menu. You will notice this can also be accessed from within
the SPSS Viewer window as well as in the Data Editor window.

Click on Pie... to open the Pie Charts dialogue box.

3 Ensure the Summaries for groups of cases radio button is checked and then
click on the Define pushbutton.

4 Select the variable you require from the variable list (i.e. status) and click on the
] button to move the variable into the Define Slices by: box. Also make sure
that the % of cases radio button is selected.

5 Click on the Options pushbutton and make sure that the Display groups
defined by missing values check box is unchecked.

6 Click on Continue and then OK. This output has now been added to your
Output Navigator/Viewer window, and your pie chart is displayed.

SPSS: Analysis without Anguish
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Status
B Censored
Relapsed

Try modifying the chart using the tools in the chart editor. Remember to double-click
anywhere on the pie chart to activate the Chart Editor window — you will notice a few
extra tools available to you, such as the Explode slice tool. To make changes, just double-
click on the aspect of the chart you are trying to modity or click your right mouse button
to open the menu of tools available to you, as illustrated in the figure below.

Status
W Censored
8 Relapsed

Patient Status

Copy Chart
1@ Add Text Box
g, Hide Data Labels d

B2 Hide Legend

‘P Return Slice

hl.ll Change to Simple Bar
[ Change to Line

[‘ Change to Area

Now copy the chart and paste it into another application.
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b» To copy and paste a chart into another application

Ensure the Chart Editor window is active.

2 Select the Edit menu and click on Copy Chart. The chart has now been saved
to the clipboard even though you cannot see it. You can view the chart in the
clipboard viewer available in Windows if you wish.

3 Open a blank or existing file in a new application (for example, Microsoft
Word).

4 Select the Edit menu in the new application and click on Paste.

5 Save your Word file and return to SPSS to finish the session.

SPSS version 12.0 has the capability to embed both pivot tables and charts interactively
into other applications; that is, tables and charts can be copied and pasted into other
applications.

Obviously, many other charts can be modified in SPSS, such as boxplots, scatterplots,
histograms and line graphs. This section has provided you with a brief introduction to
some of the basic procedures that can be undertaken to improve the presentation of bar
graphs and pie charts in the Chart Editor window.

Practice example

Using the data in the ‘carpet’ file, which is a sample data file available in SPSS version
12.0, use a bar chart and a pie chart to appropriately represent two of the variables in
this data file. Experiment with modifying these charts for presentation now that you
are more familiar with some of the functions. Then practise copying both charts into a
Microsoft Word document.

Viewer and Draft Viewer output

SPSS version 12.0 also provides you with the option of working in an SPSS Viewer or
Draft Viewer format. This chapter has provided an overview of the SPSS Viewer func-
tion of working with pivot tables and charts, but the Draft Viewer function allows you
to edit your output directly. Many regular users of SPSS who produce lots of data
output prefer the ease of editing output using the Draft Viewer; however, if you are
wanting to produce high-quality graphs and charts for reports, then the viewer function
is probably preferable.

To change output type, select the Edit menu and click on Options. Ensure the General
tab is selected and in the Viewer Type at Start-Up box select the Draft radio button,
not the Regular radio button, which is the default option, as shown opposite. Click on
Apply and then OK. For the Draft Viewer to be enabled, you will need to restart your
SPSS program.
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Data ] Curency | Scripts |
General l Viewer | Draft Viewer | Outputlabels | Chats | intersctive | Pivot Tables
-Variable Lsts ~Quitput
@ Display labels € Display names No scientific natation for small numbers
€ Aphabeticsi ¥ Fie intables
- Session Joumal . Viewer Type at Starlup:
¥ BRecord syrntax in Jouma) {* Regular " Draft

& Append " Overwrite
Measurement System: [p it ,i
CADOCUME™~T\Coakes LOCALS ™~ 1\ Temp* qints

Browse... l Language: 1Eng¥ish > l y

Temporary directory: Notfication:
|C::DOCUME™1'Coakes - LOCALS~1\Tem V' Raise viewer window
¥ Scroll to new outpit

Recently used file list: s < Sound: & None ¢~ Systembeep
" Sound Browse..,
T~ Open syntax window at start-up
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TABLE 1 {CRITICAL VALUES

Appendix

Upper Tail Probability ()

Degrees of Freedom| 0.15 0.10 0.05 0.025 0.015 0.01 0.005 0.001 0.0005

1 1.963 3.078 6.314 12706 21.205 31.821 63.657 318.309 1273.155

2 1.38¢6 1.886 2920 4303 5643 6965 9925 22327 44,703

3 1.250 1.638 2.353 3.182 3.896 4.541 5841 10.215 16.326

4 1.190 1.533 2.132 2776 3298 3747 4.604 7173 10.305

5 1.156 1.476 2015 2571 3.003 3.365 4.032 5.893 7.976

6 1.134 1.440 1.943 2.447 2829 3.143 3707 5.208 6.788

7 1119 1.415 1.895 2365 2715 2998  3.499 4.785 6.082

8 1.108 1.397 1860 2306 2634 2896 3.355 4.501 5617

9 1.100 1.383 1.833 2262 2574 282] 3.250 4297 5.29

10 1.093 1.372 1.812 2228 2527 2764 3.169 4.144 5.049

11 1.088 1.363 1.796 2.201 2.491 2718 3.106 4.025 4.863

12 1.083 1356 1.782 2179 2461 2.681 3.055 3.930 4717

13 1.079 1.350 1.771 2160 2436 2650 3012 3.852 4.597

14 1.076 1.345 1.761 2145 2415 2625 2977 3.787 4.499

15 1.074 1.341 1.753 2.131 2.397 2602 2947 3.733 4.417

16 1.071 1.337 1.746 2120 2382 2583 2921 3.686 4.346

17 1.069 1.333 1.740 2110 2368 2567 2898 3.646 4.286

18 1.067 1330 1.734 2101 2356 2552 2878 3.611 4.233

19 1.066 1328 1.729 2093 2346 2539 2.861 3.579 4187

20 1.064 1.325 1.725 2086 2336 2528 2845 3.552 4.146

21 1.063 1.323 1.721 2080 2328 2518 2831 3.527 4.109

22 1.061 1321 1717 2074 2320 2508 2819 3.505 4.077

23 1.060 1.319 1714 2069 2313 2500 2807 3.485 4.047

24 1.059 1.318 1.711 2064 2307 2492 2797 3.467 4.021

25 1.058 1316 1.708 2.060  2.301 2.485 2787 3.450 3.997

26 1.058 1315 1706 2.056 2296 2479 2779 3.435 3.974

27 1.057 1.314 1.703 2052 2.291 2473  2.771 3.421 3.954

28 1.056 1.313 1.701 2048 2286 2467 2763 3.408 3.935

29 1.055 1.311 1.699 2045 2282 2462 2756 3.396 3.918

30 1.055 1310 1.697 2042 2278 2457 2750 3.385 3.902

40 1.050 1.303 1.684 2.021 2250 2423 2704 3.307 3.788

50 1.047 1.299 1.676 2009 2234 2403 2678 3.261 3.723

60 1.045 1.296 1.671 2.000 2223 2390 2.660 3.232 3.681

120 1.041 1.289 1.658 1.980 2196 2358 24617 3.160 3.578

Z critical value 1.036 1.282 1.645 1.960 2170 2326 2576 3.090 3.290
Level of Significance

for a one-tailed test| 0.15 0.10 0.05 0.025 0.015 0.01 0.005 0.001 0.0005
Level of Significance

for a two-tailed test| 0.30 0.20 0.10 0.05 0.03 0.02 0.01 0.002 0.001
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Anal\/éisl without Angmsh |

This edition of SPSS: Analysis without Anguish is based on SPSS version 12.0
for Windows.

u. .

SPSS is a sophisticated piece of software used by social scientists and related
professionals for statistical analysis. There are several new features in SPSS version
12.0 that are covered in the new edition of this workbook, including:
¢ improved charting capabilities
* new data management features
* statistical enhancements.
Always popular in previous editions, SPSS: Analysis without Anguish Version 12.0
for Windows continues to address the needs of all users of SPSS software. It serves as
a practical introduction to new users and also allows those wishing to undertake more
advanced analysis to work their way systematically through each stage.
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Extensive use of screen displays and a range of “step by step’ working and practice
examples remain as features of the workbook. SPSS data sets for all exercises are also
now available at the accompanying website www.johnwiley.com.au/highered/spssV12.
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Features new to this edition of the workbook include:

* areporting box at the end of each relevant chapter to illustrate how results from each of
the particular tests should be reported

e a chapter on multidimensional scaling
e an 'at a glance’ listing of practice and working examples in the front of the book
e three common statistical tables in the appendix: f, chi square, and t.

SPSS: Analysis without Anguish Version 12.0is suitable across a number of disciplines,
including business, health, social sciences, environmental science and geography. It can
also be value packed with other Wiley textbooks in subjects such as statistics, market
research and research methods to save students money.
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